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INTRODUCTION 

Welcome to the fascinating world of SAP. This book helps you crack the tricks of mastering SAP HANA 

Customization 
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Profitability Analysis 

Here you will find all the information you need to implement Profitability Analysis. 

Before you start to configure your system, you should familiarize yourself with the business functions 

and concepts of Profitability Analysis. 

Additional Information 

For more information on these topics, see the online manual CO Profitability Analysis. 

 Structures 

In this section, you define the basic structures of the Profitability Analysis application component. 

 

 

 Define Operating Concern 

In this section, you create an operating concern. 

In order to use Profitability Analysis (CO-PA), you have to define operating concerns. An operating 

concern is an organizational unit in Financials. The structure of an operating concern is determined by 

analysis criteria (characteristics) and the values to be evaluated (value fields). 

In a first step, you have to define the characteristics for your operating concerns. You define 

characteristics in the Customizing activity Maintain characteristics. For costing-based Profitability 

Analysis, you also need to define value fields. You do this using the activity Maintain value fields. These 

characteristics and value fields can be used in several operating concerns. Their definition applies to all 

clients. 

After this, you have to define the structure of your operating concern in the activity Maintain operating 

concern. You do this by selecting the desired characteristics and adding them to the data structures of 

your operating concern. If costing-based Profitability Analysis is active, you also need to select and add 

the required value fields. The structure of an operating concern is valid in all clients. 

In the step "Maintain operating concern", you also specify the attributes of your operating concern (fiscal 

year variant, currencies). By maintaining the attributes, you make an operating concern "known" in the 

current client. The attributes are client-specific. 

 Maintain Characteristics 

In this activity, you define characteristics. A number of frequently used characteristics are already 

predefined in the standard system. 

You initially define these characteristics independently of any operating concern. They are also available 

in all clients. 

Before defining a characteristic, look at the list of existing characteristics. You may find one there that 

already meets your requirements. This list contains all predefined characteristics and those you have 

already defined in your system. To see a list of those characteristics that are automatically contained in 

all operating concerns, choose Extras -> Fixed fields. 



 

 

To create characteristics, switch to the "change" mode and then choose the Create icon: 

Copying characteristics from a list of proposals 

You can use characteristics that originally come from other applications as characteristics in Profitability 

Analysis by copying these fields from existing tables or structures. For example, you can choose any 

characteristics from the SAP standard tables for customers, materials, or sales documents. The table from 

which you copy a characteristic is referred to as that characteristic's "table of origin". The values for 

these characteristics are automatically derived from other characteristics in CO-PA (derivation steps are 

generated automatically) or transferred together with the transaction data from other applications (such as 

Sales and Distribution ( SD )). 

The system only offers you those fields that can still be copied from the table. This excludes fixed 

characteristics and characteristics that cannot be used in CO-PA for technical reasons. Equaly, you 

cannot copy a field if a characteristic already exists with the same data element and the same table of 

origin. This rule does not apply if the characteristic that already exists is used in an SAP operating 

concern template. 

To avoid naming conflicts, you must rename any reference table fields to be copied as characteristics if 

their original name is not four or five characters long. The new name must begin with "WW" and should 

be only four or five characters long. 

The reference tables contain fields whose characteristic values can only be interpreted in conjunction 

with other fields. One such example is the field Region (REGIO) in the customer master table KNA1, 

which can only be understood together with the field Country ( LAND 1) because country is located at 

the level above region. If such a field is copied as a characteristic, you also need to assign the higher-

level characteristic during characteristics maintenance (see also the section "Characteristics" in the 

documentation for Profitability Analysis). Fixed characteristics (such as the controlling area) can also be 

used as higher-level characteristics. 

From a technical point of view, a characteristic's dependency on other characteristics is determined via 

the key fields of the particular check table that is defined by the foreign key relationship for the field in 

the reference table. You can only assign a characteristic as superior if it shares the same domain as the 

key field in the check table for the subordinate characteristic. The client field is not taken into account. If 

such characteristics already exist in the system, the system proposes them as possible superior 

characteristics. If no characteristics meet this criteria, you need to define a characteristic. 

Example: The field Region has the check table T005S assigned to it with the key fields Client 

(with the domain MANDT assigned to it), Country (domain LAND1) and Region ( domain REGIO). 

Since the characteristic LAND1, like the key field Country, has the domain LAND1 assigned to it, it can 

be assigned to the characteristic Region as a higher-level characteristic. 

If the field that you wish to copy is semantically dependent on another field, the Dependencies 

(characteristic compound) area is automatically displayed in the details screen for characteristic 

maintenance. Moreover, a higher-level characteristic is also proposed, if applicable. 

When you copy characteristics from reference tables, the technical attributes (such as length and data 

type) and the texts from the reference table are also copied along with the data element. The value range 

is specified either by the check table entered in the domain or by the fixed values in the domain. 

If you want other texts to appear on screens or lists for the characteristic, you need to delete the reference 

to the original data element by choosing Edit -> Data element -> Delete assignment. Then you can enter 

texts on the detail screen. You can only delete the assignment to the data element if you have not yet 

saved the characteristic. 

The system automatically proposes entries for the text table, for the text fields and for the long text fields. 

You should only change these in exceptional cases. If you do so, note that the key of the text table 

contains the same fields as the key of the check table. 

Defining new characteristics 
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You can also manually define new characteristics that you only want to use in Profitability Analysis. 

Since these characteristics have no table of origin, their values are not automatically derived from other 

characteristics. You therefore need to define derivation steps for them. The name of new characteristics 

must begin with "WW" and consist of 4 or 5 characters. Depending on the desired attributes, you must 

choose one of the following variants: 

- With own value maintenance 

In most cases, you will define new characteristics with their own value maintenance. In this case, 

the system creates a check table and text table. In the Customizing activity Maintain characteristic 

values, you can then enter characteristic values and texts for these. 

Only those values maintained here are permitted values for that characteristic. If the values for 

a characteristic are only semantically unique when in conjunction with other characteristics, 

you can display this fact by defining a dependency ( characteristic compound). 

To define this type of dependency, proceed as follows: 

When creating a characteristic, use the Display compound icon to switch to dependency display. At the 

top of the display, you find the characteristic that has just been defined. 

Use the Insert row icon to insert the same amount of empty rows as the amount of higher-level 

characteristics that you would like to assign. Then enter the higher-level characteristics into those 

rows. 

Once you have saved the characteristic, you cannot make any changes to the dependencies. If you 

would like to display a multi-level dependency, you need once more to assign a higher-level 

characteristic to another higher-level characteristic in the latter's characteristic value maintenance. 

However, when defining dependencies, you should avoid ending up with complicated, multi-leveled 

chains of dependencies. 

When you save, the system displays a dialog box in which you can specify how the check table should be 

created. Normally you will want to to choose "Automatic", which means that the names of the check 

tables are numbered sequentially with the name "T25xx" (where xx = number). You can also enter these 

numbers manually in order to avoid naming conflicts when you transport the operating concern to 

another system. In that case, you need to make sure that the numbers issued in these systems are not 

synchronous. For more information on transporting these tables, see the section Transport objects. 

Without value maintenance 

This option lets you define characteristics with no check table. This means that there is no set of 

allowed characteristic values and texts. Consequently, no validity check takes place for values of 

these characteristics. 

These characteristics cannot be used as receiver characteristics for period-based allocations. 

With reference to existing values 

This type of characteristic is only required in special cases. Here you assign the characteristic to a 

data element that already exists in the system. The characteristic takes on the attributes of that data 

element (texts, length, check table, text table). 

General information 

It is possible at any time to change the texts of new characteristics specific to CO-PA. 

The technical attributes, the assigned data element, the dependency, and the check table can only be 

changed if you have not yet saved the characteristic. 

You can delete any characteristic that is not used in any operating concern. 



 

 

It is possible to define more than one characteristic using the same data element or texts (description, 

short text, title). However, you should not include both in the same operating concern. The 

following example shows how you can use characteristics with the same data element from 

different tables of origin: 

The characteristic MATKL (Product range) is predefined. Its table of origin is MARA (material 

master). However, you want to derive the product range from the sales document. 

Therefore you need to define a characteristic from the table VBAP. Choose "Copy table fields" 

and select the field MATKL from table VBAP. Since a characteristic with the same name already 

exists, rename the field to "WWMKL". Then choose "Edit -> Data element -> Delete assignment" 

to delete the assignment to the data element. On the detail screen, enter different texts so that you 

can distinguish this one from the predefined characteristic MATKL. When you activate the new 

characteristic, the system automatically creates a new data element (with the same technical 

attributes and same table of origin). 

On the initial screen, note the repair functions: Extras -> Field catalog -> Reorganize 

Extras -> Master data -> Text read module 

The function "Reorganize" synchronizes the CO-PA field catalog and the ABAP Dictonary. "Text 

read modules" generates the routines for checking characteristic values and reformats the texts for 

display. Both functions are unnecessary in the course of normal operations. They are merely 

designed to help you correct inconsistencies following modifications or transport errors. 

Using special characteristics from SAP tables 

In SD, you can organize your customers in a hierarchical structure according to various criteria. 

To use this customer hierarchy from SD in Profitability Analysis, you can copy the fields 

HIEZU01 through HIEZU from the structure PAPARTNER to your operating concern. 

You assign the SD hierarchy nodes to these fields in PAPARTNER when you maintain the 

customer hierarchy in SD. 

To derive values for the customer hierarchy characteristics in CO-PA, you need to define the 

derivation step "Customer hierarchy" in Characteristic derivation. 

If you want to use individual levels of the product hierarchy in MM as characteristics of your 

operating concern, you can choose the fields PAPH1, PAPH2, and so on using the function 

"Copy from SAP table". (The field "Product hierarchy" is not suitable for drilldown 

reporting through the different hierarchy levels.) The values of these fields are: 

  PAPH1 - Values of level 1 of the hierarchy 

  PAPH2 - Compound values of levels 1 and 2 of the hierarchy 

  PAPH3 - Compound values of levels 1 to 3 of the hierarchy   ... 

By using these fields in your operating concern, you avoid having to maintain 

characteristic values and derivation rules for the product hierarchy. If you have already set 

up your operating concern in an earlier release and defined characteristics and derivation 

rules for the product hierarchy, those settings remain unchanged and continue to function 

as before. 

Note 

Once you have added these characteristics to an operating concern, you an no longer change 

the structure of the product hierarchy (ABAP Dictionary structure PRODHS). 

Activities 

Define the desired characteristics and then activate your entries. 

Add these characteristics to your operating concerns using the IMG activity Maintain operating concern -

> Change data structures. 
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 Maintain Value Fields 

In this activity, you can define your own value fields. Frequently used value fields, such as "Revenue" 

and "Sales quantity", are already predefined in the standard system. 

You define these values independent of any operating concern and any client. 

Before you create a new value field, you should take a look at the ones that already exist. It may be that 

you can use a value field you have already define or one defined in the standard system. 

Once you are in the "change" mode, you can define a new value field by choosing the "Create" icon: 

Enter a 4- or 5-character name that begins with "VV" for your value field. Here you also need to specify 

whether this field is a quantity field or a field for currency amounts. All the currency fields in any single 

line item use the same currency. This currency is defined in the attributes of each operating concern. 

Each quantity field, on the other hand has its own field that defines the unit of measure. Thus you can 

have quantities in different units in the same line item. 

On the next screen, you can enter texts to describe the value field, as well as how the values in this field 

are to be aggregated over characteristics of time. In most cases, you will use the aggregation rule "SUM" 

(summation) to add up the values over periods. The aggregation rules "Last value" (LAS) and "Average" 

(AVG) are only of significance if the value field is to contain a statistical non-cumulative value. 

Further notes 

If necessary, you can change the attribute "Currency or quantity field" as long as this value field is not 

used in any operating concern. 

You can change the texts for user-defined value fields at any time. 

You can delete any value field that is not being used in an operating concern. 

On the initial screen, you can use the repair function Extras -> Field catalog -> Reorganization to 

synchronize the CO-PA-specific field catalog with the ABAP Dictonary. This function is not 

needed under normal circumstances. It merely helps you remove inconsistencies following 

modifications or transport errors. 

Activities 

Create your value fields and then activate your entries. 

To add your value fields to operating concerns, call up the function "Operating Concern -> Change data 

structures" in Customizing. 

 Maintain Operating Concern 

In this activity, you define and maintain the operating concerns you are going to use in your system. 

If you want to create a new operating concern, you need to create the subobjects data structure and 

attribute and to activate the environment: 



 

 

Data structure 

The data structure determines the structure of the profitability segments that you can analyze and 

how costs and revenues are organized. All information in the data structure definition is valid for 

all clients. If you use the operating concern in more than one client, you still only need to define 

the data structure once. You then need to set the attributes in each client individually. 

One of the specifications you make for the data structure is the type of Profitability Analysis. 

You can only activate the operating concern for the types you specify here. The structure of 

the operating concern is defined by the characteristics and - in costing-based 

Profitability Analysis - by the value fields as well: 

Characteristics 

Characteristics are the segments of your organization for which you want to analyze your data in 

CO-PA. 

Several fundamental characteristics are predefined in every operating concern. These are called 

"fixed characteristics". You can display a list of the fixed characteristics by choosing Extras -> 

Fixed fields. 

In addition to these predefined fields, you can define up to 50 of your own characteristics in each 

operating concern. You can select these from a list of additional predefined characteristics, or you 

can create your own using the Customizing function Maintain Characteristics. 

Value fields 

Value fields are the fields in costing-based CO-PA in which the system stores the amounts and 

quantities. They thus determine the structure of your costs and revenues. 

An operating concern can contain up to 120 value fields. The standard system contains a list of 

predefined value fields (such as "Sales quantity" or "Sales revenue"). If you want to define 

additional value fields, you can do this using the Customizing function Maintain Value Fields. 

To add fields (characteristics or value fields) to your operating concern, select the desired fields on the 

Edit Data Structure screen (right side of the screen). Then use the function Transfer fields to copy 

these fields to the data structure. You can only transfer fields with an active status. AN operating concern 

cannot contain two fields for which the meaning, the short text, or the field title overlap. 

Once you have defined your data structures, you need to activate them. When you activate the data 

structures, the system creates the tables for plan and actual data in the database system. 

If you choose to add new characteristics or value fields at a later stage, you should note that these do not 

work retroactively. However, you can supply new value fields with existing planning data using the 

"Automatic planning" function or the "Periodic valuation" function. To fill new characteristics 

retroactively, you need to perform the "Realignments" function. 

Deleting characteristics/value fields from an operating concern 

You can delete characteristics and value fields retrospectively from an operating concern that you have 

already activated. However, you should only use this deletion function for operating concerns that 

have not yet been used productively. You should also note that some database systems require the 

operating concern tables to be converted (database conversion) after the deletion has taken place if data 

had already been posted to the operating concern. Depending on the data volumes involved, the database 

conversion can take a matter of seconds or indeed several hours. Moreover, you cannot post data or run 

reports during the conversion. Due to integration, other applications are also affected when data is 

postedwith an assignment to profitability segments (such as settlement and direct assignment from 

FI/MM). If the operating concern has been transported to another system (such as the productive system), 

then the database conversion must also occur in that target system. 

Depending on the fields that were deleted, the following tables need to be converted ( where xxxx = 

operating concern): 

Characteristics: CE1xxxx, CE2xxxx, CE4xxxx, CE4xxxx_ACCT, CE4xxxx_FLAG, and 

CE4xxxx_KENC 
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Amount fields: CE1xxxx, CE2xxxx and CE3xxxx 

Quantity fields: CE1xxxx, CE2xxxx, CE3xxxx, CE4xxxx, CE4xxxx_ACCT, 

CE4xxxx_ACCT, CE4xxxx_FLAG, and CE4xxxx_KENC 

Before deleting fields from an operating concern with a large data volume (more that  000 records in a 

table), you should refer to the section "The Database Utility" in the ABAP dictionary documentation. 

This section describes the database conversion process. 

For database systems that do not require conversion (such as DB2 for AS/400, Informix, MSSQL), it can 

still take a considerable amount of time for the operating concern to be activated. 

To delete characteristics or value fields, perform the following activities: 

Delete the corresponding characteristics and value fields from Customizing in all clients (this includes 

forms, reports, planning layouts, and so forth). To locate characteristics and value fields, use the 

appropriate where-used list in the Customizing Monitor. You can 

access it by choosing Tools -> Analysis -> Check Customizing Settings. You can jump directly 

from the where-used list to the relevant Customizing transaction and then delete the appropriate 

field there. 

Switch to the screen for maintaining the data structure of an operating concern ( Maintain operating 

concern). 

If you need to effect other changes to the datastucture for the operating concern before making any 

deletions, effect those changes and save the data structure. 

In order to be able to select the fields of the data structure, choose Extras -> Characteristics (or Value 

fields) -> Unlock. 

Select the characteristics and value fields to be deleted and remove them from the data structure with the 

"Reset fields" function. 

Reactivate the operating concern. The system starts by checking whether the operating concern contains 

any data and whether the fields to be deleted are still being used in any Customizing settings. 

If none of the fields are still in use, the system then starts the re-activation. If the operating concern does 

not contain any data or does not require the database system to be converted, the tables are 

activated. You are then able to activate the environment for the operating concern. In this case, the 

following activities no longer apply. 

If the operating concern already contains data, a system message tells you that the database needs to 

be converted. If you proceed, an activation log appears (at the top of the list). 

Analyze the activation log. If it only contains error messages telling you to convert the tables, proceed 

with the next activity. 

You must otherwise remove the cause of the errors before the tables can be converted. In this case, 

you should answer "No" to the next prompt, which asks whether the conversion transaction should 

start. 

If you still only receive error messages telling you to convert the tables, choose "Back" and start the 

conversion. 

Plan a job for the conversion. A list of the tables to be converted is shown for this. If the tables only 

contain a small amount of data (less than  000 records), then all the tables can be converted in one 

job. In that case, you can select all the tables. For larger tables, conversion should take place in 

several jobs. However, you should ensure that table CE4xxxx (where xxxx = operating concern) is 

the last table to be converted. 

Warning. No other changes can be made to the operating concern during the conversion. A copy of 

the table is generated during the conversion. The database system should have sufficient memory 

available for this copy. 



 

 

To schedule conversion as a job, use the "Schedule selections" function. You can display the 

current status of the conversion by selecting the "Refresh" icon. Tables disappear from the list once 

they have been converted sucessfully. If a conversion is taking a while, it is also possible to leave 

the transaction. You can then continue the conversion using DB requests -> Mass processing in 

one of the following ways: 

With the job overview. You access this by choosing System -> Services -> Jobs. Using the 

database utility transaction. You access this by choosing Utilities -> Database Utility in the ABAP 

Dictionary menu. 

You can use the status function to call up the status of the operating concern during 

operating concern maintenance. You need to activate all tables after conversion. 

To analyze errors that have occurred during the conversion, you can use the database utility transaction 

by choosing Extras -> Logs. The log has the same name as the conversion job: TBATG-date. You 

can also restart the conversion with this transaction. For more information on the database utility, 

choose Help -> Application help while still in the above transaction. 

Once you have activated all the tables in the operating concern, generate the operating concern 

environment from within operating concern maintenance. 

You can then use the operating concern again. 

If you want to transport the operating concern into a different system, see the section 

"Notes on transport" 

Note 

To finish processing the data structures, use the "Back", "Exit", or "Cancel" navigation functions. 

Attributes 

The attributes are client-specific parameters of an operating concern. They have different effects 

depending on the type of Profitability Analysis you are working in. When you create the attributes, you 

make the operating concern "known" in that client. If the operating concern does not yet contain any 

transaction data, you can change the attributes at any time. However, you should not change them in a 

productive system that already contains transaction data. 

- Currency types 

Note: Whereas actual data can be updated simultaneously in all the combinations of currency 

type and valuation that are described below, planning data is always updated in one currency 

only - the currency specified for that particular plan version. 

Note also that updating actual data in multiple combinations of currency and valuation 

significantly increases your data volume with each additional combination. 

Operating concern currency 

In costing-based Profitability Analysis, actual data is always updated in the operating concern 

currency. 

You can change the operating concern currency as long as no data has been posted in the 

operating concern. Once data has been posted, however, a change in the operating concern 

currency would cause the existing data to be interpreted as if it were posted in the new 

currency (for example: USD 000 in old currency -> DEM 000 in new currency). 

Company code currency 

In addition to the operating concern currency, you have the option of storing all data in the 

currency of the relevant company code as well. This makes sense if your organization operates 

internationally and deals with exchange rates that change daily. It allows you to avoid 

differences due to different exchange rates and lets you reconcile your CO-PA data directly 

with FI. 
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You can activate the company code currency at any time. However, this will not 

affect data that has already been posted. 

If you deactivate the company code currency, you can no longer use plan versions and reports 

that use the company code currency. 

Profit center valuation 

In addition to storing data in these two currencies using the legal (= company code) valuation 

view, you can also store data in both of these currencies valuated from the viewpoint of 

individual profit centers. 

This yields the following possible combinations of valuation view and currency type (so-

called valuation approaches): 

Currency type Valuation view 

Operating concern currency Legal valuation 

Company code currency Legal valuation 

Operating concern currency Profit center valuation 

Company code currency Profit center valuation 

You set up actual data valuation from the profit center viewpoint in Customizing under 

"Flows of Actual Values -> Multiple Valuation Approaches/Transfer Prices". 

Note 

Whereas actual data is updated simultaneously in all the selected combinations of currency 

type and valuation, plan data is always updated in one currency only - the currency specified 

for that particular plan version. 

Note that updating actual data in multiple combinations of currency and valuation 

significantly increases your data volume. 

If you are using account-based Profitability Analysis, the system stores all data in the transaction 

currency, company code currency and controlling area currency. If the company code currency and 

the controlling area currency are the same, the system stores the object currency for the individual 

CO object (cost center, order, project, and so on) in place of the company code currency. 

The currencies you specify for the operating concern have no significance for account-based CO-

PA. 

- Fiscal year variant 

The fiscal year variant determines the number of posting periods per fiscal year for the operating 

concern. Since each controlling area assigned to the operating concern -- and each company code 

assigned to each of those controlling areas -- can have its own fiscal year variant, the variant you 

choose for the operating concern must agree with the other areas. 

If you want to change the fiscal year variant, you can only do so in a way that increases the total 

number of periods, for example: from 12 posting periods + 2 special periods to 12 posting periods 

+ 4 special periods 

If the alternative period type is active for the operating concern (see below), you cannot change the 

fiscal year variant. 

If you are using costing-based Profitability Analysis, the operating concern and the 

controlling area which is assigned to it must have the same fiscal year variant before you can 

transfer overhead. 

If you are using account-based Profitability Analysis, the operating concern and the controlling 

areas must always have the same fiscal year variant. 

- Alternative period type 

If you are using costing-based Profitability Analysis, you can use the alternative period type to store 

your actual or plan data in weeks. However, activating the alternative period type multiplies your 



 

 

data volume. This could lead to much slower response times in your information system than if you 

do not use the alternative period type. You can also activate the alternative period type at a later 

point in time. The only disadvantage of this is that the data posted up to that point will not be stored 

according to the alternative period type. That data remains assigned to the posting period. If you are 

using account-based Profitability Analysis, you cannot use the alternative period type. 

Environment 

Whenever you activate the data structures, you also need to activate the cross-client and client-specific 

environment of the operating concern. If you have added new characteristics to an operating concern in a 

productive system, you should make sure that no postings are made in that system while you are 

activating the environment. Activate the environment on the same server that you activated the data 

structures on. 

Standard settings 

The standard SAP system contains the sample operating concern "S001". You can copy this operating 

concern to create your own operating concern. However, you should not use it productively. 

Activities 

To define your operating concern, proceed as follows: 

Enter the name of the operating concern. 

Enter a text for the operating concern. 

Specify which type or types of Profitability Analysis you want to use. 

Create the data structures and activate them 

Activate the environment. 

Define attributes in each client in which you want to use the operating concern. 

Additional information 

Generated objects 

When you activate the data structures of your operating concern, the system creates the following 

objects in the ABAP Dictionary: 

Type Name Description 

Structure CE0xxxx logical line item structure 

Table CE1xxxx actual line item table 

Table CE2xxxx plan line item table 

Table CE3xxxx segment level 

Table CE4xxxx segment table 

Table CE4xxxx_KENC realignments 

Table CE4xxxx_ACCT account assignments 

Table CE4xxxx_FLAG posted characteristics 

Structure CE5xxxx logical segment level 

Structure 

assessments 

CE7xxxx internal help structure for 

Structure CE8xxxx internal help structure for 

assessments 
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In these names, "xxxx" stands for the name of the operating concern. 

Upgrading your system 

When you upgrade your system to a later release, or when you import a support package, the new 

functions or corrections need to be activated for your existing operating concerns. This is done 

automatically when you execute the first transaction that uses data from Profitability Analysis. This 

normally takes a few minutes and is announced by a message at the bottom of the screen you are 

currently on. 

This upgrade includes a number of checks and, where necessary, the automatic correction of 

inconsistencies. However, the system may encounter situations that it cannot handle automatically. 

It is therefore recommended that you carry out this upgrade manually by executing a simple 

function (such as "Environment -> Set operating concern" in the application menu) before you 

begin working productively again in the new release. This will trigger the upgrade process. 

Deleting an operating concern 

To delete an operating concern, you need to carry out a number of preparatory steps: 

Deactivate Profitability Analysis for all the controlling areas that belong to the operating concern to be 

deleted and in all fiscal years using the function Activate Profitability Analysis. 

Delete the assignment of controlling areas to your operating concern using the function Assign Operating 

Concern (Customizing for the Enterprise Structure). 

You can access the following steps in the function Operating concern -> Delete. 

Delete the client-specific Customizing settings. 

After completing steps 1 through 3 in all clients, you can proceed with the following steps: 

Delete the environment. 

Delete the data structures. 

When you delete the data structures, the system also deletes all the transaction data in that operating concern. 

This data can no longer be recovered. 

If you want to delete characteristics and value fields that are not used in any operating concern, you can 

do this using the Customizing functions Maintain Characteristics or Maintain Value Fields. 

Notes on transporting 

You can transport the settings you made to your productive system using the CO-PA transport tool. 

Note that the generated ABAP Repository objects are valid for all clients. Conflicting names in the target 

system can also lead to problems in other applications. Therefore you should make all Customizing 

settings in one (source) system. You can then transport these settings to your other (target) systems. This 

technique helps you avoid inconsistencies. 

If you cannot use this technique for some reason, be sure to observe the following: 

Characteristics and value fields with the same name must have the same text, the same attributes (type, 

length), the same check table and the same origin table in each system. 

For characteristics which were defined manually, enter the number for the check table manually as well. 

Each characteristic must have the same number in all systems. The assignment of the number to the 

characteristic must be unique. 

For more information about transporting objects, see Transport. 



 

 

 Sample Operating Concerns 

You can work with sample operating concerns to simplify the definition of your own operating concerns. 

Some of these operating concerns are templates delivered by SAP for you to use for demonstration 

purposes and as copy templates. 

Alternatively, you can copy your own (test) operating concerns and their Customizing settings to the 

future operating concern that you wish to use productively. 

 Use SAP Operating Concern Template 

This is where you can gain an initial overview of Profitability Analysis without having to have any 

specialist knowledge and without having to have made any settings previously. 

Furthermore, operating concerns that have already been preset are available, allowing Profitability 

Analysis to be quickly integrated into your productive system. To do this, you can customize these 

operating concern templates. At any time, you can reset the templates to their original settings. 

Activities 

When you start the transaction for operating concern templates, the system provides you with an 

overview of the different templates that are available. A short description accompanies each template and 

you can display it in the right-hand side of the screen. To go to the detail view, select a template. 

The detail view provides you with an overview of the delivered settings and of the modifications that 

you can make. By choosing Application examples, you can view reports and planning layouts. The 

system fills them with example data to demonstrate more clearly how the application works. You can 

then delete the example data later. 

If you wish to implement an operating concern template as a template for your Profitability Analysis, you 

first need to copy it using the copy function found under Tools. This is also where you can choose to 

reset an operating concern template back to its initial state. 

Further notes 

The first time you work with an operating concern template in a client, you need to set the client 

beforehand. The client-dependent settings in client 000 are copied to the current client and then the 

system generates the client-dependent environment. The system also checks whether the client-

independent environment is up-to-date or whether it needs to be generated again. 

When the system generates the example data, 0 profitability segments (or market segments) are created 

from the existing characteristic values via the random selection of values. The profitability segments, 

once created, are then buffered and used whenever example data is generated subsequently. In order that 

changes to the derivation rules are considered when new example data is generated, the old example data 

first needs to be deleted. Doing so also deletes the buffer with the 0 profitability segments created 

previously. When you start up again, 0 new combinations are determined. 

If only an insufficient number of combinations are possible due to a low number of characteristic values, 

the number of different profitability segments is reduced accordingly since some profitability segments 

are posted several times. You can achieve the most representative example data if you have at least 0 

possible combinations . 

For the periods 01 to 12 of the desired fiscal year, the system generates example data for each 

profitability segment, taking into account the fact that revenues and costs reach Profitability Analysis by 

means of different record types (variances in production, for example, concern record type C). Quantities 
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are posted in the unit "Piece"(PC). Ensure that these units exist in the other clients. To see which record 

types supply which value fields in an operating concern template, refer to the table TKETE03. In the case 

of the operating concern template for the consumer goods industry, 3600 line items are created each 

time example data is generated (0 profitability segments x 12 periods x 3 record types = 3600 records). 

Both actual data and planning data can be created in plan version 000 for a selected business year. 

When example data is generated, the system considers any valid derivation rules that have been specified 

for the operating concern template. It ignores any that are invalid or that contain errors. 

If you delete example data, all the record types present in the current client are removed from the tables 

CE1xxxx, CE2xxxx, CE3xxxx and CE4xxxx (where xxxx is the key for the operating concern template). 

This means that the profitability segments that have been determined are also deleted. 

Equally, if you reset an operating concern template, all example data in the current client will be lost. 

 Copy Operating Concern including Customizing 

In this IMG activity, you can create an operating concern by copying an existing one. There are three 

ways you can do this: - Import operating concern 

Copy operating concern 

Copy specific objects 

Note: This step is not intended to be used as a means of creating backup copies of operating concerns that 

could be imported if needed. No transaction data is copied in this step! 

Import operating concern 

This function lets you copy the customizing settings for an operating concern to another client. In 

particular, you can use this function to copy one of the standard "templates" from client 000 to your 

test client. 

Note: Unlike the function Import objects, this function copies ALL the settings for the operating 

concern, not just individual objects. 

The logic for copying settings is different from the logic for transporting in that settings that simply 

reference the operating concern instead of being dependent on it (such as PA transfer structures) are 

copied as well. To avoid inadvertently overwriting settings in the target client, you should only use 

this function when the target client does not contain any customizing settings yet, or when you want 

customizing in the source and target clients to be identical. 

Copy operating concern 

This function lets you copy an entire operating concern within the same client. You can choose 

whether you want to copy the data structures only, the customizing settings only, or both. These are 

copied in separate steps. 

First you need to copy the data structures. When you do so, you can decide whether the (cross-

client) environment should be generated automatically or not. If you want to make changes to 

the new operating concern after copying it, you should generate the environment later. 

Note: To copy the data structures, you must enter a target operating concern name does not yet 

exist. 

Once you have done this you can copy the customizing settings. You can also repeat this step as 

often as required. The data structures in the target operating concern must be active, and they 

must at least contain the same characteristics and value fields as 

the source operating concern. 

If you repeat the copy, the system overwrites any existing settings. 



 

 

Copy specific objects 

This special function lets you copy specific customizing settings between clients or between 

operating concerns within one client. To do so, you must collect all the relevant tables in a transport 

request using the transaction Transport objects or the manual transport function in the transaction 

for each setting. Do NOT release the request. When you call up this function, enter the number of 

the TASK (not the request). The source client is determined based on the client the transport 

request is defined for. If you are copying between clients, you cannot change the operating concern. 

If you are copying between operating concerns, they must be in the same client. 

Caution: The system cannot automatically check whether all the table entries in the transport 

request belong to the specified source operating concern. You need to pay special attention to this 

when you use this function. 

Log display 

For each copying action, the system writes a log in the application log. You can display these logs 

at any time using transaction SLG1. Use the object "COG_PA" and the subobjects "IMPORT" 

(Import operating concern) and "COPY" (copy operating concern and copy specific objects). 

When you import an operating concern (SAP template), you need to generate the 

operating concern's environment. In addition, you need to maintain the record types 

and number ranges. 

 Set Operating Concern 

In this step, you specify which operating concern you want to work in and the type of Profitability 

Analysis. All functions that you then execute thereafter and until you logoff will relate to that type of 

Profitability Analysis for the specified operating concern. 

Prerequisites 

The operating concern must already be defined. 

Additional Information 

The operating concern is stored until you reset it or logoff from the system. 

If you work essentially with one operating concern, you can use the Save pushbutton to store the 

specified operating concern and the type of Profitability Analysis in your user master. If you do this, the 

system uses the settings stored in the user master the next time you logon to the system and the dialog 

box asking you to set the operating concern does not appear. 

You can use the "Set Operating Concern" function to switch at any time to a different operating concern 

or to a different type of Profitability Analysis. That way you can temporarily override the settings in 

your user master. 

You can also execute the "Set Operating Concern" function in the CO-PA application menu by choosing 

Environment -> Set Operating Concern. 

 Master Data 

In this step you make all the basic settings that determine the basic structure and contents of Profitability 

Analysis in your system. 



 

WHATSAPP +255738656506 

 

In short, you need to define the following: 

How the relevant segments of your organization are to be created (so-called "profitabilty segments"). 

You can do this using the characteristic derivation function. 

What values should be determined automatically by means of valuation. You can do this using the 

valuation functions. 

 Characteristic Values 

In this section, you fill characteristics with values by maintaining the characteristic values for the 

characteristics you have defined. 

You can also use a characteristics hierarchy to order the characteristic values in a hierarchy and to 

analyze in the information system the hierarchical relationships between the values. 

 Maintain Characteristic Values 

In this step you maintain characteristic values and texts for your user-defined characteristics if you only 

want these characteristics to have a fixed set of possible values. 

You define characteristics in the Customizing step Maintain characteristics. When you define a user-

defined characteristic, you need to specify the field type and length of its characteristic values. When you 

define such a characteristic, the system automatically generates a check table and a text table which are 

used to check what characteristic values are permitted. 

 Define Characteristics Hierarchy 

You can define hierarchical structures for characteristics in Profitability Analysis (CO-PA) and analyze 

these structures later in the information system. This means you can, for example, structure your 

products or customers in a hierarchy. 

Each characteristic value contained in the hierarchy represents a hierarchy node. Further to the 

characteristic values contained in the master data, you can add "non-chargeable nodes" to the structure. 

Note that different characteristics that use the same master data table are grouped in the same 

characteristics hierarchy. It is not possible to define external hierarchies for characteristics that do not 

have a check table or text table. 

Note that only the characteristic values for one characteristic are grouped hierarchically for each 

hierarchy. In addition, each characteristic value can occur only once in the hierarchy. Thus each value is 

unique within the entire hierarchy. 

You can define alternative hierarchies for the same characteristic in order to simulate different ways of 

grouping the characteristic values. These alternative hierarchies are stored as hierarchy variants. You can 

define up to 999 different variants for each characteristic. 



 

 

Activities 

Creating a characteristic hierarchy 

Enter the name of the characteristic for which you want to define the hierarchy. Also, enter a number 

between 1 and 999 for the hierarchy variant. 

If you enter a characteristic that has the same data element and domain as another characteristic, the 

hierarchy applies for both characteristics, since both have the same characteristic values. A list of 

the characteristics involved is displayed in the lower part of the screen. 

Choose "Hierarchy -> Create". 

The next screen contains information about the hierarchy. 

Enter a description for the hierarchy and, if desired, select the "Visible system-wide" indicator. 

If you select this field, this variant will be active for all applications where you can maintain master 

data hierarchies. If you do not select it, the variant will only be available in EC-EIS. 

Choose "Goto -> Back". 

Then add the nodes to the hierarchy. 

Position the cursor on a node and press F4 to display the valid characteristic values to 

which data can be posted. Choose the desired value or any existing node that cannot receive 

postings. 

If you enter data for a nonchargeable node, this data is transferred to a table. To access this table, 

choose Goto -> Maintain nonchargeable nodes. 

Once you have added the desired characteristic values, save the hierarchy. 

Each characteristic value can only occur once in the hierarchy variant. If a characteristic value already 

occurs in the hierarchy, it no longer appears in the list of possible entries. To add new nodes, you can use 

the following functions: 

"Edit -> Create entry -> Same level" 

This function inserts a blank node at the same level as the selected node. 

"Edit -> Create entry -> One level lower" This function inserts a new node 

at the next level down. 

"Edit -> Create sev. entries -> Same level" This function inserts several 

blank nodes at the same level. 

"Edit -> Create sev. entries -> One level lower" This function inserts 

several blank nodes at the next level down. 

"Edit -> Create range -> Same level" 

"Edit -> Create range -> One level lower" 

These functions let you enter a range, such as "characteristic value X through characteristic value 

Z". 

Changing, displaying, copying, and deleting characteristics hierarchies 

The functions for changing, displaying, copying, and deleting master data hierarchies work the same way 

as the function for creating them. 

You can use an existing hierarchy as the basis for creating a new hierarchy variant by copying the 

existing variant and then changing it. 

When you change a hierarchy, you can add new nodes and remove existing nodes, as well as cut and 

paste existing parts of the hierarchy. When deleting a node, ensure that all dependent entries are deleted 

as well. 
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You can search for specific values in the hierarchy by choosing Edit -> Find -> Characteristic value. It 

is also possible to see the relationships between the different nodes by positioning the cursor on a node 

and then searching for the parent, child, and so on. You can expand and collapse branches of the 

hierarchy by clicking on the plus and minus signs. This makes it easier to find your way around in the 

hierarchy. 

You can delete any hierarchy variants that you no longer need from the initial screen of this transaction. 

 Define Characteristic Derivation 

In this step, you set up the derivation of characteristic values. 

Derivation lets you find values for certain characteristics automatically based on the known values of 

other characteristics, where these characteristics are logically dependent on one another. 

Standard settings 

When an operating concern is generated, the system produces a standard derivation strategy containing 

all known dependencies between characteristics. You can display these by choosing "View -> Display all 

steps". 

Activities 

You can change the standard derivation strategy by 

Creating additional steps 

Adjusting changeable standard steps to suit your situation or deleting them 

Changing the step sequence Proceed as follows: 

Creating a step 

Select the step that is to precede the new step you wish to add. Choose "Create step". 

Choose the desired type of derivation step from those available. 

Enter a text as well as source and target fields for the derivation step. By using the arrow button, you can 

determine field characteristics for the source and target fields. 

If the derivation step should only be executed unter certain conditions, such as only for specific 

characteristic values, make the entry under "Condition". 

You determine step characteristics under "Characteristics". For example, you determine whether an 

error message should be generated if no target value can be calculated. 

If you use the derivation step type "Derivation rule", some additional entry options are available: 

Under "Maintain rule values", you enter which values in the target fields should be placed in which 

characteristic values of the source fields. 

Under "Characteristics", you can make additional entries which, for example, make it possible to enter a 

validity date for the step. 

Changing/deleting steps 



 

 

You can change and delete the steps you have defined as well as the changeable standard steps (those 

that read from tables). 

When you change a step, all the possible entries described under "Creating steps" are available. 

To delete a step, select the step in question and choose "Delete". 

Changing the step sequence 

Select the step to be relocated in the sequence. 

Position the cursor beneath the desired position for that step. 

Choose "Move". 

Further notes 

For more information about characteristic derivation, see "Master data -> Characteristic derivation" in 

the documentation for Profitability Analysis. 

 Valuation 

You can have values calculated automatically in costing-based CO-PA. This procedure is called 

"valuation" and can be used for both planning data and actual data. 

There are four different methods of valuation in CO-PA: 

Valuation using material costing 

You can use material cost estimates from Product Cost Controlling (CO-PC) to determine the cost 

of goods manufactured in Profitability Analysis. The breakdown of these costs in CO-PC is 

usually more detailed than that required in CO-PA. Consequently, you can assign more than one 

cost component to the same value field in CO-PA. 

Other than the standard cost estimate, the periodic allocation prices / actual cost estimates from 

Material Ledger can also be used for valuation. This is particularly useful for period revaluation. 

Valuation using conditions and a costing sheet 

This is useful when you need certain data to evaluate a sale but do not yet know the actual values. 

This makes it possible to calculate such things as sales commission, discounts, cash discounts or 

freight costs. You calculate these values by defining conditions, which are stored and processed in a 

costing sheet. Conditions can be scaled and made dependent on certain characteristic values. 

To valuate actual data, you need to define special conditions in CO-PA. For planning data, you can 

also access conditions from Sales and Distribution (SD) directly. 

Valuation by means of a user-defined program exit 

If your requirements for valuation go beyond the techniques supported in the standard SAP System, 

you can program your own valuation routines. 

Valuation with transfer prices 

Valuation using transfer prices is only possible for plan data. 

For detailed information about transfer prices and multiple valuation approaches in the SAP 

System, see the online documentation "EC-PCA Profit Center Accounting" You define transfer 

prices in Customizing for Profit Center Accounting in the section Transfer Prices. 
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 Valuation Strategies 

The valuation strategy contains the methods used for valuating value fields in costing-based CO-PA. 

It determines the methods used to fill different value fields and the order in which these methods are 

processed. 

You can valuate data using the following methods: 

     CO-PA-specific condition types 

     Material cost estimates 

     User-programmed valuation routines 

     Transfer prices 

In CO-PA planning, you can also valuate data using condition types and pricing procedures from the 

Sales and Distribution (SD) application component. Valuation using transfer prices is likewise only 

possible in planning. 

Example 

The following valuation strategy calls for valuation using product costing, then using a CO-PA costing 

sheet ("ACT001"), then using a user-programmed valuation routine ( "U01" ). 

 Sequence    Appl. Cstg sheet  Name       Mat.cstg Qty field  Exit no. 

                                            X       VVIQT 

    20       KE     ACT001                            VVIQT 

    30                                                          U01 

Valuation using material costing is used primarily to determine the cost of goods manufactured of the 

products sold in billing documents that are transferred to CO-PA. It allows you to add the fixed and 

variable cost of goods manufactured to the CO-PA line item in order to compare them to the sales 

revenues and sales deductions transferred with the original billing document. 

The conditions technique lets you calculate values that are required for analyzing contribution margins 

in CO-PA but are not yet known at the time the original document is posted. In particular, this make it 

possible for you to calculate such values as sales commission, cash discounts, sales deductions, or 

freight costs. 

You can use your own valuation routines to calculate any values that cannot be determined using either 

of the above methods. 

Activities 

First, define the valuation strategies you want to use. Then assign these strategies to the desired points of 

valuation. 

Further notes 



 

 

Each valuation step contained in a CO-PA valuation strategy is assigned a number. This number 

determines the order in which the system processes the steps in that strategy. 

Value fields that are filled using a previous valuation step are not overwritten by subsequent steps. The 

only exception to this is when you use a user exit. Once a value has been calculated in one step, you can 

use that value to calculate other values in subsequent steps. 

As a rule, value fields that are filled before valuation is carried out in CO-PA -- regardless of whether 

they were transferred from SD or entered manually -- can only be changed or overwritten in valuation by 

a user exit. The only exception to this are values entered manually in CO-PA planning. Here the values 

found using automatic valuation always take priority over values entered manually in the planning 

layout. 

Plan valuation using pricing procedures from Sales and Distribution ( SD ) 

When you define a valuation strategy to be used solely in CO-PA planning, you can also use prcing 

procedures from Sales and Distribution (SD) (application class "V" in the field "Application"). Note that 

this is not allowed for valuation of actual data, since there the SD conditions are transferred directly 

from the billing document or sales order as defined in the value field assignments of the SD interface. 

If you use an SD pricing procedure for valuation in planning, the system transfers the values of the 

conditions to the value fields as assigned in the SD interface. 

Under certain circumstances, it may not be possible to use all conditions from SD to valuate data in CO-

PA. For example, the access sequences used in the SD pricing procedures may contain condition tables 

with fields that are not defined as CO-PA characteristics. Consequently, before using an SD pricing 

procedure, be sure to check whether the fields required by the access sequence are defined as 

characteristics in your operating concern. Otherwise the system will not find the condition records, even 

if they have been maintained in SD. 

 Define and Assign Valuation Strategy 

In this step, you can define your valuation strategies and assign them to a point of valuation. 

Activities 

First, enter a three-character key and a description for the valuation strategy. 

On the detail screen, you can then define which methods you want to use in what order to perform 

valuation in your operating concern. 

Example 

You want to define a valuation strategy that performs valuation using material costing, then a CO-PA 

costing sheet, then a customer-defined valuation routine. To do so, make the following entries: 

Sequence Appl. Costg sheet name  Mat. CE   Qty field Exit no. 

--------------------------------------------------------------------- 

                                   X        VVIQT 

  20      KE    ACT001                        VVIQT 

  30                                                    U01 

If you want to use a material cost estimate for valuation, select the field under "Mat. CE". In this case 

you also need to specify the quantity field to be used (here "VVIQT"). 
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If you want to use conditions, enter the key (here "ACT001") and the application from which to take the 

costing sheet (here "KE"). If the conditions are calculated depending on the quantity, enter the name of 

the quantity field you want to use (here "VVIQT"). 

If you want to use your own calculation routines to valuate fields, enter the name of the program exit 

(here "U01"). For programming your own routines, you can use the customer exit in SAP standard 

enhancement COPA0002, which you maintain by calling up SAP Project Management. For more details, 

see the documentation found there and in the F1 Help for the field Exit no. 

If you want to valuate with a transfer price, you need to specify a variant for transfer pricing. In 

addition, you need to specify the CO-PA value field to which the transfer price should be mapped. 

Once you have defined your valuation strategies, assign them to the desired combinations of point of 

valuation, record type, and plan version. 

 Flexible Assignment Valuation Strategy 

Use 

In the 

Define and Assign Valuation Strategy 

step, you can assign a valuation strategy to a point of valuation and a record type. 

For cases in which control of the valuation based on the point of valuation and record type is not flexible 

enough, you can flexibly assign a valuation strategy based on additional CO-PA characteristics. 

Requirements 

In the costing-based profitability analysis, the flexible assignment is only evaluated if no valuation 

strategy assignment has been defined for a given combination of point of valuation and record type in the 

Define and Assign Valuation Strategy step. 

In contrast, in the combined profitability analysis, the determination of a valuation strategy using 

flexible assignment always takes priority over an assignment made in the Define and Assign Valuation 

Strategy step. 

Activities 

Flexible assignment takes place by means of user-defined assignment tables. Assignment rules are 

defined in the assignment tables, based on which the relevant CO-PA valuation strategy is determined. 

Example 

In the combined profitability analysis, the various currency and valuation views of an operating concern 

can be valuated using different valuation strategies. If this is required, the 'Currency Type and Valuation 

View' ('GLOBAL CURTP') field must be included as a source field in the definition of the assignment 

table. 



 

 

If products with different material types are to be valuated using different valuation strategies, the 

'Material Type' ('GLOBAL MTART') field must be included as a source field in the definition of the 

assignment table. 

 Set Up Valuation Using Material Cost Estimate 

In Profitability Analysis (CO-PA), you can valuate documents by reading the cost of goods manufactured 

in the material cost estimates from Product Cost Controlling. You do this by defining costing keys. 

Which costing key is used for a particular document can depend on when the document is 

valuated in CO-PA (the "point of valuation"), the record type, the product sold, the material type of that 

product, or any other characteristic in your operating concern. 

In this activity, you make the necessary Customizing settings for setting up valuation using material cost 

estimates in your system: 

When you maintain costing keys, you determine which 

standard cost estimates the system should read in Product Cost Planning and which 

periodic allocation prices / actual cost estimates the system should read in the Material Ledger. 

Once you have done this, you can assign these costing keys to a product or material type. Alternatively, 

you can use the flexible assignment function to assign costing keys to any characteristics in your 

operating concern for valuation. 

You then need to use value field assignment to determine for each operating concern and at each point of 

valuation how the cost components in the cost component split are to be assigned to the value fields 

in CO-PA. This must be done for each relevant cost component split. 

 Define Access to Standard Cost Estimates 

In Product Cost Planning, the planned cost of goods manufactured are calculated for a material. In 

Profitability Analysis (CO-PA), you can access these material cost estimates to valuate the data in CO-

PA. This includes values from cost estimates both with and without quantity structure for automatic 

valuation. 

With this function, you determine which cost estimates from Product Cost Planning should be used to 

valuate actual or planning data in CO-PA. You do this by defining costing keys. A costing key is a 

particular set of access parameters that are used in the valuation to determine which costing data in 

Product Cost Planning should be read. 

A costing key consists of a combination of the following parameters: 

        ==> Transfer sales order cost estimate 

        ==> Costing variant 

        ==> Costing version 
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        ==> Transfer additive costs 

        ==> Costing date 

        ==> Period/year 

        ==> Plan period indicator 

        ==> Transfer auxiliary cost component split 

        ==> Transfer cost estimate in controlling area currency 

        ==> Plant used for reading cost estimate 

        ==> Exclusive access to cost estimate 

        ==> Error message if no cost estimate found 

        ==> Order selection for access to production order cost estimate 

        ==> Cost component view for production order cost estimate 

        ==> Factor for production order cost estimate 

. 

                                                                       - 

Activities 

Define all the costing keys you want to use to valuate actual and planning data in Profitability Analysis. 

 Define Access to Actual Costing/Material Ledger 

In this activity, you create the costing keys for valuation with actual costs of goods manufactured. You 

define how the system calls up the periodic allocation prices/actual cost estimates from the Material 

Ledger by maintaining costing keys. 

Further notes 

When your sales quantities in CO-PA are valuated using periodic allocation prices/actual cost estimates 

from the Material Ledger, this typically occurs at the period end during revaluation. 

 Assign Costing Keys to Any Characteristics 

The steps 



 

 

Assign Costing Keys to Products 

Assign Costing Keys to Material Types let you assign costing keys to 

individual products or material types. 

In cases where the product-dependent or material-dependent callup of material cost estimates in Product 

Cost Accounting is not flexible enough to meet your requirements, you can determine the costing keys 

using your own "strategy" for the "flexible assignment of costing keys". 

This "strategy" is taken to determine the costing keys, generally using user-defined assignment 

tables. 

As in characteristic derivation in CO-PA, you can also work with table lookups or your own customer 

enhancements when setting up the "strategy". 

You can use the following Step Methods to define a strategy: 

User-Defined Assignment Tables 

As with the predefined assignment tables for products and material types, these user-defined 

assignment tables let you assign costing keys separately for each point of valuation, record type and 

plan version. In addition to these source fields, which are automatically contained in each assignment 

table, you can specify up to three characteristics in your operating concern as source fields for 

determining the costing key. Thus you can assign costing keys not only to certain "products" or 

"materials types", but to any combination of values of any characteristics. For example, you could 

define an assignment table to assign costing keys to specific combinations of "company code", "plant" 

and "product group". 

If you have created several assignment tables, the system respects the order in which they are entered 

when it searches through them for valid assignment rules. 

Table Lookups 

A table lookup allows you to access individual data records in any SAP table and to transfer the contents 

of individual table fields to Target Fields of the type USERTEMP.The USERTEMP fields that have been 

filled by a table lookup can then be used in a subsequent strategy step as source fields for an 

assignment rule. Therefore, the combination of table lookup and assignment rule means that you can 

use the data in fields from any SAP table as the basis for determining costing keys. 

III. Customer Enhancements 

To set up a strategy to determine costing keys flexibly, you can use the enhancement "COPA0002" and 

the component "EXIT_SAPLKEAB_004". It is possible to include a link to this enhancement 

wherever and as often as you want in the strategy since the step identifier ensures that the different links 

are not confused. For more information about how to determine costing keys using user-defined user-

exits, see the documentation for the SAP enhancement "COPA0002" or see the function module 

documentation for the function module "EXIT_SAPLKEAB_004". 

The assignment tables that you have defined and the customer enhancements make up the strategy for 

the flexible definition of costing keys. 

When creating your own assignment tables/table lookups or enhancements, observe the following: 

To create an assignment table, you can also choose from other source fields in addition to the 

characteristics in your operating concern. For details, see the F1 field help in the transaction for 

creating assignment tables. 
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By specifying multiple costing keys as target fields, you can valuate your data using up to six cost 

estimates in parallel. 

If you wish to run alternative valuation instead of parallel valuation, you first need to set the flag 

Exclusive access to cost estimate when defining the costing keys. 

In addition, you can specify a special valuation plant that should be used to access the cost estimate from 

product costing. This means that the plant found in the CO-PA line item does not always need to be 

the plant used for costing purposes. 

If you wish to access cost estimates simultaneously from several plants, we recommend that you 

firmly specify the valuation plant to be used to access the cost estimate when you define the costing 

keys. 

You can specify a special control indicator as a target field in an assignment table to avoid receiving an 

error message during valuation whenever the system cannot find a cost estimate from product 

costing. Note that by default, the system always displays an error message when this occurs. 

In the attributes for the assignment table, you can select the "Display error message" flag to specify that 

the system should automatically display an error message if no valid assignment rule entry is found 

in this table when the system tries to find the costing key. 

You may want to avoid a product already successfully valuated using product costing from being 

valuated again with a price found using a costing sheet. If so, you can define an assignment rule 

with a target field "VALUE_FLD1" to ensure that the value field assigned to the condition type is 

cleared before the CO-PA line item is updated. 

If your operating concern stores line items using transfer prices according to the profit center viewpoint 

in addition to the standard "legal" view, you should include the field ITEM_TYPE as an additional 

source field in the structure of the assignment table. Note that all entries in assignment tables that do 

not contains this field are interpreted as referring to line items created according to the legal view. 

Example 

You want to access cost estimates from product costing by company code and material type. You want to 

valuate using four costing keys, while explicitly specifying the plant that the system should use for 

finding the cost estimate. In addition, you want to be able to define whether an error message should be 

displayed if no cost estimate is found. All assignment rule entries should be valid for a specific period of 

time. 

To implement this example, proceed as follows: 

Call up the function: "Flexible Assignment of Costing Keys: Change Strategy". 

Choose Edit -> Create step to reach the screen "Flexible Assignment of Costing Keys: Change Rule". 

On this screen, enter a name for the assignment rule. Then add the fields "Company code" (CO-PA-

BUKRS) and "Material type" 'GLOBAL-MTART') to the existing fixed source fields "Point of 

valuation" (GLOBAL-BWFKT), "Record type" (GLOBAL-VRGAR), and "Plan version" 

GLOBAL-VERSI). 

For the target fields, you can specify, in addition to the "First costing key (CO-PA)" field 

(GLOBAL-KALAW1) the fields GLOBAL-KALAW2, GLOBAL-KALAW3 and GLOBAL-

KALAW4, plus the "Valuation plant" (GLOBAL-WERKS) and "Error handling" (GLOBAL-

XMES_FLG) fields. 

Select the "Entries should be maintained for specific dates" indicator, and then save. 



 

 

Once you have saved, you can maintain the assignment entries by choosing "Maintain rule entries". Or 

you can leave the "Change Rules" screen and maintain the entries later from the "Display Strategy" 

screen. 

Activities 

First define the assignment tables you require. If you define more than one assignment table, note that the 

system processes these in the order in which you enter them, from top to bottom. Once you have defined 

the necessary tables, you can maintain assignment rule entries for each assignment table. 

Further notes 

In order to valuate CO-PA line items using material cost estimates in Product Cost Planning, you must 

define your valuation strategy so that the system accesses product costing for the desired point of 

valuation. 

If you are valuating using more than one costing key, note that a value field can only be filled by 

valuation if it is empty. In other words, each value field can only be filled once, and is never overwritten. 

The system follows certain rules for determining which costing keys to use: 

First it checks whether one or more costing keys has been assigned to the product being valuated. If so, it 

valuates the data using only those costing keys. 

If no costing key is assigned to the product, the system checks whether any costing keys have been 

assigned to the material type of the product. If so, the data is valuated only using those costing keys. 

If no costing keys have been assigned to the material type, the system then checks whether any costing 

keys have been assigned to other characteristics using the flexible assignment function. If no 

costing keys are found in this manner, the transaction cannot be valuated using a material cost 

estimate. 

Likewise, no valuation is carried out if an entry exists in one of these assignment tables but does 

not contain a costing key. 

 Assign Value Fields 

Here you can assign the components of a cost component structure from Product Cost Controlling to the 

value fields of your operating concern. Note that you need to maintain separate value field assignments 

for each point of valuation in Profitability Analysis ( CO-PA ). 

You can divide the cost components into fixed and variable parts before transferring them to CO-PA. 

For each cost estimate, you can transfer any number of cost components to the same value field (n:1 

relationship). The values from these cost components are then added together in the value field. 

If you valuate using multiple material cost estimates simultaneously, this means that the values of 

different cost components within the same cost estimate are aggregated and then entered in one CO-PA 

value field. However, value fields that already contain data from a previous cost estimate are not 

overwritten by a later cost estimate. Consequently, you should assign value fields in Customizing so that 

the values of different cost estimates are entered in different sets of value fields. 

You can assign up to six different value fields from your operating concern to each cost component in the 

cost component structure. These assignments is indicated by the value fields entered in the columns 

Field name 1 through Field name 6. 
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Different value field assignments are important whenever you want to use multiple valuation 

approaches with different cost estimates. Six is the maximum number of cost estimates that you can 

transfer simultaneously from Product Cost Controlling to Profitability Analysis. 

You can assign up to three costing keys in parallel to a product or material type. 

Using the flexible assignment function, you can define your own assignment tables and assign up to six 

costing keys for parallel valuation. 

In valuation, the system first determines which costing keys to use. Then it finds the correct cost estimate 

in Product Cost Controlling based on the read parameters stored in those costing keys. 

Once it has found a cost estimate, it transfers the values of the cost components contained there to CO-

PA value fields based on the cost component layout for that cost estimate and on the costing key's 

position in the aforementioned assignment tables. For example, for the costing key entered in the first 

column in the assignment table, the system transfers the cost components to the value fields entered in 

the first value field column (the column with the name Field name 1). The same then happens for the 

costing keys in the second and third columns and in the fourth through sixth columns (if you use the 

flexible assignment function). 

Example 

For a costing key assigned to a product or material type in the column Costing key 1, the cost 

components of the relevnat cost component structure are assigned to the value fields entered in this 

transaction in the column Field name 1. 

Product "MAT01" is assigned the costing keys "I01" and "I02" for record type "F" and point 

of valuation "01": 

 PV   Rec.T. Product    Valid to     Cstg 1    Cstg 2   Cstg 3 

 01   F      MAT01      12 /31/1999   I01       I 02 

The value of the raw materials in the cost estimate found using costing key "I01" is supposed to be 

transferred to the CO-PA value field "VV001". Meanwhile, the raw material costs found using costing 

key "I02" are to be transferred to the value field "I02". In both cases the fixed and variable costs are to be 

added together and transferred as one sum. 

If we say that "001" is the cost component for raw material costs in the relevant cost component layout, 

we have the following assignment: 

 PV   CCmp  Name        F/V   Field name 1  Field name 2  Field name 3 

 01   001   Raw mat.    3     VV001         VV002 

Activities 

Assign the components of the cost component structure to the value fields in your operating concern. 

Remember the you may need to maintain entries in this table for more than one point of valuation. 

Note 

For detailed information on cost component structures, see Customizing for Product Cost Controlling 

under "Basic Settings -> Define cost components". 

To get to the screen "Assignment: Organizational Units to Cost Component Structure", choose the icon 

"Next page" from the screen "Define cost components". 

Further notes 



 

 

In order to valuate CO-PA line items using material cost estimates in Product Cost Planning, you must 

define your valuation strategy so that the system accesses product costing for the desired point of 

valuation. 

If you are valuating using more than one costing key, note that a value field can only be filled by 

valuation if it is empty. In other words, each value field can only be filled once, and is never overwritten. 

The system follows certain rules for determining which costing keys to use: 

First it checks whether one or more costing keys has been assigned to the product being valuated. If so, it 

valuates the data using only those costing keys. 

If no costing key is assigned to the product, the system checks whether any costing keys have been 

assigned to the material type of the product. If so, the data is valuated only using those costing keys. 

If no costing keys have been assigned to the material type, the system then checks whether any costing 

keys have been assigned to other characteristics using the flexible assignment function. If no 

costing keys are found in this manner, the transaction cannot be valuated using a material cost 

estimate. 

Likewise, no valuation is carried out if an entry exists in one of these assignment tables but does 

not contain a costing key. 

 Set Up Conditions and Costing Sheets 

The conditions technique in Profitability Analysis (CO-PA) lets you calculate fictitious values that are 

needed in CO-PA for analyzing contribution margins but are not known at the time the original 

document is posted. In particular, this makes it possible to calculate sales commissions, cash discounts, 

other discounts, or freight costs for a sales document. 

Conditions are used to calculate values based on any number of criteria (such as the quantity sold, the 

product sold, or the customer who bought the product). 

In this step, you can defined CO-PA-specific costing sheets for valuating data in CO-PA. You do this 

using the same basic functions as those for defining pricing procedures in Sales and Distribution ( SD ). 

This entails the following steps: 

Create the necessary condition tables. 

Create the necessary access sequences. 

Create the necessary condition types and specify the access sequences they should use. 

Define the necessary costing sheets. 

Assing your CO-PA-specific condition types to CO-PA value fields. 

 Define Condition Tables 

In this step you define condition tables for Profitability Analysis ( CO-PA ). 

Condition records in CO-PA are stored in CO-PA-specific condition tables whose key consists of 

specific combinations of characteristic values. Each condition table represents a different combination of 

characteristics and can be used by any number of conditions. ( Different conditions may depend on the 

same characteristics, such as customer and product, in the same system.) 

The key of the condition table consists of those characteristics that make up the key of the condition 

record. 
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To create a condition table, proceed as follows: 

Specify a number between 501 and 999. 

Enter a name for the condition table and double-click on the characteristics you want to use for the key. 

Generate the table. 

If desired, you can limit the period of validity of the condition table. If you do, all the condition records 

in this table are stored with this period of validity. The table must be a transparent table (table type "T"). 

Examples 

You want to use the condition type KPRA, which grants a price reduction for certain combinations of 

customer and product, in a costing sheet. In this case, you would select the fields "Customer" and 

"Product" from the CO-PA field catalog for Table 501 ( technical name: "A501"). If you wanted the 

price reduction to depend on the customer group, you would create a new condition table, 502 

("A502"), and enter the field "Customer group" from the field catalog. 

You want to calculate a percentage value based on the value of the characteristic "Material group". 

However, for certain materials a different value percentage rate should be used. Only if the material 

sold is not one of these materials should the percentage be based on the material group. 

To do this, you first need to create two condition tables: table 503 for the characteristic "Material" 

and table 504 for the characteristic "Material group". Then you can define an access sequence ZZ01 

that accesses these tables -- first table 503 (since the material should have higher priority), and then 

table 504. Once you have then assigned this access sequence to a condition type, you can define 

condition records in these tables for that condition type. 

          Access sequence               Condition tables 

               ZZ01                     1. 503 ( "Material" ) 

                                        2. 504 ("Material group") 

Actions 

Create your CO-PA-specific condition tables. 

Additional information 

You can use all the characteristics in Profitability Analysis -- in all operating concerns -- in the keys for 

condition tables. Thus if you have different characteristics that have the same text in different operating 

concerns, both of these characteristics appear in the field catalog. The fact that they have the same texts 

suggests that a double entry exists. 

You should only use characteristics from the same operating concern in a condition table. You can use 

the function "Field attributes" to display the corresponding data element for a characteristic in the field 

catalog. By comparing this data element with the data element stored in table CE1xxxx (xxxx = 

operating concern) for that characteristic, you can see which operating concern the field belongs to. 

 Define Access Sequences 

In this step, you define access sequences for your condition types in Profitability Analysis 

(CO-PA). You must assign an access sequence to each condition type for which you create 



 

 

condition records. 

The access sequence determines the condition tables in which the system should search for valid 

condition records for the condition type. Thus the access sequence is a sort of directory that tells the 

system where condition records for that condition type are stored. 

For each access sequence, you first need to enter a name and a short description. On the detail screen, 

specify which condition tables are to be used to access condition records, and the order in which these 

condition tables should be read. On the screen "Access Sequence: Access", specify the field contents 

(characteristics) with which they are read. 

Example 

Access sequence Z001 for condition type KPRA 

Lnr.   Table       Name 

----------------------------------------- 

01     501         Table Customer/product 

02     502         Table Customer group 

First the access sequence Z001 looks for condition records which exist for a certain combination of 

product and customer. If no records are found, the system then looks for a data record for the customer 

group. 

Activities 

Enter your access sequences and save them. Note that you must save your access sequences before you 

can assign them to condition types and create condition records for the condition types. 

 Create Condition Types and Costing Sheets 

Konditionsarten anlegen 

Konditionsschemata anlegen 

 Assign Value Fields 

In this IMG activity, you assign the CO-PA condition types you have defined to the corresponding 

value fields. This determines which condition types are used to value those value fields. 

For example, you can assign condition type "DISC" ("Discounts") to a value field "VVPRD" ("Price 

reduction"). The field names are filled automatically. 

It is possible to assign more than one condition type to a single value field. If you do so, the values of 

these conditions are added together and entered in that value field as one value. This is true even if the 

conditions come from different costing sheets in the valuation strategy. 

Actions 

Assign condition types to the CO-PA value fields you want to valuate. 
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 Define Pricing Reports 

In this menu option, you define the screen layout for pricing reports. You use pricing reports to analyze 

condition records according to different criteria. Technically, pricing reports are ABAP/4 programs. 

Note 

The standard SAP R/3 System contains predefined pricing reports which you can start using the 

application menu. 

Actions 

Display the pricing reports defined in the standard SAP R/3 System to check to what extent you can use 

them. 

Create new pricing reports. To do this, proceed as follows: 

Enter a two-digit description (with a character as the first digit) and the title of the pricing report 

you want to create. 

All key fields which are used in conditions appear in alphabetical order on the following data 

screen. Select all key fields which should be used in the pricing report. If you choose Edit-

>Further processing with AND, all condition tables will be evaluated that contain at least 

one of the selected key 

fields. If you choose Edit->Further processing with OR, only the condition tables that 

contain all the selected key fields will 

be evaluated.Select all condition tables which should be analyzed in the next dialog box. 

Choose "Position fields" to define the screen layout of the pricing report. Make sure that all key 

fields from the selected tables appear on the following data screen. 

Fields which should not be used as selection criteria later on when displaying the list, can be 

suppressed by cancelling the check mark in the "Selection" column. You can also indicate 

fields as obligatory on the selection screen. 

e) 

 Planning 

When you implement planning for Profitability Analysis (CO-PA), you need to determine the 

characteristics for which you want to plan, and the value fields that you want to plan. 

The automatic planning functions provide you with a number of options for copying, revaluating, 

forecasting, and distributing large amounts of plan data, which you can then process in detail using 

the manual planning functions. 

In manual planning, you can define planning layouts that let you create and modify plan values and 

quantities. 

The integrated planning functions let you transfer plan data from other applications, such as Sales and 

Operations Planning (SOP), cost center planning, or the Logistics Information System ( LIS ). 



 

 

Prerequisites 

The structures of your operating concern (characteristics and value fields) must be defined. 

The functions for defining profitability segments (such as derivation) and for valuating data must have 

been defined under the section "Master Data" in Customizing. 

 Initial Steps 

The following sections describe what preparatory steps are necessary for setting up planning: 

 Define Number Ranges for Planning Data 

In this step, you define a number range for updating plan line items in each of your operating concerns. 

In profit planning, the system automatically assigns a number which lies within your selected interval. 

Since the system does this automatically, the indicator "Ext" is not checked off. 

Prerequisites 

You must have system authorization for maintaining number ranges. 

You need to have defined the operating concern completely. 

Actions 

Define a number range. 

Notes on transporting 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

 Maintain Versions 

In this step you define the CO versions you want to use for your operating concern. These versions are 

valid for all of CO and for all operating concerns. 

In Profitability Analysis, you can only use versions for plan data. Consequently, the fields "Actual" and 

"Exclusive use" are not relevant for CO-PA. 

Each version has attributes which are only valid for one operating concern. 

The attributes determine the following: 
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whether you can plan a version 

The Version locked indicator lets you lock a plan version so that no more changes can be made to 

it. 

which currency type should be used to store the data in this version 

If, alongside the operating concern currency, the company code currency or the profit center 

valuation are also active in your operating concern, you need to specify the currency type for each 

version. 

which exchange rate should be used to translate foreign currencies to the local currency 

for what date the system should derive characteristics 

In planning, the system always tries to derive values for the characteristics which you do not 

specify. Since these derivation rules are time-dependent, you can specify which date the system 

should use when it performs derivation. 

which plan structure is checked for the plan version 

You can enter a plan structure here to ensure that plan data for different profitability 

segments corresponds to a pre-defined plan structure. For the transfer of plan data to SOP, you can 

determine: 

which characteristic group, if any, is used 

An interface in planning lets you transfer planned sales quantities to Sales and Operations Planning. 

You can specify for each plan version which characteristic group, if any, should be provided to the 

user as an entry aid. 

(See the example in the online documentation (F1).) If 

you plan in weeks, you also need to specify: 

which rule is used to distribute the weekly plan values to plan periods 

This rule determines how the weekly values are distributed to periods when a week cannot be 

assigned to one period. 

(See the example in the online documentation (F1).) 

which calendar is used as a basis for this distribution. 

Actions 

Define your CO version and select the "Plan" indicator. Then maintain the operating concern settings. 

 Assign Quantity Fields 

A number of quantity fields are defined and used in the SD billing system. In this step you assign these to 

the corresponding quantity fields in costing-based Profitability Analysis ( CO-PA ). 

Actions 

Assign all the quantity fields you want to transfer from the billing system to costing-based CO-PA. 

Additional Information 

You can transfer the billed quantity to costing-based CO-PA using the sales unit as well as the 

stockkeeping unit. The assignment you make here is valid for both profitability planning and for actual 

postings. 



 

 

This assignment is particularly important for planning, because the system can automatically derive the 

unit for the quantities you plan manually for individual products. 

 Check Active Value Flows of Actual Data 

To be able to compare your plan data with your actual data in CO-PA, you should orient your planning 

toward reflecting the flows of actual values in your system. Pay particular attention to the following: 

Plan your value fields in a way that reflects the actual value flows. For an overview of the flow of 

actual values, choose Tools -> Analysis -> Check Customizing Settings. 

If you want to assess costs, allocate activities indirectly from cost centers, or settle planning data 

from orders or projects, check the following activation parameters for actual data: 

Check whether the desired form of Profitability Analysis is active (choose Actual Flows of Values 

-> Activate Profitability Analysis). 

Check whether the actual data in your system is stored in both the operating concern currency and 

the company code currency, and whether you consequently want to plan in the company code 

currency as well. If so, you need to define plan versions and planning layouts for this purpose. 

Structures -> Define Operating Concern -> Maintain Operating Concern -> Attributes -
> Display. 

Check whether the data in your system is stored using profit center valuation as well as legal 

valuation, and whether you need to reflect this in planning as well. If so, you have to define 

special plan versions and planning layouts for this as well. Actual Flows of Values -> 

Multiple Valuation Approaches/Transfer Prices -> Activate Profit Center Valuation). 

  

 Planning Framework 

In this activity, you define your planning environment. To do this, you set up planning levels and 

planning packages using the planning framework. You also have the option of defining parameter sets 

for executing the individual planning methods. 

If you would like to transfer to the planning framework the settings that you used for planning in a 

previous release, SAP provides several conversion aids for this purpose. 

 Set Up Planning Framework 

In this step, you set up the planning framework and thereby specify the architecture to be used in 

planning. 

The planning framework consists of the following elements: 

Planning level 

Planning package 

Planning method 
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Parameter set 

For more detailed information about these individual elements and about setting up the planning 

framework, see the documentation for Profitability Analysis. You can access this documentation by 

choosing Help -> Application help. 

 Aids for Changeover to the Planning Framework 

If you have used CO-PA Planning in previous releases (before Release 4A), the system offers you aids in 

this step which you can use for the changeover to the new planning framework. 

Firstly, you can take an existing planning layout to create a corresponding planning level. 

Secondly, you have the option of displaying the settings for your old planner profiles. This simplifies 

making the settings in the corresponding parameter sets. 

 Create Planning Level from Planning Layout 

In this step, you can create a planning level on the basis of the planning layout that you used prior to 

Release 4A for sales and profit planning. You can then include the planning layout in parameter sets for 

that particular planning level. 

The system then uses the planning layout it finds to select all characteristics in the General Selections, 

the lead columns, and the value field columns, and copies them to the planning level. Moreover, the 

characteristic values - specified in the planning layout - for the currency type (in costing-based CO-PA) 

or the controlling area (for account-based CO-PA) are read and transferred to the planning level. 

Recommendation 

If you have used several planning layouts with the same characteristics and the same currency 

type/controlling area, you should only create one level for all these layouts. You should include the 

different layouts in different parameter sets at this planning level. 

Activities 

Enter the name of the existing planning layout and specify a new name as well as a description for the 

planning level to be created. 

 Display Planner Profiles 

Note 

The possible planner profile settings described below are not relevant for setting up the planning 

framework (see Set Up Planning Framework). It may be necessary to display your settings for planner 

profiles if you had already set up sales and profit planning prior to Release 4A and are now changing 

over to the planning framework. 

If it is not possible to switch to the planning framework for the moment, you can make changes by 

choosing Table View -> Display->Change. However, this option should only be used in exceptional 

circumstances since SAP reserves the right to phase out the transactions for the old planning functions in 

future releases. 



 

 

Defining Planner Profiles 

In this activity, you can define planner profiles to shape your planning process in sales and profit 

planning. 

Planner profiles are used throughout CO as well as in Profitability Analysis. The other applications 

include Overhead Cost Controlling (CO-OM), Profit Center Accounting ( EC-PCA), and the Executive 

Information System (EC-EIS). Consequently, you can define separate parameters for planning in these 

applications and planning in Profitability Analysis. 

Planner profiles have a hierarchical structure: 

Planner profile overview 

Settings for Profitability Analysis 

Profitability Analysis layouts 

Parameter settings for layout 

Planner profile overview 

You can assign each planner profile an authorization group. 

By assigning authorization groups and specifying fixed parameters (i.e. those which cannot be 

overwritten), you can provide your users detailed authorizations for creating plan data. 

Settings for Profitability Analysis 

Here you can define default settings for the current operating concern. Note that the type of 

Profitability Analysis also plays a role here. (Set operating concern.) 

The field "Items" indicates whether or not any planning layouts have already been assigned to the 

profile. 

For Profitability Analysis, you can store two default distribution keys for each planner profile. The 

system automatically defaults the distribution key "2" (Distribution as before) here. If you want to 

use segment-specific distribution keys, you can specify an access key here instead of a distribution 

key. 

You can also select the "Auto.TP vltn" and "Suppress zeros" options if desired. 

If you want to use top-down distribution in manual planning, you need to specify the desired distribution 

profile. This contains all the parameters for top-down distribution in manual planning (see Define 

Distribution Profile). 

- Profitability Analysis layouts 

You can assign one or more planning layouts to each planner profile. If you assign more than one, 

you can scroll between the planning layouts in planning using "Goto -> Next layout" and "Goto -> 

Previous layout". 

If no layout has been assigned to the profile yet, you can enter a new one. The system automatically 

issues an item number. If you would like to change an existing layout, delete the entry and create a 

new one. 

The "Default parameters" field indicates whether default characteristic values have been predefined 

for the layout. 

If you deselect the "Overwrite" field, the users who work with that profile must use the parameters 

you specify in the profile. They cannot overwrite the defaults with other values. If you leave 

indicator selected, the parameters you specify serve as defaults which can be overwritten at any 

time. 

The "File description" and the "Integrated Excel" fields are only relevant if you want to use 

Microsoft Excel as your planning tool. If you select "Integrated Excel", the system displays Excel 

within the SAP window in planning. In this case, you can enter a file name that should be used to 

link the fields of the Excel worksheet with those in the planning layout. If you do not enter a file 

name here, the system defines one automatically when you save. 
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- Default parameters for layout 

You can specify characteristic values to be used as default parameters for the planning layout. 

The system lets you specify values for all the variables defined in the planning layout. You can 

specify these parameters separately for each profile item for the planning layout. If you have 

selected "Integrated Excel", you can define a template for planning in Excel as well by choosing 

"Goto -> Overview screen". For information on what settings you can make in an Excel template, 

see "Setting Up Integrated Excel" in the CO-PA online documentation. 

Requirements 

The operating concern must be complete and active before you can create planner profiles for 

Profitability Analysis (see Maintain Operating Concern). In addition, planning layouts must already be 

defined (see Create Planning Layouts). 

Activities 

Process the planner profiles in the following order: 

Planner profile overview 

Create a new profile using the function "New entries", or copy an existing one using "Copy as". 

Enter an explanatory text for the new profile and, if desired, assign an authorization group. 

Settings for Profitability Analysis 

Enter the default distribution keys for the operating concern. Select the entry and choose 

"Profitability Analysis Layouts" in the navigation box. 

Profitability Analysis layouts 

Assign a planning layout to the profile. Deactivate the indicator "Overwrite" if you do not want the 

users to be able to overwrite your settings. Select "Integrated Excel" if you want to use Microsoft 

Excel as your planning screen with this layout. 

Default parameters 

Enter values for the variables defined in the planning layout. If desired, define and format an Excel 

worksheet has a template for your planning screens. 

 Manual Entry of Planning Data 

In this activity, you can define a planning layout with which to enter planning data manually. 

Furthermore, you can set up transaction-based top-down distribution, whereby manually entered data is 

distributed to a lower planning level when posted. 

 Define Planning Layout 

In this activity, you define the entry screens for sales and profit planning. These definitions are referred 

to as "planning layouts" and represent structures of rows and columns. 

Note: In most cases, you should create a planning layout via automatic generation from the parameter set 

for the planning method Enter Planning Data. The only planning layouts that you need to create 

manually are those with complex lead columns containing several characteristics that are specified by 

row. An example of such a planning layout is one for displaying a contribution scheme. In such cases, 



 

 

you have to ensure that the planning layout is compatible with the planning level. This means that all the 

planning level characteristics in the planning layout must occur in the General Selections, the lead 

columns or the value columns. 

Each planning layout is valid for one operating concern. 

If you are using parallel currencies in the current operating concern, you need to decide whether you 

want to plan the planning data in the planning layout 

in just the operating concern currency, or 

in the operating concern currency and the company code currency. 

You should make this decision first thing when you create this layout. 

If you are also using parallel valuations in the current operating concern, then you have a wider choice 

of options for planning the planning layout: 

Only in the operating concern currency with legal valuation, or 

In any valuation approach (that is, in the operating concern currency and/or company code currency with 

legal and/or profit center valuation. 

This planning layout setting cannot be changed retrospectively. 

The setting that you make determines which of the characteristics company code and currency type 

are made available to you for the planning layout definition: 

If you plan in just the operating concern currency (with legal valuation), you cannot select characteristic 

currency type. You can select characteristic company code as a normal characteristic. 

If you would like to plan in both currencies, you must select characteristics company code and 

currency type. 

If you would like to plan with profit center valuation, you only need to select characteristic currency 

type. 

If you also store your planning data in the current operating concern on the basis of calendar weeks, you 

then need to decide when you start defining a planning layout whether you want to use it to edit planning 

data for posting periods or to edit weekly data. 

Characteristics and value fields 

Every field on the screen belongs to a row and a column of the planning layout. The content of the field 

depends on the characteristics and value fields used to define the corresponding row and column. 

One characteristic you can use is the plan/actual indicator. This makes it possible to display actual values 

in planning for informational purposes. If you use the plan/actual indicator, you need to specify a value 

for it in each column. In "actual" columns, you cannot choose the characteristic "Version", whereas in 

"plan" columns you are required to do so. 

Characteristic values 

Characteristic values that are specified in the planning layout are overwritten by those specified in the 

planning package and in the planning level. This is because the selections made in the planning package 

and in the planning level supercede those in the planning layout. You should therefore make your 

selection in the layout as flexible as possible, which can usually be achieved by entering "*" as the 

characteristic value in the simple lead columns and in the general data selections. This entry captures all 

possible characteristic values and can be replaced by a single value or by an interval. However, the entry 

"*" is not permitted as the characteristic value for the following characteristics, which are exceptions: 

Currency type (or controlling area, for account-based CO-PA) 
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You need to enter the single value that is specified for this characteristic in the version specified in 

the planning level or in the planning package. 

Version 

You need to create a variable. During planning, the variable is then filled via the selection made in 

the planning package or the planning level. 

Period 

You need to create a variable for every "from" value and every "to" value. 

In complex lead columns and in value columns that also cannot take "*" as an entry, you need to use 

single values or variables that are then replaced during planning with selections from the planning 

package or the planning level. If you specify more characteristic values than there are in the planning 

package or the planning level, then entries cannot be made in the corresponding fields during planning. 

To enter a local variable for a characteristic value, select the checkbox "Variable on/off". Such 

variables are filled using the selections in the planning package or the planning level. You just need to 

ensure that the planning layout has the same number of variables for a characteristic value as the 

selection from the planning package or planning level. If, for example, there are two columns in the 

layout and each has a variable for the version, then the package should contain two single values for the 

version. If a "from" variable and a "to" variable have been entered in the general data selections for a 

characteristic, then a from-to value must also be specified in the package or level. 

Variables are valid only in the planning layout in which you define them. You can define the varaible 

name as you wish; it is unique for each characteristic and can therefore be used for different 

characteristics within a layout. For example, variable "1" for the characteristic "Version" is not the same 

as variable "1" for the characteristic "Division". Furthermore, a variable can be used more than once in 

the same layout. For example, variable "1" for "Version" can occur in the first and second columns. 

Text variables can be used anywhere where you would normally enter texts. To use a text variable, 

you need to enter "&$" followed by the name of the variable. 

The function Extras -> Variables -> Variable definition lets you assign the variable to a 

characteristic. When you enter planning, the system automatically finds a text depending on the 

value selected for that characteristic. (You cannot replace text variables manually.) 

Note 

For variables which refer to numeric fields, you can also use addition and subtraction. The 

variable is extended by a "+" or "-" and a number with up to two characters. 

Example 

The following layout, for example, allows you to plan the current fiscal year in the planning 

session by entering a variable, while allowing you to display the figures from the previous year 

for comparison purposes in another column. 

Column 1: A (period from) and B (period to) 

Column 2: A-12 (period from) and B-12 (period to) 

The variables in column 1 could be replaced with 01/200 (period from) and 12/2000 (period to). 

Those in column 2 could be replaced with 01/1999 (period from) and 12/1999 ( period to). 

Activities 

Define elements 

Except for a few minor differences, you define planning layouts the same way you define forms for the 

information system. 

A planning layout consists of the following parts: 



 

 

Header 

You define the header by choosing "Edit -> Gen. data selection" from the menu or by double-

clicking the word "Planning layout". The general data selection determines which characteristics 

and characteristic values appear where in the header. 

Lead columns and value columns 

Here you choose the characteristics, characteristic values and value fields you want to plan. 

Define the header 

In the general data selection, you specify the characteristics and characteristic values that you want to 

apply to all the rows and columns of the layout. For example, you should enter a version here if you want 

the entire layout to be for that version. The general data selection simplifies the layout and makes it 

easier to avoid errors when defining it. 

Once you have specified a value for a characteristic in the header, that characteristic is no longer offered 

for selection in the rows and columns. 

Under "Edit -> General data selection -> Gen. data selections", you can select as many characteristics as 

you like for the header of the planning layout. All these characteristics apply for all the rows and 

columns of the layout. 

Under "Edit -> Gen. data selection -> Header layout..." you can sort the characteristics as you would like 

them to appear in the header. Note that the system can only display up to nine characteristics in the 

header. 

Define lead columns 

There are two ways you can define lead columns: 

Define simple lead columns via the column header 

You define the first lead column by double-clicking the column header. You can then add new lead 

columns via the menu option "Edit -> Columns -> New lead column". Note that the new lead 

column is always inserted in front of the existing lead columns! If you define lead columns this 

way, you can only choose one characteristic for each lead column. Note: You should only define in 

this way in exceptional circumstances, such as to postprocess a planning layout. Normally, such a 

layout with simple lead columns should be generated automatically from the planning level. 

Definition of a specific lead column from the rows (complex lead column) If you choose to define the 

lead column this way, you need to define each row individually. You can specify characteristics, a 

value field or a formula for each row. For example, this allows you to display a contribution margin 

in a lead column. The procedure you use is the same as that for defining value columns. 

Note 

Remember that you determined whether the value fields go in the rows or the columns of the 

planning layout when you defined the first row or column. You cannot change this decision later. 

Define value columns 

There are three ways to define a value column: 

Define a normal column using characteristics 

or value fields 

You define the first value column by double-clicking that column's header. You can define 

additional columns in the free space following the first column by double-clicking in that space. 

After choosing the desired column, specify the desired characteristics and characteristic values. 

Intervals of characteristic values in one row (for example, products A through H) are not allowed. If 

necessary, enter "#" for "not assigned". 
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It is important that you choose the same characteristics for every column, with the exception of the 

version, if you are using different plan/actual indicators. (The version must be specified in plan 

columns, and cannot be specified in actual columns.) 

Define an attribute column You can enter the 

following attributes: 

distribution key 

The distribution key determines how cumulative values are distributed to the individual 

periods. This makes it possible to represent seasonal trends across periods. If no distribution 

key is entered, the system distributes proportionately according to the existing data, or evenly 

if no data exists yet. 

unit 

This attribute lets you assign a currency or quantity unit to a value field. 

action 

If you choose the attribute "Action", you can enter delta (= changed) values to help you solve 

calculations. For example, say you want to add USD 15,000 to the existing plan value of USD 

40,000. Here you would enter "+" in the field "Action" and "15000" in the value column. 

long text indicator 

If this indicator is set, it means that a long text exists for the profitability segment in that row. 

characteristic 

This attribute lets you display all characteristics, even those not used in the planning layout. 

Again it is important that the same characteristics are chosen for every column. The only 

exception to this are characteristics of time, which cannot be chosen for the attributes 

"Distribution key", "Action" and "Unit". For the attributes "Long text indicator" and 

"Characteristic", neither characteristics of time nor value fields can be chosen. The attributes 

"Distribution key", "Unit" and "Action" are always linked directly to one data cell. There are two 

ways you can define these attributes: 

You can assign the attributes directly to a value column via the menu path "Edit -> Columns -> 

Append additional fields". If you later want to change the characteristic value in the assigned value 

column, the system can automatically change the attribute column accordingly, if you desire. 

If you define the attribute by double-clicking in the space next to the existing value column, 

the system does not create a reference. In this case the system requires you to enter the 

characteristics and values again. If you choose the attribute "Unit", this field will contain 

either the quantity unit or the entry currency, depending on the corresponding value field. For 

more information about units and foreign currencies, see the CO-PA documentation (SAP 

Library). 

3. Define a formula column 

To define a formula column -- a value column for which the values are calculated using a formula -- 

proceed as follows: 

Double-click the free space after a value column and choose the element type "Formula". 

In the next dialog box, you can define a formula using the value columns you have 

already defined. 

Using the menu option "Formatting -> Ready for input y/n", you can define rows or columns of 

your layout as mere display rows or columns, in which no manual entry can be made. This makes 

sense if you want the system to display certain data, such as a different plan version than the one 

being planned, for purely informational purposes. 

Example 

Value column 1: (ready for input) Plan price ( Revenue/quantity ) 

Value column 2: (calculated) Plan revenue 



 

 

If you want to plan the price directly, you need to activate this field for input using the function 

"Formatting -> Ready for input y/n". The price will not be stored in the database. Therefore you 

need to calculate a database field from the price. In the above example, that field is the revenue. 

Consequently, the field "Revenue" is locked for manual entry and defined by the inverse formula 

"quantity * price". For another example of an inverse formula, see the standard planning layout 0-

SAP05 (operating concern S001). 

Default settings for decimal places and display factor 

When you define the planning layout, you can set the number of decimal places you want displayed as 

well as a display factor (e.g. planning in 00s) for each column. These settings can be changed at any time 

in planning. 

 Set Up Transaction-Based Top-Down Distribution 

In this activity, you can set up transaction-based top-down distribution for manually planned data. This 

function means that, when you save your planning data, it is automatically distributed top-down to a 

more detailed planning level. 

Transaction-based top-down distribution lets you ensure that your planning data is always updated at the 

same planning level. Even if you enter the planning data at more aggregated levels (such as the 

product/product group level or the product/customer group level), the system automatically posts it at the 

lowest level (product/product group/customer group). 

Transaction-based top-down distribution functions essentially the same way as the automatic planning 

method top-down distribution, whereby the relevant data is distributed. 

Note 

Transaction-based top-down distribution can lead to long runtimes. If your planning process calls for 

planning data to become increasingly detailed in different phases, you should use the automatic planning 

method for top-down distribution. 

 Define Value Field Assignments 

In this activity, you assign the value fields you want to distribute in top-down planning to the values you 

want to use as the reference for the distribution. 

You can distribute your value fields using three basic strategies: 

Reference "Fixed value field" 

This option distributes the values of all value fields according to one reference field. You can 

choose any value field, such as the revenue or sales quantity, or any calculate value defined using 

value fields. If you want to use a calculated value, you must define this in the activity Define 

Calculated Values for Use as Reference Values. 

If you want to use one fixed value field or calculated values as the reference, enter the value fields 

you want to distribute, and then enter the reference value for each of these. 

Referece "By value fields" 

This option allows you to use each value field as the reference value for distributing that particular 

value field. This means that the revenue is distributed based on the revenue in the reference data, 

the quantity discount according to the quantity discount in the reference data, and so on. 

To achieve this, enter each value field you want to distribute and then enter the same value field as 

the reference. 
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Reference "Any value field" 

You can also choose to distribute the value fields using any other value field or calculated value. 

Requirements 

If you want to use calculated values as reference values, you need to have defined these beforehand. 

 Define Distribution Profiles 

In this activity, you define a so-called "distribution profile", which contains all the necessary control 

information for top-down manual planning. This includes information on the reference data, the top-

down method, the reference value and the desired distribution level. 

When you enter your distribution profile in a parameter set, you tell the system to distribute your 

manually planned data top-down when you save your data. 

Activities 

To define the distribution profile, you need to specify the following: 

A reference record type. You can decide whether to use a fixed record type as the reference data or 

always use the record type of the data being distributed top-down ( "*" ). 

A reference version. You can decide whether to use a fixed version or the version of the data being 

distributed ("*") as the reference data. 

In top-down planning, you can use two different methods of top-down distribution. The method 

Redistribute aggregates the values already planned at the lower levels and then redistributes them 

according to the reference values. The method Distribute "nonassigned" only only distribute the 

amount planned directly at the higher level. For an example, see the F1 Help for this field. 

In the value field assignment, you determine the reference values that will be used to distribute the plan 

data to the distribution level. 

Once you have defined the distribution profile, you can specify the distribution level, which is the 

characteristic or characteristics to which the plan data should be distributed. 

 Calculated Values as Reference for Top-Down Distribution 

In this activity, you define a key figure (a formula based on value fields) for use as the reference values 

for distributing planning data or actual data using top-down distribution. 



 

 

Example 

You defined a key figure "Net revenue = Revenue - Discounts" and enter this as the reference value in 

top-down distribution. The system distributes the data in proportion to the net revenue according to the 

reference data of the profitability segments at the lowest level. 

Activities 

Define the desired key figures 

If you want to use the key figure as the tracing factor in automatic top-down planning, select the key 

figure in the parameter set under Reference value field. 

If you want to use the key figure for top-down manual planning, you need to assign it to the value fields 

you want to use it for. You do this in Customizing. 

If you want to use the key figure as a tracing factor for actual top-down planning, select the option "Fixed 

value field" under "Tracing factor" when you execute it and enter the key figure in the field "Value 

field". 

 Integrated Planning 

In integrated planning, you determine which plan values are transferred from other applications (such as 

cost center planning or LIS), and which plan values are transferred to other applications (such as Sales 

and Operations Planning ( SOP )). 

 Transfer Cost Center Planning/Process Planning 

The following business transactions let you transfer overhead to Profitability Analysis. 

 Initial Steps 

In this section you make the settings necessary for transferring overhead to sales and profit planning. 

 Define Calculated Values for Use as Reference Values 

In this activity, you can define calculated values for use as tracing factors for cost center assessment, 

process assessment, or indirect activity allocation. 

Example 

You want to assess the costs of your cost centers on the basis of the net revenue of the receiver 

profitability segments. So you define this value here using value fields. 

Activities 

Define a calculated value as a formula consisting of value fields. 

When you define your cycles for assessment or indirect activity allocation, you can then choose these 

values as tracing factors. 
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 Assign Characteristic Groups to Plan Cycles 

In this step, you specify (for cycle maintenance for assessment and for the allocation of indirect 

activities) which characteristics can be used to define the receiver during segment maintenance. To do 

this, you assign a characteristic group to the business transaction of the particular allocation type 

concerned. 

Example 

During segment maintenance for a planned assessment cycle, only the characteristics "Company code", 

"Customer" and "Sales organization" should be available for defining the receiver. You therefore assign 

a characteristic group containing these characteristics to the business transaction KSPB (Plan assessment 

to CO-PA). 

Requirements 

You need to have defined a characteristic group containing the characteristics that are to be made 

available for defining the receiver. You do this by choosing Flows of Actual Values -> Initial Steps -

> Characteristic Groups -> Maintain Characteristic Groups. 

 Assign Receiver Plan Version 

Example 

You want to merge a plan version in Cost Center Accounting with a different plan version in CO-PA. 

Activities 

Assign the version in CO-OM to the desired receiver version in CO-PA. 

 Activate Transfer of Cost Component Split During Activity 

Allocation 

In this activity, you activate the transfer of the price cost components from activity and process allocation 

to Profitability Analysis. 

Activities 

If you use the cost component split in Cost Center Accounting or Activity-Based Costing for price 

calculation, you can update the prices divided into cost components during allocations to Profitability 

Analysis. To do this, you need to perform the following steps: 

Maintain the cost component split assignments to CO-PA value fields. 

Assign a value field or, when splitting into fixed and variable portions, both value fields to each of 

the cost components of the cost component structure used in Cost Center Accounting or Activity-

Based Costing. 

You find the corresponding cost component structure in the detailed information on the section of 

the CO version dependent on the fiscal year. 



 

 

Activate the transfer of the cost components for the corresponding operating concern. 

Further notes 

Note that, when the transfer is activated, price revaluations are also updated for activities posted 

previously using the assignment of cost components to CO-PA value fields. 

For more information on the cost component structure and on price calculation with cost components, see 

the SAP Library in the area Financials -> Controlling -> Cost Center Accounting -> Period-End Closing 

-> Actual Price Calculations -> Price Calculation with Cost Component Split. 

 Assign PA Transfer Structure to Business Transaction 

In this activity, you specify which PA transfer structures are used for specific business transactions to 

transfer overhead. 

For this, you assign a PA transfer structure to the business transaction of the respective allocation type. 

Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. Initial entries in the PA Transfer Structure column are reset to 

the following SAP standard selection when you save. 

PA transfer structure "CO" for 

Internal activity allocation 

Template allocation from cost center costs and process costs 

Revaluation due to price ( re)calculation 

PA transfer structure "FI" for repostings 

Example 

You want to be able to display price changes individually when revaluating internally allocated activities 

with a price calculation. 

By assigning different PA transfer structures for the business transactions "Activity Allocation" and 

"Revaluation Due to (Re)Calculation of Prices", you can send the results from the revaluation of activity 

quantities into other value fields as opposed to those for the values calculated in activity allocation. 

 Assess Cost Center Costs / Process Costs 

You can assess both plan and actual cost center costs and process costs to profitability segments as part 

of your period-end closing activities. 

Example 

You can assign the costs of your sales cost centers to the customer groups and regions for which those 

cost centers are responsible. You can assess specific percentages of the costs or absolute amounts to the 

different customer groups and regions, or you can distribute them in proportion to certain values 

contained in the value fields of those segments (tracing factors). 

Activities 



 

WHATSAPP +255738656506 

 

Define an assessment cycle. The cycle determines: 

The cost centers or business processes that assess the costs 

The profitability segments that receive the costs 

The amounts that are to be assessed 

The tracing factors according to which the costs are distributed to the different profitability 

segments 

In the cycle, you need to specify a PA transfer structure if you want to transfer different cost element 

groups to several value fields in costing-based CO-PA. 

You need to specify an allocation structure if you want to credit the cost center using several assessment 

cost elements. 

Note 

You can only use PA transfer structures and allocation structures with sender rule "1" ( posted amounts). 

 Define Structure of Cost Center Assessment/Process Cost Assessment 

In this step you define rules for allocating cost center costs and process costs to Profitability Analysis 

(CO-PA) in the form of cycles. 

Activities 

Define your assessment cycles. In doing so, observe the following: 

The header of the cycle contains the parameters that are valid for the entire cycle. This includes the 

sender selection type, where you specify for actual data whether you want to assess all costs 

together or fixed and variable costs separately. 

The segments contain the combinations of sender cost centers/sender processes and receiver profitability 

segments that are processed using a single distribution rule. 

Specify either an assessment cost element or an allocation structure, which determines more than 

one assessment cost element for each cost element group. The sender cost centers/sender 

processes are credited using these secondary cost elements (cost element category 42). In 

account-based CO-PA, the receiver profitability segments are also credited using this cost 

element. 

Specify either single value fields for the fixed and variable costs, respectively, or a PA transfer 

structure that determines more than one value field for each cost element group. 

Specify the rule which you want to use to credit the sender. 

Note that, for technical reasons, you can only use an allocation structure or a PA transfer 

structure with sender rule "1" (posted amounts). 

Define the tracing factor, the rule which determines how the values are distributed to the receivers. 

For example, you can distribute certain percentages to the different receivers or distribute 

using certain values (such as the quantity sold or the revenue) as an allocation base. If you 

choose to use an allocation base, choose the receiver rule "Variable portions". 

Specify the senders and receivers in the allocation characteristics. 



 

 

Prerequisites 

For process cost assessment, Activity-Based Costing (CO-OM-ABC) must be active as an operational 

Controlling component in your system. 

The desired form of Profitability Analysis must be active. 

You can check the form of Profitability Analysis by choosing Actual Flows of Values -> Activate 

Profitability Analysis. 

Credit postings require you to have assigned an internal number range for the CO transactions KSPA 

(actual) or KSPB ( plan ). 

To verify that this has been done, switch to Customizing for General Controlling and choose 

Organization -> Define Number Ranges for CO Documents. 

In Profitability Analysis, you must define a number range for record type "D". For actual data, you verify 

this by choosing Flows of Actual Values -> Initial Steps -> Define Number Ranges for Actual 

Postings. 

In planning, you verify this by choosing Planning -> Initial Steps -> Define Number Ranges 

for Planning Data. 

To improve runtimes in assessment, it is recommended that you use summarization levels if possible. 

These provide presummarized tracing factors for the receiver profitability segments. 

Notes on Planning 

The receiver version of a cycle is determined using the assignments you make to the sender version under 

Planning -> Integrated Planning -> Transfer Cost Center Planning/Process Planning -> 

Initial Steps -> Assign Receiver Plan Version. 

Note that the field "Receiver version" is only relevant for costing-based Profitability Analysis. In 

account-based Profitability Analysis, postings are made to the sender version. - Ensure that 

the controlling area for the receiver is the same as that for the sender. Consequently, for the receiver 

rule "variable portions", you need to ensure that the characteristic "Controlling area" has already 

been planned in manual planning if planning data is to be taken as the basis for the assessment. 

For actual assessment, you cannot use cycles that you defined for plan process assessment. You need to 

define new cycles separately. Nevertheless, you can copy plan cycles to actual cycles and vice 

versa. 

 Define PA Transfer Structure for Assessment 

In this activity, you define a PA transfer structure for performing assessment. 

If you want import the values posted to a cost center/process into different value fields by means of 

differentiation by cost element, you can use one of the following options: 

You can set up a cycle with several segments. For this, you need to create a separate segment for each 

assignment of a cost element interval/cost element group to a value field. 

You can set up a cycle with only one segment. For this, the assignment of cost elements to the respective 

value fields is defined via a PA transfer structure. 
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You can use the PA transfer structure to combine in a single segment different assignments of cost 

elements/cost element groups to value fields. Instead of a value field, you can enter the PA transfer 

structure when defining an assessment cycle in the segment header. 

Notes: 

You can only use a PA transfer system together with the "Posted values" sender rule. 

Even when it is technically possible, via a joint maintenance dialog, to use PA transfer structures from 

different allocation types to perform the assessment, you should still define separate PA transfer 

structures. 

Equally dependent on the joint maintenance dialog, there are some selection options within the 

maintenance functions for the PA transfer structure that do not apply to structures used exclusively 

in assessment. These options are discussed below under "Activities". 

Activities 

Create a PA transfer structure for assessment. 

Decide how you want to divide the cost elements and define corresponding assignment lines. This 

division is then used to transfer the cost elements to the CO-PA value fields. The indicator for 

quantity billed/delivered is not relevant for assessment and hence should 

not be activated. 

For each assignment line, enter into the cost center/process the cost element(s) or the cost element that 

are to be assigned. 

As the source, activate the "Costs/Revenues" option. Note that only costs are allocated during 

assessment, not revenues. 

For each assignment line, enter the value field (or, if the cost elements are split into fixed and variable 

portions, both value fields) into which the entered costs are to be imported. 

 Define Allocation Structure 

If the assessment for each segment is not made with a pre-defined assessment cost element, you can 

assign the source cost elements to the desired assessment cost element in the allocation structure. During 

cycle definition, enter the allocation structure instead of an assessment cost element in the segment. 

An allocation structure for the assessment consists of at least one assignment, stating the assessment cost 

element to which the source element is assigned. The original cost elements will already have 

assignments in the source. 

Requirements 

To define the assessment cost elements required for the allocation structures, you must first complete the 

IMG activity "Create Assessment Cost Elements". 



 

 

Activities 

Creating an allocation structure. 

To create an allocation structure, proceed as follows: 

Choose "New Entries". 

Enter a name and text for the allocation structure. 

Save the allocation structure. 

Enter the assignments for each allocation structure. To make the assignments, proceed as follows: 

Select the allocation structure, and then choose "Assignments". 

Choose "New Entries". 

Enter a name and text for the assignment. 

Save the assignment. 

Specify the source for each assignment. 

To specify the source for an assignment, proceed as follows: 

Select the assignment, then choose "Source". 

Enter a cost element interval or a cost element group. 

Save the source. 

Enter the assessment cost element for each assignment. 

To specify an assessment cost element for an assignement, proceed as follows: 

Select the assignment, then choose "Assessment cost element". 

Enter the assessment cost element you require. 

Save your entries. 

 Display Cycle Overview of Plan Assessment 

In this step, you can display the cycles for planned assessment that have been defined in an operating 

concern. 

Cycles are displayed in a tree structure on the left-hand side of the screen. By expanding the nodes, you 

can display the segments for a cycle. 

On the right-hand side of the screen, you can change the selection used to call up the tree structure for the 

cycles and you can display additional columns in the tree. 

To call up detailed information about a cycle and a segment, select the required object in the tree by 

double-clicking it and switch to the tab index Cycle information. From the detailed information screen, 

you can switch to cycle maintenance to make changes there. Alternatively, you can execute the cycle 

directly. 
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 Direct/Indirect Activity Allocation 

In this step, you make the necessary settings for allocating activities from cost centers and processes to 

profitability segments. 

Whereas in assessment you can distribute the data from cost elements or cost element groups by 

percentages or based on tracing factors, the distribution of values in activity allocation depends on the 

activity involved. 

Direct activity allocation 

Normally, you can assign activities that are performed for certain profitability segments (such as 

customers or products) directly to those segments. When you do so, the system transfers the quantity of 

the activity performed and valuates this with the planned price for that activity in the cost center 

involved. This makes it possible to allocate consulting hours, for example, to the customer for whom 

they were worked. 

Prerequisite 

The activity must be defined as activity type category "1" (manual entry and manual allocation) 

in Cost Center Accounting, and an activity quantity must have been planned manually. 

Activities 

Define the PA transfer structure "CO". 

Indirect activity allocation 

If the activity cannot be measured directly, you can create a quantity structure on the basis of certain 

assumptions, and then valuate and allocate this structure just like direct activity allocation. An example 

for this would be a cost center "Order processing", for which no activities are explicitly entered. In order 

to allocate these costs in accordance with how they originated, you can create a quantity structure based 

on a quantity field "Number of orders entered", and then valuate this with a planned price. 

Prerequisite 

The activity must be defined as activity type category "2" (Indirect creation and indirect 

allocation) or "3" (Manual entry and indirect allocation) in Cost Center Accounting. If you use 

category "3", you also need to define an activity quantity for the sender. 

Activities 

Define the PA transfer structure "CO". 

Define indirect activity allocation for cost centers or processes. 

Further Notes 

The sender cost center are credited using the allocation cost element that was assigned to the activity 

type. 

In account-based CO-PA, the values are posted to the same allocation cost element. 

In costing-based CO-PA, the allocation cost element needs to be assigned to a value field in PA transfer 

structure "CO". The value is transferred to that value field. 



 

 

 Maintain PA Transfer Structure for Template and Activity 

Allocation 

In this activity, you maintain PA transfer structures that are used for the following allocations of actual 

and plan data: 

Internal activity allocation 

Template allocation for cost center costs and process costs 

Revaluation due to price ( re)determination 

Reposting 

You use the PA transfer structure to determine which allocation cost elements are transferred to which 

CO-PA value fields. 

You can also transfer the allocated activity quantity to CO-PA. To do this, include in the assignment the 

corresponding quantity field along with the value field(s). 

Note: 

Since this maintenance dialog is also used in the definition of PA transfer structures for other allocations, 

there are several selection options that do not apply to the PA transfer structures used here. These options 

are discussed below under Activities. 

Activities 

Maintain the appropriate PA transfer structure. 

Decide how you want to divide your allocation cost elements and create corresponding assignment lines. 

This division is then used to transfer the cost elements to the CO-PA value fields. 

Note: The indicator for quantity billed/delivered is not relevant here and should therefore not be 

activated. 

For each assignment line, enter the allocation cost element(s) or the allocation cost element group to be 

assigned. As the source, activate the "Costs/Revenues" option. Note that only costs are allocated 

during activity allocation and template allocation, and that revenues are not. 

For each assignment line, enter the value field (or, if the costs are split into fixed and variable portions, 

both value fields) into which the entered costs are to be imported. 

Assign the PA transfer structure to the corresponding business transaction. Maintain these settings 

separately for actual business transactions and plan business transactions . 

Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. ("CO" or "FI"). 

 Set Up Indirect Allocation of Activities from Cost 

Centers/Processes 

The advantage of indirect activity allocation over cost assessment is that you can allocate the entire 

activity based on the activity quantity performed or one determined indirectly after valuating it with a 

fixed and/or a variable price. For information on the basic concept of indirect activity allocation, see 

Indirect Activity Allocation. 

Activities 
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Set up indirect activity allocation as described by performing the steps described in the section Define 

Indirect Activity Allocation in Customizing for Cost Center Accounting. You use the same steps 

again to set up the indirect allocation of activities from processes. 

Enter a cost center and a suitable activity type or business process as the sender objects in the cycle. 

As the receiver, specify those profitability segments that are relevant for the allocation of costs. 

Prerequisites 

For the indirect allocation of activities from cost centers: 

You must have an activity type that uses allocation category 02 or 03. Maintain Activity Types for 

Indirect Activity Allocation. 

Planning data must exist for the activity type so that 

plan price iteration has been carried out, or - a plan price was defined manually for the cost center, or 

an actual price must have been determined in period-end closing. 

For the indirect allocation of activities from processes: 

You must have Activity-Based Costing implemented as an operational Controlling component in your 

system 

You need to have defined a process containing the allocation category 02 or 03. 

The process has been planned during business process planning so that - a price is available for 

valuating utilization, or - an actual price is determined. 

Notes on Planning 

The receiver version of a cycle is achieved when you have performed the assignment to the sender 

version under Planning -> Integrated Planning -> Transfer Cost Center Planning/ Process 

Planning -> Initial Steps -> Assign Receiver Plan Version. 

Note that the receiver controlling area should be the same as the sender controlling area. It is therefore 

important for the receiver rule "variable portions" that the characteristic "controlling area" has been 

planned in manual planning if allocation is to occur on the basis of planning data. 

 Display Cycle Overview of Plan Activity Allocation 

In this step, you can display the cycles created in an operating concern for indirect activity allocation in 

planning. 

Cycles are displayed in a tree structure on the left-hand side of the screen. By expanding the nodes, you 

can display the segments for a cycle. 

On the right-hand side of the screen, you can change the selection used to call up the tree structure for the 

cycles and you can display additional columns in the tree. 

To call up detailed information about a cycle and a segment, select the required object in the tree by 

double-clicking it and switch to the tab index Cycle information. From the detailed information screen, 

you can switch to cycle maintenance to make changes there. Alternatively, you can execute the cycle 

directly. 



 

 

 Maintain Cost Component Split Assignments for Activity Allocation 

In this activity, you define the assignment of cost elements to value fields. 

Requirements 

This assignment is only relevant if the transfer of the cost component split to Profitability Analysis is 

active. 

Activities 

Assign a value field or, if splitting into fixed and variable portions, both value fields to each of the cost 

components of the cost component structure used in Cost Center Accounting or Activity-Based Costing. 

You find the corresponding cost component structure in the detailed information on the part of 

the CO version dependent on the fiscal year. 

Further notes 

For more information on the cost component structure as well as on price calculation with cost 

components, see the documentation in the SAP Library in the area Financials -> Controlling -> Cost 

Center Accounting -> Period-End Closing -> Actual Price Calculations -> Price Calculation with Cost 

Component Split. 

 Set Up Template Allocation 

In contrast to assessment, template allocation lets you allocate overhead costs (for business processes or 

cost centers/activity types) in a cause-and-effect manner based on the quantities used. 

To do this, you must define a template containing the formulas and functions required for calculating the 

quantities used and thus the cost drivers. The quantities are then valuated by means of price calculation. 

Dynamic template allocation functions as follows: 

When carrying out the allocation, the user specifies the particular characteristic area for which the 

allocation should be carried out. If there are characteristic values in this area that are linked with a 

template via a selection strategy, this template is then used automatically. The template's settings are 

employed to determine the appropriate activity quantities and the appropriate business process or cost 

center/activity type that forward those quantities to the profitability segment. The activity quantities 

(valuated with prices) are then allocated to the profitability segment whose dimensions are defined in 

Customizing. The costs are not only allocated to the specified update characteristics. They are also 

allocated to all characteristics that you defined as target fields for source characteristics via a derivation 

rule. 

To create all prerequisites for this procedure, you need to carry out the following steps in Customizing: 

First, limit the number of record types. Doing so reduces the amounts of data to be processed, thus 

enhancing system performance. Moreover, this prevents duplicate allocations from occurring (for 

example, for an incoming sales order and again for its corresponding billing document). 

You specify the dimensions of the profitability segment by entering update characteristics. You then 

make some or all of them into selection characteristics. These determine which criteria are used to 

select the destination objects in the template allocation. 

This last step completes the definition of the profitability segment. The following steps allow you to set 

about using the process template: 
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You generate and maintain the template environment by changing environment functions already present 

or creating new ones. 

You can use the environment functions delivered in the system or those that you created yourself to 

create the templates required for your allocations. 

To ensure that the appropriate template is used for allocation, enter at this stage which characteristics and 

which characteristic values should be used to define the template. 

You then specify in the PA transfer structure which value fields the process costs are posted to. This 

occurs via the assignment of the allocation cost elements (for business processes or cost 

centers/activity types) to value fields. 

 Define Record Types for Selecting Cost Drivers 

In this activity, you choose which record types in CO-PA you want to use as tracing factors for selecting 

the cost drivers. This reduces the number of profitability segments used in template determination, 

thereby producing several advantages. Such a reduction can considerably enhance performance, for 

example. 

You can choose from the record types delivered by SAP or define your own: Define New 

Record Types 

Example 

If incoming sales orders and billing documents are both posted in CO-PA, you can decide whether the 

sender objects (such as processes) should be allocated at the point of entry of the incoming sales orders 

or of the billing documents. If you choose both record types, then you have to decide on an activation 

condition in the template that controls when the sender objects are settled. This ensures that a settlement 

does not occur twice. 

Activities 

To choose a record type, select the appropriate checkbox and save your selection. 

 Specify Characteristics for Selection and Update 

In this activity, you define update characteristics and specify which ones you want the system to use to 

select profitability segments in template allocation. 

Allocated costs in CO-PA are posted to the update characteristics (and to the characteristics derived 

from them). Update characteristics are used to locate cost drivers. 

When you carry out the dynamic process allocation, the selection characteristics appear for selection. 

This enables you to limit the number of characteristic values. 

Note 

Delta postings to characteristics are no longer possible once the latter have been changed. 

Activities 



 

 

Select 'New Entries'. 

Select the desired update characteristics in the "Characteristic" column using the possible 

entries function. The characteristics for the operating concern are then available. Note: The 

characteristics "Product" and "Customer" are not offered for selection because the general 

allocation of sender objects to lowest-level characteristics usually causes performance problems. 

To specify an update characteristic as a selection characteristic, click on the corresponding indicator in 

the "Selection" column. 

Note 

You can define other update characteristics which can then also be considered during profitability 

segment determination, but dependently of the characteristic values relating to the update characteristics 

defined under "New Entries". You do this in the transaction Maintain Process Template Determination 

and Other Update Characteristics. This makes sense if, for example, the characteristic "Customer" is to 

be included in operating concern determination for a specific customer group. (Example: if an update 

should occur at customer level whenever the characteristic "Customer group" receives the value "Major 

customer"). 

 Generate Template Environment for CO-PA 

Before you can define a template, you first need to modify the template environment so that it is 

compatible with your operating concern. 

The update characteristics that you specified and the value fields of your operating concern are first made 

available in the environment. 

Activities 

Choose from the available characteristics and value fields all those that you wish to use for maintaining 

the template. 

 Maintain Template Environment and Function Trees 

At this point, you can choose from all the possible environments for template allocation. However,you 

should ONLY edit the environment PAC ! Ensure that you note the following when executing the 

allocation. 

General 

In this step you maintain: 

Function trees 

Structure nodes - Function references - Functions. 

The basis for the maintenance of the object is always the chosen environment. 

Environment 

The Template's environment determines the information of the SAP-environment and the external system 

that can be accessed. Basically, the functions relevant to each context are already provided in the 
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corresponding environment. Environments always contain a row of sub-environments which group 

functions by theme; these include material, BOM, routing, and others. 

The standard system delivers the following environments: 

Template allocation (for cost objects, profitability segments, 

business processes, cost centers/activity types) 

Formula planning (business processes, cost centers, profit centers) 

Standard cost estimates 

Process quantity determination ( SOP/LTP ) 

Easy Cost Planning/Internal Service Request 

Recommendation 

Use the sub-environments provided by SAP as much as possible. When you assign an function to a sub-

environment, it is automatically available in all the main environments containing this sub-environment. 

Further notes 

For more information on environments and a list of these and their sub-environments go to the help for 

applications of Activity-Based Costing under "Template -> Template Environment". 

Function Tree 

A function tree is a user-defined hierarchy which structures or groups functions. With the Help for 

function trees, you can structure groups of functions available in each environment according to their 

their theme or emphasis. Functions are then processed from here on. 

A function tree is assigned to an environment and consists of nodes and function nodes. 

Environments: all environments are displayed when you call up the n transaction. Environments 

themselves cannot be changed or deleted. The creation of new environments is also not possible. 

Function trees: the first level under environments. You can subordinate nodes or function nodes to a 

function tree. 

Nodes: nodes are always subordinate to function trees or other nodes. You can subordinate other nodes to 

a node or function node. In function trees SAP1, nodes contain sub-environments. 

Function nodes are always subordinate to function trees or nodes. They always refer to a function. 

SAP standard delivery for all environments includes function tree SAP1 (for example, for environment 

001, function tree SAP1-001). This contains all standard nodes ( sub-environments ) and function nodes 

(with reference to the respective function). 

Activities 

The transaction provides you with left and right screens. The left one displays the existing environments. 

You can expand the hierarchy and view the function trees, nodes and function nodes in their hierarchical 

structure. Place the curser on an object you want to process. 



 

 

The right screen details of the chosen object (environment, function tree, nodes or function nodes) in list 

form. If you double click on a funciton node you will see the maintenance screen for the functions. 

Further notes 

For more information see Application help for Activity-Based Costing: 

AC-Financials -> CO-Controlling -> Activity-Based Costing -> Template -> 

Function tree -> Maintain function tree or Template -> Template environment -> Maintain 

functions 

AC-Financials -> CO-Controlling -> Cost center accounting -> Cost center planning -> Aids -> 
Formula planning -> Template -> Template environment. 

 Maintain Template 

Here you maintain templates. 

Applications 

Each purpose (application) of a template requires a special environment. Before creating a template, 

choose an environment. The environment determines which row and column types are available, for 

example. 

The available applications include the following: 

Template allocation to cost objects, or use in standard cost estimates for cost objects and materials 

(environments 001 - 012) 

Template allocation to business processes, cost centers, or cost centers/activity types 

(environments SBP, SCI, SCD) 

Template allocation to profitability segments (environment PAC) 

Formula planning (environments CPI, CPD, BPP, PCA) 

Calculation of output quantities (environment SOP) 

Easy Cost Planning/Internal Service Requests (environment 200 - 299) 

Structure 

A template consists of rows (items) and columns. The row and column types available to you depend on 

the environment. 

Columns available include: 

Type of row, such as business process, cost element subtemplate, or calculation row 

Name of the item 

Object, such as the name of the process, cost element, subtemplate, or calculation row 

Quantity (actual/plan), such as the process quantity or statistical key figure quantity 

Activation ( actual/plan ) 

Allocation event (template for cost objects) 
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Activities 

To maintain a template, you must edit the initial and overview screens, from which you can access 

various editors. 

Initial screen 

Enter the name of the template that you want to create or edit. 

Enter the environment of the template. 

Choose Enter. 

Overview screen 

If the template is new, enter a name for it. 

Select the row type. 

Enter a name for the row. 

Edit the other columns. Use the mouse or the tab key to reach the individual columns. Double-clicking on 

particular column types (such as object, quantity, activation, or allocation event) brings you to the 

editor or function selection. 

Once you have entered or edited all rows, choose Template -> Save. 

Further notes 

Detailed information is available in the Application Help for the transaction, or in the SAP Library under 

Financials -> Controlling -> Activity-Based Costing -> Template -> Maintaining Templates. 

 Maintain Template Determination and Other Update 

Characteristics 

Maintaining template definition 

If the user wants to run a template allocation, he/she specifies via the selection characteristics the 

particular characteristic area for which the allocation should be carried out. If that particular area 

contains characteristics that are linked to a template via a determination strategy, then the relevant 

template is automatically used for the calculation. You define the determination strategy as follows: 

Choose "Strategy -> Display/Change" 

Choose "Edit -> Create step" 

Assign a description to the determination rule. 

Use the possible entries pushbutton to choose source fields from the selection characteristics previously 

specified. A placeholder is automatically entered as target field for a template. Note: During rule 

entry, a column is provided for all the fields entered at this stage. You can then enter concrete 

values into this column. 

Save your entries and choose "Maintain rule values". Use the possible entries pushbutton to insert 

Use the possible entries pushbutton to insert in the columns produced by source field entries the 

characteristic values to be used in the selection of the template. 

Use the possible entries pushbutton to insert a template in the template column. 



 

 

Note: If you have already defined further allocation characteristics in this transaction ( see below), 

change the existing determination rule by inserting a concrete template for the rule values. 

Maintaining further allocation characteristics 

Further allocation characteristics are those which only form a dimension of an operating concern under 

certain circumstances (that is, when one or more allocation characteristics accept certain values). 

These are maintained after you have selected the fixed allocation characteristics. 

You need to take the following steps: 

Choose "Strategy -> Display/Change" 

Choose "Edit -> Create step" 

Assign a description to the determination rule. 

Carry out the following steps in the register "Definition": 

Use the possible entries pushbutton to choose source fields from the selection characteristics 

previously specified. 

Use the possible entries pushbutton to choose up to five target fields ('NAME1' to 

'NAME5') as additional allocation characteristics. 

Save your entries and choose "Maintain rule values". 

You arrive at the screen "Change rule values" in which an entry column is displayed for each field 

that you have created. 

Use the possible entries pushbutton to insert in the columns produced by source field entries the 

characteristic values to be used in the selection of the additional template. 

Use the possible entries pushbutton to insert the additional allocation characteristic in the columns 

produced by target field entries. All characteristics for the operating concern that are not yet fixed 

allocation characteristics are available. 

Save your entries. 

Example 

You have chosen the characteristic value "Major customer" for the fixed allocation characteristic 

"Customer group" and you have chosen the additional allocation characteristic "Customer" for this 

condition. If during the template allocation data records with the characteristic value "Major customer" 

are contained in the selected characteristic area, then the characteristic "Customer" (and all 

characteristics derived from it) is involved in determining the operating concern. 

 Maintain PA Transfer Structure for Template and Activity 

Allocation 

In this activity, you maintain PA transfer structures that are used for the following allocations of actual 

and plan data: 

Internal activity allocation 

Template allocation for cost center costs and process costs 
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Revaluation due to price ( re)determination 

Reposting 

You use the PA transfer structure to determine which allocation cost elements are transferred to which 

CO-PA value fields. 

You can also transfer the allocated activity quantity to CO-PA. To do this, include in the assignment the 

corresponding quantity field along with the value field(s). 

Note: 

Since this maintenance dialog is also used in the definition of PA transfer structures for other allocations, 

there are several selection options that do not apply to the PA transfer structures used here. These options 

are discussed below under Activities. 

Activities 

Maintain the appropriate PA transfer structure. 

Decide how you want to divide your allocation cost elements and create corresponding assignment lines. 

This division is then used to transfer the cost elements to the CO-PA value fields. 

Note: The indicator for quantity billed/delivered is not relevant here and should therefore not be 

activated. 

For each assignment line, enter the allocation cost element(s) or the allocation cost element group to be 

assigned. As the source, activate the "Costs/Revenues" option. Note that only costs are allocated 

during activity allocation and template allocation, and that revenues are not. 

For each assignment line, enter the value field (or, if the costs are split into fixed and variable portions, 

both value fields) into which the entered costs are to be imported. 

Assign the PA transfer structure to the corresponding business transaction. Maintain these settings 

separately for actual business transactions and plan business transactions . 

Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. ("CO" or "FI"). 

 Maintain Cost Component Split Assignments for Activity Allocation 

In this activity, you define the assignment of cost elements to value fields. 

Requirements 

This assignment is only relevant if the transfer of the cost component split to Profitability Analysis is 

active. 

Activities 

Assign a value field or, if splitting into fixed and variable portions, both value fields to each of the cost 

components of the cost component structure used in Cost Center Accounting or Activity-Based Costing. 

You find the corresponding cost component structure in the detailed information on the part of the CO 

version dependent on the fiscal year. 

Further notes 



 

 

For more information on the cost component structure as well as on price calculation with cost 

components, see the documentation in the SAP Library in the area Financials -> Controlling -> Cost 

Center Accounting -> Period-End Closing -> Actual Price Calculations -> Price Calculation with Cost 

Component Split. 

 Transfer Order/Project Planning 

In this section you set up settlement of actual and plan data for orders and projects to Profitability 

Analysis. 

You can settle actual data from internal orders, sales orders, and projects and plan data from plan-

integrated internal orders and projects. 

To settle data to CO-PA, you need to define a so-called "settlement profile" and assign this to the master 

data of the objects you want to settle. 

This settlement profile contains an allocation structure, which defines how the corresponding order or 

project is credit. It also contains a PA transfer structure, which determines how the values are settled to 

value fields in Profitability Analysis. 

In the PA transfer structure, you first assign the original cost elements on the order or the project to lines 

(assignments), which you then assign to value fields in Profitability Analysis. 

Example 

PA transfer structure:  VA ( value field assignment ) 

Assignment    Origin(al cost element)    Value field 

             OAS material               VV0     material costs 

  20           OAS wage                   VV200     labor costs 

Prerequisites 

The operating concern must be completely defined. 

A number range must be defined for the credit postings for the orders (business transaction KOAO). 

 ==> Check number ranges for transactions 

The number ranges for record type "C" must be defined. 

 ==> Check number ranges in CO-PA 

The desired form(s) of Profitability Analysis must be active. 

 ==> Check form of Profitability Analysis 

In the general definition of the CO version, you need to assign a receiver version ( for CO-PA) to the 

version under "Fiscaly year settings -> Detail". 

 Define PA Transfer Structure for Settlement 

In this activity, you define the PA transfer structures to be used to settle actual and planning data for 

orders and projects. 

Although it is technically possible, via a joint maintenance dialog, to use the same PA transfer structures 

from different allocation types in settlement, you should instead define separate PA transfer structures. 

Actions 
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Select the function "New entries" and enter an abbreviation and a name for your PA transfer structure. 

Divide your cost elements according to how you want to group them in Profitability Analysis, and create 

assignment lines accordingly. These assignment lines are then used to transfer the cost elements to 

CO-PA value fields. 

The indicator for quantity billed/delivered is relevant for settling sales orders and projects. Select 

this indicator for the particular assignment line with which the billed quantity is to be transferred to 

CO-PA. Under "Value fields", you need to assign a CO-PA quantity field (quantity/value indicator 

"2") to such an assignment line for the billed quantity. During settlement to CO-PA, the billed 

amount is transferred to the assigned field. 

For each assignment line, enter into the order/project the cost element(s) or the cost element group to be 

assigned. You should usually activate the "Costs/Revenues" option as the source. The "Variances 

on production orders" option is only relevant for the settlement of production orders. In the latter 

case, you should define a separate operating concern (see the section "Define PA Tranfer Structure 

for Variance Settlement"). The "Accounting indicator from SM orders" option is only relevant for 

the settlement of service orders. 

For each assignment line, enter the value field (or, if costs are split into fixed and variable portions, both 

value fields) into which the entered costs are to be imported. 

 Assign PA Transfer Structure to Settlement Profile 

The settlement profile contains all the relevant information needed for settling CO orders, sales orders, 

projects, and production orders. 

From the point of view of Profitability Analysis (CO-PA), you need to assign your PA transfer structure 

to a settlement profile. 

Note: 

The settlement profile must allow profitability segments as settlement receivers. If you want to settle 

production variances, this must be stored in the settlement profile. 

Requirements 

Since the settlement profile is usually entered automatically in the master data of the object being settled 

(internal order, sales order, or project), you need to specify the desired settlement profile as a default. 

For internal orders, you can do this when you maintain order types. 

For sales orders, you do this when you maintain requirement classes. 

For projects, you do this when you maintain project profiles. 

 Define LIS Interface 

In this step, you define the interface for transferring data between info structures in LIS and operating 

concerns in Profitability Analysis ( CO-PA ). 

This interface lets you transfer the following data: 



 

 

Plan data 

Statistical key figures 

SOP info structures 

Note: The LIS interface only allows you to transfer data from the SOP into CO-PA. You set up a 

transfer of data from CO-PA to SOP in the section Transfer of Sales Quantities to SOP. 

Activities 

In the characteristic assignment, you assign the characteristics in the info structure to characteristics in 

the operating concern. 

In the key figure assignment, you assign the key figures in the info structure to the value fields and 

quantity fields in the operating concern. Here you can only assign quantity fields to quantity fields and 

value fields to value fields. 

Under assignment groups, you essentially enter the desired operating concern and the corresponding 

info structure, plus the assignments of characteristics and value fields. 

Further notes 

When you tranfer data from SOP, you do not need to make a characteristic assignment because this is 

already defined in the system. The assignment is defined as follows: 

CO-PA   ->   LIS 

WERKS  ->   WENUX 

ARTNR  ->   PMNUX 

WWxxx  ->   PMNUX 

The field WWxxx stands for a user-defined characteristic that corresponds to the product group in SOP. 

When you transfer data from SOP to CO-PA, the system determines whether the characteristic value in 

the field PMNUX is a product or a product group. If it is a product group, the system uses the 

corresponding field in CO-PA based on the master data for that product group. 

For info structures that are copied from the SOP info structure S076, you can only transfer data at the 

product or product group level and at the plant level. The system summarizes the data over any other 

characteristics. 

 Planning Aids 

In this activity, you can define "planning aids", supplementary functions that you can use to support your 

planning process. 

You can include a planning aid as a parameter in the corresponding planning method that you are 

executing in the planning framework. 

Furthermore, you can enter a planning aid as a parameter in the corresponding planning function that you 

are executing for the manual entry of planning data. 
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 Distribution Key for Periodic Distribution 

In Profitability Analysis, planning data is saved on a weekly or periodic basis. If you enter an annual 

value, then it is always distributed internally to the weeks or periods. By default, it is distributed in 

proportion to the existing values. If no previous values exist, then the system distributes the values 

evenly. The system uses the fiscal year variant for the operating concern to determine the number of 

periods that there are in a year. 

You can use one of two types of distribution key to change the default setting: 

Standard distribution keys 

These are distribution keys that apply equally to all the planning data for which you want to use 

them. 

Segment-specific distribution keys 

These are distribution keys that are valid only for specific characteristics and value fields. For 

example, depending on the characteristic "country", you can distribute the planned annual values 

for the product "Suntan lotion" to the individual periods on the basis of different distribution keys. 

You specify in an access key the control information for the segment-specific distribution keys. 

You can use either the distribution key that you defined or the access key at different places in planning: 

You can include the distribution key in the parameter set for the planning method Period distribution. 

When you execute the method, the data is distributed according to the entries you made in the 

parameter set. 

You can include either the distribution key or the access key in the parameter group for the planning 

method Enter planning data. The key is used when you add new objects (such as rows in the 

planning layout) manually. The distribution of profitability segments that have been planned 

previously is not affected. 

During manual planning, you can also use the menu to execute the planning method Period distribution 

for selected profitability segments and then you can enter a distribution key or access key. 

In the definition of a planning layout, you can define the distribution key as an attribute for a profitability 

segment and value field. 

 Maintain Distribution Keys 

In this activity, you define distribution keys for use in planning. Distribution keys let you distribute plan 

values entered at the year level to individual periods or weeks using certain distribution strategies. 

In a distribute key, you assign a relative factor to each period/week to which you want the plan values to 

be distributed. Enter "0" or nothing for periods that you do not want to plan any values for. 

The number of periods per fiscal year is determined based on the fiscal year variant of the operating 

concern. If you have activated planning in weeks, you must specify whether you want to use the 

distribution key to distribute to weeks or to posting periods. (The fiscal year variant and weekly planning 

are defined in the operating concern attributes.) If you want to use the distribution key for more than one 

year, select the "Cyclical" field. 



 

 

 Maintain Segment-Specific Distribution Keys 

In this activity, you can define segment-specific distribution keys, or keys that apply for specific 

characteristic values in planning. With these you can distribute values differently to periods depending 

on the country, for example. 

With a so-called "access key", you define which distribution keys should apply for which characteristic 

values in planning. Thus an access key combines all the information pertaining to segment-specific 

distribution to periods. 

You do not need to make all entries for all profitability segments to carry out segment-specific 

distribution in planning. Instead, all you have to do is specify the access key, and the system carries out 

all the corresponding distributions. 

Activities 

To define a segment-specific revaluation key: 

Create an access key. 

Define a derivation rule for segment-specific distribution. Note that the "access key" is a mandatory 

source field and is thus automatically entered in the derivation rule. Select the additional 

characteristics that you want to use to determine the distribution key. If you want to distribute 

different value fields differently as well, select the "FIELDNAME" field here. 

The "distribution key" is a mandatory target field and is thus automatically entered in the derivation 

rule. 

Create rule values for the derivation rule. These are the combinations of characteristic values and the 

resulting distribution keys. If you have not yet created any distribution keys, you can do so here by 

double-clicking on the "Distribution key" field. 

You can also define rule values directly from the application menu. 

Alternatively to using the default distribution keys stored in the parameter set, you can define an access 

key as the default to be used in distribution. 

 Revaluation Key 

In this activity, you can define revaluation keys to change specified value fields by certain percentages. 

There are two types of revaluation key: 

Standard revaluation keys 

These revaluation keys can be applied to all planning data. 

Segment-specific revaluation keys 

These revaluation keys are valid only for specific characteristics and value fields. For example, you 

can plan a different increase in sales using different revaluation factors, depending on which 

division you are planning. In a callup, you specify the information governing the segment-specific 

revaluation keys. 

You can apply revaluation keys to your planning data when entering planning data manually as well as in 

the planning method revaluation. 
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 Maintain Revaluation Keys 

In this section you define revaluation keys, which you can use to change values in planning by specified 

percentages. 

Activities 

Define your revaluation factors. 

Then defined the desired percentage increases and reductions for each value field. 

To define a reduction, enter the percentage with a "-" sign. 

 Maintain Segment-Specific Revaluation Keys 

In this activity, you can define segment-specific revaluation keys, or keys that apply for specific 

characteristic values in planning. With these you can define different revaluation factors for different 

divisions, for example. 

With a so-called "access key", you define which revaluation factors should apply for which characteristic 

values in planning. Thus an access key combines all the information pertaining to segment-specific 

revaluation. 

You do not need to make all entries for all profitability segments to carry out a segment-specific 

revaluation in planning. Instead, all you have to do is specify the access key, and the system carries out 

all the corresponding revaluations. 

Activities 

To define a segment-specific revaluation key: 

Create an access key. 

Define a derivation rule for segment-specific revaluation. Note that the "access key" is a mandatory 

source field and is thus automatically entered in the derivation rule. Select the additional 

characteristics that you want to use to determine the revaluation key. The "revaluation key" is a 

mandatory target field and is thus automatically entered in the derivation rule. 

Create rule values for the derivation rule. These are the combinations of characteristic values and the 

resulting revaluation keys. If you have not yet created any revaluation keys, you can do so here by 

double-clicking on the "Revaluation key" field. 

You can also define rule values directly from the application menu. 

 Event 

An event is a short-term influence, such as a sales deal, on the value and quantity fields of your operating 

concern. You can take the effects of such events into account in planning. 

From a technical point of view, an event is a time-based revaluation key with which you can perform 

percentage as well as cumulative revaluation. 

There are two types of event that you can define: 



 

 

Standard events 

These events can be applied non-specifically to all planning data. 

Segment-specific events 

These events are dependent on a specific characteristic and you can define several of them in a 

single planning session. An example of a segment-specific event could be a sales promotion for 

summer clothing planned for the month of May. This event is expected to influence different 

regions in different ways, whereby a greater increase in sales is anticipated in southern Europe than 

in northern Europe. You specify in an access key the necessary control information for the 

segment-specific events. 

Events can be used with the manual entry of planning data as well as applied to your planning data in the 

planning method event. 

 Maintain Events 

In this activity, you define events - revaluation keys that apply to limited time frames - to reflect the 

effects of short-term events on your plan data. An example of an event might be a sales promotion that 

takes place in a certain month. You can take the effects of such an event into account in planning. 

Activities 

First, define an event and determine the time frame in which you want it to be valid. Here you also 

specify whether the event should revaluate by absolute amounts or by percentages. 

Then decide which value fields the event should have an impact on. 

For each value field and for each period within the relevant time frame, define the revaluation factors that 

you want to plan. 

 Maintain Segment-Specific Events 

In this activity, you can define segment-specific events, or events that apply for specific characteristic 

values in planning. An event is a short-term influence on your profitability data, such as an advertising 

campaign for summer fashions planned for the month of May. Segment-specific events let you define 

different revaluation factors for different regions (supposing, for example, that the increase in sales that 

results from the asvertising campaign will be larger in southern countries than in northern countries). 

With a so-called "access key", you define which revaluation factors should apply for which characteristic 

values in planning. Thus an access key combines all the information pertaining to segment-specific 

revaluation. 

You do not need to make all entries for all profitability segments to use a segment-specific event in 

planning. Instead, all you have to do is specify the access key, and the system carries out all the 

corresponding revaluations. 

Activities 

To define a segment-specific event: 
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Create an access key. 

Define a derivation rule for segment-specific events. Note that the "access key" is a mandatory source 

field and is thus automatically entered in the derivation rule. Select the additional characteristics 

that you want to use to determine the event. The "event" field is a mandatory target field and is thus 

automatically entered in the derivation rule. 

Create rule values for the derivation rule. These are the combinations of characteristic values and the 

resulting revaluation keys. If you have not yet created any revaluation keys, you can do so here by 

double-clicking on the "Revaluation key" field. 

You can also define rule values directly from the application menu. 

 Forecast Profile 

A forecast profile groups together parameters (calculation factors) to represent a strategy that allows you 

to extrapolate existing plan values to forecast future ones. 

A forecast profile is based on a forecast strategy, which enables you to extrapolate planning data (for 

example, using a moving weighted average, as in the case of forecast profile 14). If you use forecast 

profile 14 and want to give extra weighting to certain values in your forecast, you can create weighting 

groups. 

There are two types of forecast profiles that you can define: 

Standard forecast profiles 

This type of forecast profile handles all planning data in the same way. 

Segment-specific forecast profiles 

You define several segment-specific forecast profiles for each planning session. In this way, you 

can forecast the sales of different products, for example, on the basis of different strategies. In an 

access key, you specify the control information for the segment-specific forecast profiles. 

You can apply standard forecast profiles with the manual entry of planning data and in the planning 

method Forecast. Segment-specific forecast profiles, on the other hand, cannot be used together with 

the manual entry of planning data. 

 Maintain Forecast Profiles 

In this step you define forecast profiles. 

A forecast profile consists of a forecast strategy and a group of parameters (calculation factors) which let 

you project existing values into the future. Since you can use the same forecast profile over and over 

again, you do not have to perform the tedious task of entering the same data again each time you plan. 

To define a forecast profiles, you need to enter a number of factors, depending on the pre-defined 

forecast strategy. 

Standard settings 

One standard forecast profile is delivered with the system. You can create additional forecast profiles as 

needed. 

Actions 



 

 

Enter a name and a description for your forecast profile. 

Specify the desired forecast strategy for this profile. 

Press ENTER to see what forecast parameters make sense to use with the forecast strategy. Enter these 

parameters. 

Save your entries. 

Additional information 

For more detailed information on the different forecasting methods, see the online documentation "Sales 

and Operations Planning" in the section "Planning Table: The Forecast". 

 Maintain Segment-Specific Forecast Profiles 

In this activity, you can define segment-specific forecast profiles, or profiles that apply for specific 

characteristic values in planning. With these you can define different forecast profiles for different 

products, for example. 

With a so-called "access key", you define which forecast profile should apply for which characteristic 

values in planning. Thus an access key combines all the information pertaining to segment-specific 

forecasting. 

You can only use segment-specific forecast profiles in automatic planning. You do not need to make all 

entries for all profitability segments to carry out a segment-specific forecast. Instead, all you have to do 

is specify the access key, and the system carries out all the corresponding forecasts. 

Activities 

To define a segment-specific forecast profile: 

Create an access key. 

Define a derivation rule for segment-specific forecasting. Note that the "access key" is a mandatory 

source field and is thus automatically entered in the derivation rule. Select the additional 

characteristics that you want to use to determine the forecast profile. The "forecast profile" is a 

mandatory target field and is thus automatically entered in the derivation rule. 

Create rule values for the derivation rule. These are the combinations of characteristic values and the 

resulting forecast profiles. If you have not yet created any forecast profiles, 

you can do so here by double-clicking on the "Forecast profile" field. 

You can also define rule values directly from the application menu. 

 Define Weighting Groups 

In this activity, you define weighting groups for use in your plan forecasts. 

Using a weighting group only makes sense if you are using forecast strategy 14 ( weighted moving 

average) in a forecast profile. This lets you individually weight the past periods you use for forecasting to 

calculate the forecasted values. 

The numbers in the weighting group have the following meanings: 
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- current period minus one (last period) 

- current period minus two (second-last period) 

- current period minus three (period before the second-last period) 

 Define Ratios and Ratio Schemes 

In this step you define ratios for use in planning. A ratio is the quotient between two value fields, such 

as price = sales/quantity or commission rate = commission/sales. (Note that ratios cannot be defined 

with a quantity field for a numerator and a value field for a denominator, such as "quantity field / value 

field".) Ratios can be used in two ways: 

To simulate price and quantity changes (in manual planning) 

In planning, you can change quantities, values or ratios directly in the planning layout. You can select 

ratios when you define the planning layout, just like you would value fields. 

If you change a quantity, value or ratio, special rules determine which of the other two is recalculated. 

You define these calculation rules via calculation types which you maintain when defining the ratio. 

The ratio scheme is not involved in this function. 

To valuate a quantity plan with prices stored calculated in another plan version or in actual data (in 

manual and in automatic planning) 

Using a ratio scheme, you can define which ratios should be used in which order for valuation (similar 

to using the calculation scheme for conditions). 

You must assign at least one access-level characteristic to each ratio in a ratio group. 

Access-level characteristics determine, for each ratio, which combination of characteristics the system 

should use to access the valuation. This makes it possible, for example, to calculate the average price for 

a product group. The calculation types for the ratios are not involved in this function. 

 Calculated Values as Reference for Top-Down Distribution 

In this activity, you define a key figure (a formula based on value fields) for use as the reference values 

for distributing planning data or actual data using top-down distribution. 

Example 

You defined a key figure "Net revenue = Revenue - Discounts" and enter this as the reference value in 

top-down distribution. The system distributes the data in proportion to the net revenue according to the 

reference data of the profitability segments at the lowest level. 

Activities 

Define the desired key figures 

If you want to use the key figure as the tracing factor in automatic top-down planning, select the key 

figure in the parameter set under Reference value field. 

If you want to use the key figure for top-down manual planning, you need to assign it to the value fields 

you want to use it for. You do this in Customizing. 



 

 

If you want to use the key figure as a tracing factor for actual top-down planning, select the option "Fixed 

value field" under "Tracing factor" when you execute it and enter the key figure in the field "Value 

field". 

 Create Exit Number for Customer Enhancement 

In this step, you can define user exit numbers that identify specific planning functions in the components 

of customer enhancement COPA0006. This customer enhancement lets you create your own planning 

functions. 

The exit numbers are added to the interfaces of the components and let you distinguish between different 

planning functions. 

This enhancement can be used both for automatic planning and for manual planning. 

You define the customer enhancement itself in the step SAP enhancements. 

Example 

You can realize, among others, the following planning functions: 

Distribution of annual values to periods using a distribution key that is dependent on a specific 

characteristic 

Revaluation using characteristic- and/or time-dependent factors 

Valuation using percentage or additive events 

Distribution to periods on the basis of reference data 

"Roll-forward planning" -- ongoing update of period planning by distributing plan/actual variances to 

future periods so that the annual values remain the same 

 Reorganization 

In this section you can delete planning layouts and long texts. 

 Reorganize Planning Layouts 

Here you can select a number of planning layouts and then delete them individually from an overview 

list. 

Before you actually delete the layouts, the system displays another dialog box, in which you repeat your 

selection. 

Example 

You can delete all the planning layouts which were changed on a certain date. 

Actions 
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Reorganize your planning layouts by deleting unnecessary ones before you go productive with your 

system. 

 Reorganize Long Texts 

In this step you can delete selected long texts for plan data. 

Example 

You can delete the long texts which were created within a certain time range. 

 Flows of Actual Values 

In this section you make the basic settings required for posting data from the SD, FI, and CO application 

components to Profitability Analysis. 

Which functions you need to carry out will depend on your information requirements and on the 

applications you are using in your company. 

 Initial Steps 

In this step, you make preparatory settings required for transferring actual data to Profitability Analysis. 

 Define Number Ranges for Actual Postings 

In this step, you define a number range to be used for actual line items. 

You can specify whether the numbers in the range should be assigned internally or externally. If you 

choose "internal", the SAP system assigns numbers automatically. 

Number ranges are valid for a specific operating concern. You can assign one or more record types to 

each number range. 

Prerequisites 

You must have system authorization for number range maintenance. 

Your operating concern must be defined completely. 

The record types must be maintained. 

Actions 

Decide which record types you want to use in this operating concern. 

If necessary, define new number range groups to meet your requirements ( function "Maintain group", 

then function "Insert group"). 



 

 

Enter document number ranges in the number range groups. When doing so, do not forget to take 

existing document number ranges into account. 

Note that automatic (internal) number assignment is mandatory for data which is transferred to CO-

PA from other SAP application components (such as direct postings from FI, cost assessment from 

CO-CCA, or order/project settlement from CO-OPA and PS). 

Assign the record types to the number range groups. 

Notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

 Summarization 

 Summarization of Account-Based Line Items and Profitability Segments 

Caution 

This function is intended only for exceptionally large data volumes that are causing critical performance 

and data storage issues. It should only be used when absolutely necessary, since it restricts the flexibility 

of reporting. 

If you decide to use this function, keep in mind that its effects cannot normally be reversed. The effects 

can be undesirable if the function is used incorrectly. 

Use 

To avoid performance and data storage issues with large data volumes, you may need to reduce the 

number of line items and the number of profitability segments by defining a summarization for these 

elements. 

In this section you can define a summarization of fields for G/L line item table ACDOCA containing the 

universal journal entry (General Ledger View). If an operating concern is activated for account-based 

CO-PA the account-based line items are posted to this table. In order to achieve that all characteristics 

are generated into table ACDOCA. 

Since the level of summarization in table ACDOCA should be the same as that of the profitability 

segments, the summarization settings maintained here are used for account-based profitability segment 

determination. You find these settings under #Summarization of Account-Based Line Items and 

Profitability Segments#. 

Note: 

If you are using costing-based profitability analysis, the corresponding profitability segment 

determination utilizes these settings as well. In other words, summarization is the same regardless 

of whether you are using account-based or costing-based profitability analysis. Even if you define a 
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summarization of fields for table ACDOCA, costing-based line items continue to be posted to table 

CE1XXXX (where #XXXX# denotes your operating concern). This table uses the existing 

definition of line item summarization, which can be found under #Summarization of Costing-Based 

Line Items#. 

The settings maintained here also apply to Distributed CO-PA which means that the same level of 

summarization is used with regard to the profitability segments in the distributed scenario. 

If only costing-based profitability analysis (CO-PA) is activated in an operating concern, line items in 

table ACDOCA are posted to highly aggregated objects called reconciliation objects (ACDOCA-OBJNR 

#AO#.#). No characteristics are generated to table ACDOCA for this operating concern. If another 

operating concern existed for which account-based CO-PA was activated, characteristics could be 

generated into table ACDOCA that are also contained in the costing-based operating concern. 

Nevertheless, for the G/L line items in the costing-based operating concern (the ones posted to 

reconciliation objects), no characteristics are filled in table ACDOCA and hence no summarization is 

needed. An exception to this are certain fixed characteristics already predefined in table ACDOCA that 

are filled by a sending application even if only costing-based CO-PA is active, for example the fields 

Sales Organization (VKORG) or Distribution Channel (VTWEG) of an SD billing document. In order to 

summarize such fields, you can use the#Dependent Summarization of General Ledger View# activity. 

If profitability analysis is not active at all in a company code, the settings #Summarization of Account-

Based Line Items and Profitability Segments# are not used either. As for the costing-based-only case, use 

the     #Dependent Summarization of General Ledger View# activity in order to summarize above 

mentioned fixed fields like Sales Organization or Distribution Channel. 

The existing summarization on table BSEG containing the classic Journal Entry (Entry View) still exists. 

A field which exists in table BSEG and ACDOCA can only be summarized in table ACDOCA if it is 

summarized in table BSEG as well. A warning message is usually issued if this is not the case. 

Summarization of table BSEG can be found under #Dependent Summarization of Entry View# and    

#Independent Summarization of Entry View#. 

Summarization of G/L line item table ACDOCA and profitability segments can be dependent or 

independent: 

- Dependent summarization: 

A field can be summarized based on a combination of the reference transaction ( AWTYP), document 

type (BLART), company code (BUKRS), and ledger (RLDNR). This allows you to summarize a field 

only in a particular document type and ledger, for example. This option is available for fields of table 

ACDOCA which may not be part of a CO-PA operating concern and for CO-PA characteristics if CO-

PA is not active in a company code (see above). This option can be found under#Dependent 

Summarization of General Ledger View#. 

- Independent summarization: 

A field can be used for summarization only based on the Operating Concern (ERKRS) and the Company 

Code (BUKRS). This option is used for all fields which are part of an operating concern, since 

profitability analysis does not recognize most of above-mentioned dimensions at the time the profitability 

segment is determined. Fields offered for independent summarization are customer-defined CO-PA 

characteristics and some fixed characteristics such as Sales Organization (VKORG), Distribution 

Channel (VTWEG), and Division (SPART), which are contained in every operating concern. 

Independent summarization therefore depends on the operating concern. This is the option you can find 

under"Summarization of Account-Based Line Items and Profitability Segments". 

If a field is maintained here, it is summarized in distributed CO-PA regardless of whether summarization 

is restricted to certain company codes or not. 



 

 

Note that ACDOCA has two different fields for the material number: 

MATNR is the material number for materials management, which is filled for example in material 

movements. It is not relevant for CO-PA. 

MATNR_COPA is the product number for CO-PA. It identifies the product sold. 

MATNR is therefore available for dependent summarization, whereas MATNR_COPA is only available 

for independent summarization (except for company codes where CO-PA is not active, as described 

above). 

Recommendation 

To avoid performance problems, we recommend excluding frequently occurring fields that have a 

different value with each posting and which are therefore not relevant for analysis. This applies for 

example to the sales order number for a repetitive manufacturer, or the customer and material for a 

retailer.  For retailers, you can analyze at the customer group or product group level by excluding 

customers or products from the analysis. This can improve performance considerably. 

We further recommend using document summarization of table BSEG and reducing the number of G/L 

line items in table ACDOCA as little as possible. 

Note that the fields you define for summarization of G/L line item table ACDOCA and profitability 

segments will not be summarized in the following cases: 

With dependent summarization, the material number (MATNR) is not summarized in table ACDOCA if 

the material ledger is used in the system. 

With independent summarization, the customer number (KUNNR) is not summarized in table ACDOCA 

on debtor items or if the customer is an affiliated party. 

With independent summarization, real account assignments are never summarized in table ACDOCA. 

For example, if you choose to summarize cost centers, this would not be initialized in G/L line 

items with real account assignment to cost center. For profitability segments containing the cost 

center characteristic, summarization takes place for both the G/L line item and the profitability 

segment, since in this case the cost center can at most be a statistical account assignment whereas 

the profitability segment is always a real account assignment. 

Note 

This function is a purely technical function which is intended to allow customers with large data volumes 

to optimize their system performance by reducing the number of G/L line items in table ACDOCA 

and the number of profitability segments in table CE4XXXX (where #XXXX# denotes your 

operating concern). It should be used with caution because it is usually not possible to reverse its 

effects. The effects can be undesirable if the function is used incorrectly. 

If profitability analysis is active, changes to summarization settings will result in the creation of 

additional profitability segments if new postings are made to profitability segments that had been 
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posted to before the changes were made. This is especially the case when a characteristic that had 

been summarized before is removed. Also note that changes to summarization settings may result in 

error message KE 396 #Inconsistency between a document field and the profitability segment 

number# during postings. 

 Summarization of Account-Based Line Items and Profitability 

Segments 

Use 

In this step, you specify fields of G/L line item table ACDOCA containing the Unified Journal Entry 

(G/L View) that are characteristics of an operating concern for independent summarization. This means 

that summarization does not depend on any other dimensions, except for the Operating Concern 

(ERKRS) and the Company Code ( BUKRS ). 

When you start the maintenance transaction you are asked to enter an operating concern.  If you just 

maintain a characteristic, the system attempts to summarize for all G/L line items assigned to the 

respective operating concern. You can also choose to summarize only in certain company codes by 

maintaining the company codes in which you want the field to be summarized under #Summarization 

Only In#. 

During posting of a G/L line item, the system checks whether the corresponding company code has an 

operating concern with activated account-based CO-PA assigned and, if so, reads the settings for this 

company code and operating concern. In the line item it initializes the fields maintained here and the 

ones entered under#Dependent summarization of General Ledger View#. Having done that for all line 

items, the system attempts to summarize the resulting data. 

The settings are also used for profitability segment determination in this operating concern if CO-PA is 

active (costing-based and account-based). When a profitability segment is created, the characteristics 

entered for summarization are initialized and it is checked against table CE4XXXX (where #XXXX# 

denotes the operating concern) to determine whether a profitability segment already exists for the 

resulting combination of characteristics. If one exists, the corresponding profitability segment number is 

reused, otherwise a new one is determined. 

Fields maintained here are also summarized in distributed CO-PA, regardless of whether summarization 

is restricted to certain company codes or not. 

If, on the other hand, you have company codes where no or only costing-based CO-PA is active, 

maintain the   #Dependent Summarization of General Ledger View#. The system will take these settings 

into account when summarizing G/L line items for company codes without operating concern assigned, 

where CO-PA is inactive or where only costing-based CO-PA is activated. 

Requirements 

Table ACDOCA can at maximum be summarized to the level of table BSEG containing the classic 

Journal Entry (Entry View). That is, if you want to summarize a field contained in table ACDOCA that is 

also contained in table BSEG, you must also maintain the summarization of table BSEG under 

#Dependent Summarization of Entry View# or#Independent Summarization of Entry View#. A warning 

message is issued in most cases, if this requirement is not met. 



 

 

Activities 

Configure those fields that you want to use for summarization. 

You can also 

Further fields are available for summarization in activity#Dependent Summarization of General Ledger 

View#. 

Maintain summarization of costing-based line items here. 

 Summarization of Costing-Based Line Items 

Use 

In this section you can define how several line items of a sender document should be summarized when 

they are updated in costing-based profitability analysis ( CO-PA ). 

By summarizing document items posted to the same profitability segment, you can reduce the data 

volume in the costing-based line item table CE1XXXX (where #XXXX# denotes the respective 

operating concern) significantly. You can also improve runtimes for the update to CO-PA using 

summarization. 

Summarization is defined based on: 

The reference transaction (SD00 = billing document, RFBU = FI document, RMRP = incoming invoice, 

RMWA = goods movement, RMWE = goods receipt order) 

The document type (internal, external), and 

The point at which summarization takes place (1 = after derivation/valuation, 

2 = before derivation/valuation) 

Summarization of journal entries (reference transaction RFBU) is only possible for internal documents 

and only after derivation and valuation. 

The system summarizes data that was posted to the same profitability segment (the same combination of 

characteristics). For journal entries, the account or cost element is also used as a criterion. 

You can only summarize data within the same sender document. Only the document number of the 

sender document is stored as information on the origin. Consequently, you can no longer see the 

corresponding item in costing-based CO-PA. 

Activities 

Configure those fields that you want to use for summarization. 

You can also 

Maintain summarization of account-based line items and profitability segments here. 

Example 

1. Billing document with summarization '1': 
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In CO-PA, imputed sales commission is calculated on the basis of a quantity scale: 

2% of revenue if quantity <=  units 

3% of revenue if quantity >  units 

Item Material Amount Revenue Discount Prof. Segment 

 M1  00  4711 

20 M2 5 5000 60 4819 

30 M1 3 300 3 4711 

Line item updated in table CE1XXXX: 

Item Material Quantity Revenue Discount Imputed commission 

1 M1 13 1300 13 26 2 

M2 5 5000 60 0 

2. FI document with summarization '1': 

Item Deb/Crd Account Name Amount Prof. Segment 

D K0 Cust00 35 

D 889000 Sales ded. 0 47880 

C 800000 Sales rev. 00 47880 

C 175000 VAT 135 

D K200 Cust00 35 

D 889000 Sales ded. 0 47880 

C 800000 Sales rev. 00 47880 

C 175000 VAT 135 

D K300 Cust00 2070 

D 889000 Sales ded. 200 5019 

C 800000 Sales rev. 2000 5019 

C 175000 VAT 270 

Line item updated in table CE1XXXX: 

Item Account Revenue Sales Ded. Prof. Segment 

800000 2000   0 47880 



 

 

889000    0 200 47880 3 

800000 2000   0 5019 4 

889000    0 200 5019 

 Characteristic Groups 

You can use characteristic groups to determine what characteristics appear in which order on the screens 

for assigning profitability segments in different business transactions. 

 Maintain Characteristic Groups 

In this step you can define "characteristic groups", which can be any combination of characteristics in 

your operating concern. 

Characteristic groups can be used for various actual business transactions as well as for various 

allocations of planning data. 

A characteristic group determines the characteristics for which users can specify individual values when 

assigning a posting to a profitability segment, as well as the order in which these characteristics appear 

on the screen. 

You can also define whether the user is required or is allowed to specify values for certain 

characteristics, or whether the user cannot make an entry. 

If no characteristic groups are defined, the user can enter values for any characteristic in the operating 

concern. 

Recommendation 

If you want certain characteristic values in a group to be derived automatically, you should define those 

fields so that the user cannot make an entry. 

Actions 

Define your characteristic groups. 

 Assign Characteristic Groups for Assignment Screen 

In this step, you structure the "Assignments to Profitability Segments" dialog box ( the assignment 

screen) for business transactions, such as: 

Direct postings from Financial Accounting 

Maintenance of settlement rules for CO orders or projects 

Internal cost allocations 

To organize the layout of the assignment screen, you assign a characteristic group to each business 

transaction. 
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Furthermore, you can construct entry aids for the business transactions. In the entry aids, you can save 

combinations of characteristic values that are frequently required during assignment. These entry aids 

can then be made available to users making assignments to profitability segments. For more information, 

see the documentation for Profitability Analysis. 

Prerequisite 

You need to have created a characteristic group. 

Activities 

Assign the Characteristic groups to the desired business transactions and create any relevant entry aids. 

You can also create entry aids for a business transaction without assigning a characteristic group. 

If you delete a characteristic group assignment, any associated entry aids will also be deleted. Note 

If a transaction does not have a characteristic group assigned to it, users can enter values for all of the 

characteristics in the operating concern. 

If this assignment of characteristic groups to business transactions is too restrictive, you can use the 

standard enhancement "COPA0003" to define a more flexible way of assigning characteristic groups 

within individual transactions. 

 Assign Characteristic Groups for Line Item Screens 

In this step, you organize the screen for entering or displaying characteristic values during line item 

entry/display. You do this by assigning a characteristics group to a record type. 

If, for example, you assign a characteristics group to record type "F", then only the characteristics in that 

characteristics group will appear as entry options when a user is entering a line item for this record type. 

If you have not assigned any characteristics groups to a record type, then users can enter/display all the 

characteristics for the operating concern. 

Requirements 

You need to have defined a characteristics group containing the characteristic "Company code" as a 

required field. The company code for a line item must be known at the point when derivation occurs as a 

user enters that line item. 

Activities 

Assign the characteristics group to the desired record type. 

 Value Field Groups 

You use value field groups to create the input and display screens for CO-PA line items. 



 

 

 Maintain Value Field Groups 

In this step, you define the "value field groups" representing the possible combinations of value fields in 

an operating concern. 

You use value field groups to specify 

Which value fields should be made available to users entering or displaying a line item, and 

In what order these value fields should be displayed. 

Furthermore, you can stipulate 

Whether specific value fields can be filled - Whether specific value fields have to be filled, or -

 Whether they may only be displayed. 

If you do not define any value field groups, then all value fields in an operating concern are unlocked for 

entry during line item entry. 

Activities 

Define your value field groups. 

 Assign Value Field Groups for Line Item Screens 

In this step, you organize the screen for entering or displaying value fields during line item entry/display. 

You do this by assigning a value field group to a record type. 

If, for example, you assign a value field group to record type "F", then only the value fields in that value 

field group will appear as entry options when a user is entering a line item for this record type. 

If you have not assigned any value field group to a record type, then users can enter/display all the value 

fields for the operating concern. 

Requirements 

You need to have defined a value field group. 

Activities 

Assign the value field group to the desired record type. 
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 Summarize Data During Update 

In this section you can define how several items of a sender document should be summarized when they 

are updated in Profitability Analysis. 

By summarizing document items posted to the same profitability segment, you can reduce the data 

volumne in the line item table in Profitability Analysis (CE1xxxx) significantly. 

You can also improve runtimes for the update to Profitability Analysis using summarization. 

Summarization is defined dependent on: 

the activity (SD00 = billing document, RFBU = FI document, RMRP = 

incoming invoice, RMWA = goods movement, RMWE = goods receipt order) 

the document type (internal, external) and 

the point at which summarization takes place 1 = after derivation/valuation 

                                              2 = before derivation/valuation 

Summarization of financial accounting document items (RFBU) is only possible for internal documents 

and only after derivation and valution. 

The system summarizes data that was posted to the same profitability segment (the same combination of 

characteristics). For financial accounting documents, the account or cost element is also used as a 

criterion. 

You can only summarize data within the same sender document. Only the document number of the 

sender document is stored as information on the origin. Consequently, you can no longer see the 

corresponding item in Profitability Analysis. 

Example 

Billing document with summarization '1': 

In Profitability Analysis, imputed sales commission is calculated on the basis of a quantity scale: 

2% of revenue if quantity <= units 

3% of revenue if quantity >  units 

Item  Material  Amount  Revenue Discount Prof. segment 

    M1              00           4711 

20    M2        5       5000    60       4819 

30    M1        3       300     3        4711 

Line item updated in CE1xxx: 

Item   Material  Quantity Revenue Discount Imputed commission 

M1        13       1300    13       26 2      M2        5        5000    60       0 

FI document with summarization '1':  

Item   Deb/Crd Account Name      Amount   Prof. segment 

D       K0    Cust00   35     

D       889000  Sales ded. 0      47880 

C       800000  Sales rev. 00     47880 



 

 

C       175000  VAT       135 

D       K200    Cust00   35 

D       889000  Sales ded. 0      47880 

C       800000  Sales rev. 00     47880 

C       175000  VAT       135 

D       K300    Cust00   2070 

D       889000  Sales ded. 200      5019 

C       800000  Sales rev. 2000     5019 

C       175000  VAT       270 

Line item updated in CE1xxx: 

Item      Account Revenue Sales ded. Prof. segment 

1         800000  2000      0        47880 

2         889000     0    200        47880 

3         800000  2000      0        5019 

4         889000     0    200        5019 

 Store Quantities in CO-PA Standard Unit of Measure 

This function allows you to store all the quantities mapped to a CO-PA quantity field additionally in a 

CO-PA standard quantity unit. 

Example 

You have mapped the billed quantity field in SD to the CO-PA quantity field "VVIQT", and also want to 

store all quantities billed in kilograms. 

First you need to create an additional field "VVISU" ("Qty billed in KG") in the data structures of your 

operating concern. Then you map CO-PA billed quantity field "VVIQT" to the SD billed quantity field 

"FKIMG" using the function "Assign quantity fields". Then you can map quantity field "VVISU" to 

quantity field "VVIQT" as follows: 

Source qty  Description   Standard qty  Description        Unit 

---------------------------------------------------------------------- 

- 

VVIQT       Qty billed    VVISU         Qty billed in KG   KG 

These settings mean that when actual data is transferred to CO-PA, the quantity transferred to quantity 

field "VVIQT" is translated to kilograms, and the quantity in kilograms is then posted in the field 

"VVISU". 

Requirements 

The required CO-PA quantity fields must be contained in the data structures of your operating concern. 

Activities 

To activate the CO-PA standard quantity field(s), map them to a CO-PA quantity field that is populated 

with data from another application. In addition, specify the quantity unit to be used for each standard 

quantity field. 

Further notes 
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You should choose your standard quantity unit so that all materials can be translated to that unit. You 

should also make sure that the quantity unit you choose is either the base quantity unit or the 

alternative quantity unit in the material master records. If a translation to the standard quantity unit is 

not possible, the system issues an error message when actual data is transferred to CO-PA. The 

documents with which this happens cannot be updated in CO-PA. 

 Transfer of Incoming Sales Orders 

To be able to analyzing expected operating results as early as possible, you can transfer 

incoming sales order to Profitability Analysis (CO-PA) the same way as the billing documents. 

The transfer of condition types from SD to value fields in Profitability Analysis and the transfer of the 

billing documents from SD must be completely consistent. 

Activate the transfer of incoming sales orders. Prerequisites 

The operating concern to which you want to transfer the sales orders must be completely defined and 

active in the assigned controlling area. 

You must have maintained number ranges for record type "A". 

Costing-based Profitability Analysis must be active. 

 Assign Value Fields 

In Sales and Distribution(SD), all sales revenues, sales deductions and other values (such as the transfer 

price) are stored as conditions. In this IMG activity, you assign these SD conditions to the corresponding 

value fields in CO-PA. 

Incoming sales orders are updated in CO-PA with record type "A". These sales orders are to be 

regarded as purely statistical. Consequently, all conditions that are assigned to a value field are 

transferred to CO-PA when incoming sales orders are posted. 

Note that this is different from the transfer of billing documents to CO-PA, where the conditions are 

subject to validity checks. Note in particular that, for FI-relevant conditions to be transferred, the 

corresponding FI account must be defined as a cost element in CO. 

Notes 

As a rule, conditions from SD are updated as positive values in CO-PA. The only exceptions to this are 

credit memos and returns. The reason for this handling is that signs are handled differently in the 

different SAP applications. For example, revenues are positive in SD but negative in FI (the FI view of 

business processes being taken from the cost view). Consequently, CO-PA defines all values as positive 

and subtracts costs and sales deductions from revenues in the information system. 

Note that the indicator Transfer with signs is not used to compare the different use of +/signs between FI 

or SD and CO-PA. If you activate this indicator, only the positive and negative values for the condition 

in question will be balanced. This guarantees that the sum of the negative and positive condition values is 

displayed as a correct total value in the value field assigned to that condition. 



 

 

Activities 

Assign the condition types you want to transfer from SD to the desired value fields in CO-PA. Where 

desired, set the "+/- signs" indicator for the condition value transfer. 

Note that, in this activity, you are maintaining the same table as in the IMG activities 

Transfer of Billing Documents -> Assign value fields and 

Transfer of Customer Rebate Agreements 

Therefore, when you delete an entry in one of these activities, it is also deleted in the other ones. 

 Assign Quantity Fields 

A number of quantity fields are defined and used in the SD billing system. In this step you assign these to 

the corresponding quantity fields in costing-based Profitability Analysis ( CO-PA ). 

Actions 

Assign all the quantity fields you want to transfer from the billing system to costing-based CO-PA. 

Additional Information 

You can transfer the billed quantity to costing-based CO-PA using the sales unit as well as the 

stockkeeping unit. The assignment you make here is valid for both profitability planning and for actual 

postings. 

This assignment is particularly important for planning, because the system can automatically derive the 

unit for the quantities you plan manually for individual products. 

 Activate Transfer of Incoming Sales Orders 

In this step, you activate the transfer of incoming sales orders from Sales and Distribution ( SD ) to 

Profitability Analysis ( CO-PA ). 

You can specify whether the transferred sales orders should be shown in CO-PA in 

The period in which they were created or 

The period of the planned delivery 

This information is stored in the schedule lines in the order. 

Further notes 

Sales orders transferred to CO-PA receive the record type "A". Sales orders from projects receive the 

record type "I" when transferred during project settlement. Both of these need to be displayed in 

separate columns from billing documents in the information system. 

Incoming sales orders are only updated in costing-based Profitability Analysis. Only documents that are 

likewise represented in Financial Accounting can be posted to account-based Profitability Analysis. 

Note that, in this step, you are maintaining the same table as you do in the step Activate operating 

concern. If you delete an entry here, it is also deleted in that step. 
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 Transfer of Billing Documents 

In this step you define how billing document items for sales from stock are transferred to Profitability 

Analysis ( CO-PA ). 

In costing-based CO-PA, you need to assign condition types and quantity fields from Sales and 

Distribution (SD) to the value and quantity fields CO-PA. 

Activities: 

Assign condition types to the desired value fields. These assignments let you transfer "real" conditions 

(those that are posted to FI) and "statistical" (fictitious) conditions to CO-PA. Assign value fields. 

For real conditions, the corresponding revenue, sales deduction, and cost-of-sales accounts must be 

defined as CO-relevant accounts (cost or revenue elements). 

Assign the quantity fields in SD to the desired quantity fields in CO-PA. Assign quantity fields. 

If desired, reset individual value fields for billing documents of a certain billing type. Reset value fields. 

For account-based CO-PA, the system only transfers those posting lines that are posted to FI as well. 

Activities: 

Only "real" postings that are posted to FI can be transferred to account-based CO-PA. All you need to do 

to transfer this data to CO-PA is make sure that the desired revenue, sales deduction, and cost-of-

sales accounts are defined as relevant for CO. Prerequisites 

The operating concern to which you want to transfer billing documents has been completely defined. 

You have maintained record type "F" for the necessary number ranges. 

You have activated the desired form(s) of Profitability Analysis. 

 Assign Value Fields 

All revenues, sales deductions and other values (such as transfer prices) are defined as conditions in SD. 

In this step, you assign these conditions to the corresponding CO-PA value fields. 

Note that certain limitations exist on the transfer of condition values of billing documents to CO-PA. 

To transfer condition types for sales revenues and sales deductions to CO-PA, you need to make sure 

that the condition types and linked to an account in FI that is also defined as a cost element of the 

category "11" (revenue element) or "12" (sales deduction) in CO. These condition types must be 

assigned to a CO-PA value field. 

Condition types linked to FI accounts that are defined as cost elements of another category are not 

transferred to CO-PA, even when the condition type has been assigned to a CO-PA value field. 

Condition types such as "VPRS" ("Cost") that are defined as statistical in SD are always transferred to 

CO-PA if they are assigned to a value field. 

All condition types that you want to transfer to CO-PA must be active in the SD pricing procedure. 

Inactive conditions in a billing item are not transferred. If all the conditions in a billing item are 

inactive, that item is not transferred to CO-PA. 

Conditions do not need to be active, however, to be transferred with sales order items, since the 

transfer of incoming sales orders is always statistical. 



 

 

It is also possible to transfer conditions from MM to update billing data in pooled payment in the IS 

Retail system. These are transferred according to the same rules as SD conditions. 

Notes 

Conditions from SD are always transferred to CO-PA with "+" signs, with the exception of credit memos 

and returns. The reasons for this is that the signs for revenues are handled differently in the different 

applications of the system. For example, revenues are positive in SD, while they are negative in FI. 

Consequently, CO-PA accepts all the values as positive, and then subtracts deductions and costs from 

revenues in the information system. 

Note that the indicator Transfer +/- signs is not used to compare the different use of +/- signs between FI 

or SD and CO-PA. If you activate this indicator, only the positive and negative values for the condition 

in question will be balanced. This guarantees that the sum of the negative and positive condition values is 

displayed as a correct total value in the value field assigned to that condition. 

Prerequisites 

The level of detail of the valuation in the SD billing document must meet the requirements for value 

fields in Profitability Analysis. 

The pricing procedure must be defined in SD. 

The condition types must be defined in SD. 

It is not necessary to activate the conditions for transferring sales order data, since this transfer is solely 

for statistical purposes. 

Actions 

Assign value fields to the conditions you want to transfer to Profitability Analysis, and set the flag 

"Transfer with +/- signs" if desired. 

Note that in this step you are maintaining the same table that you maintain in the steps under Transfer of 

Incoming Sales Orders and Transfer Customer Rebate Agreements. 

Thus, if you delete an entry, that entry is deleted in both steps. 

 Assign Quantity Fields 

A number of quantity fields are defined and used in the SD billing system. In this step you assign these to 

the corresponding quantity fields in costing-based Profitability Analysis ( CO-PA ). 

Actions 

Assign all the quantity fields you want to transfer from the billing system to costing-based CO-PA. 

Additional Information 

You can transfer the billed quantity to costing-based CO-PA using the sales unit as well as the 

stockkeeping unit. The assignment you make here is valid for both profitability planning and for actual 

postings. 

This assignment is particularly important for planning, because the system can automatically derive the 

unit for the quantities you plan manually for individual products. 
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 Reset Value/Quantity Fields 

You can use this function to reset a quantity or value field depending on the billing type. This means that 

the condition value set in the field is replaced by value 0. This procedure makes it possible to post only 

the revenue and quantity in Profitability Analysis (i.e. for returns) while retaining the freight costs of the 

original billing document by setting 'RE' as the billing type and resetting the value field "Freight costs". 

Activities 

Enter the combination of billing type and CO-PA quantity or value field that are to be reset in 

Profitability Analysis, and then select the field "Reset". 

 Order and Project Settlement 

In this section you set up settlement of actual and plan data for orders and projects to Profitability 

Analysis. 

You can settle actual data from internal orders, sales orders, and projects and plan data from plan-

integrated internal orders and projects. 

To settle data to CO-PA, you need to define a so-called "settlement profile" and assign this to the master 

data of the objects you want to settle. 

This settlement profile contains an allocation structure, which defines how the corresponding order or 

project is credit. It also contains a PA transfer structure, which determines how the values are settled to 

value fields in Profitability Analysis. 

In the PA transfer structure, you first assign the original cost elements on the order or the project to lines 

(assignments), which you then assign to value fields in Profitability Analysis. 

Example 

PA transfer structure:  VA ( value field assignment ) 

Assignment    Origin(al cost element)    Value field 

             OAS material               VV0     material costs 

  20           OAS wage                   VV200     labor costs 

Prerequisites 

The operating concern must be completely defined. 

A number range must be defined for the credit postings for the orders (business transaction KOAO). 

 ==> Check number ranges for transactions 

The number ranges for record type "C" must be defined. 

 ==> Check number ranges in CO-PA 

The desired form(s) of Profitability Analysis must be active. 

 ==> Check form of Profitability Analysis 



 

 

 Define PA Transfer Structure for Settlement 

In this activity, you define the PA transfer structures to be used to settle actual and planning data for 

orders and projects. 

Although it is technically possible, via a joint maintenance dialog, to use the same PA transfer structures 

from different allocation types in settlement, you should instead define separate PA transfer structures. 

Actions 

Select the function "New entries" and enter an abbreviation and a name for your PA transfer structure. 

Divide your cost elements according to how you want to group them in Profitability Analysis, and create 

assignment lines accordingly. These assignment lines are then used to transfer the cost elements to 

CO-PA value fields. 

The indicator for quantity billed/delivered is relevant for settling sales orders and projects. Select 

this indicator for the particular assignment line with which the billed quantity is to be transferred to 

CO-PA. Under "Value fields", you need to assign a CO-PA quantity field (quantity/value indicator 

"2") to such an assignment line for the billed quantity. During settlement to CO-PA, the billed 

amount is transferred to the assigned field. 

For each assignment line, enter into the order/project the cost element(s) or the cost element group to be 

assigned. You should usually activate the "Costs/Revenues" option as the source. The "Variances 

on production orders" option is only relevant for the settlement of production orders. In the latter 

case, you should define a separate operating concern (see the section "Define PA Tranfer Structure 

for Variance Settlement"). The "Accounting indicator from SM orders" option is only relevant for 

the settlement of service orders. 

For each assignment line, enter the value field (or, if costs are split into fixed and variable portions, both 

value fields) into which the entered costs are to be imported. 

 Assign PA Transfer Structure to Settlement Profile 

The settlement profile contains all the relevant information needed for settling CO orders, sales orders, 

projects, and production orders. 

From the point of view of Profitability Analysis (CO-PA), you need to assign your PA transfer structure 

to a settlement profile. 

Note: 

The settlement profile must allow profitability segments as settlement receivers. If you want to settle 

production variances, this must be stored in the settlement profile. 

Requirements 

Since the settlement profile is usually entered automatically in the master data of the object being settled 

(internal order, sales order, or project), you need to specify the desired settlement profile as a default. 

For internal orders, you can do this when you maintain order types. 

For sales orders, you do this when you maintain requirement classes. 

For projects, you do this when you maintain project profiles. 
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 Direct Posting from FI/MM 

You can transfer direct primary postings from Financial Accounting (FI) and Materials Management 

(MM) to profitability segments. 

The following are some typical cases of when you would want to do this: 

You post special direct costs from sales, such as transport insurance for a certain delivery, and would like 

to assign these primary costs directly to a profitability segment. 

You post an invoice for promotional events and you want this invoice to appear statistically in the 

responsible marketing cost center, and at the same time assign it to a profitability segment in 

Profitability Analysis. In this case, you would assign the invoice to both a cost center and a 

profitability segment. 

You create automatic postings in Materials Management and you want these revenues and expenses from 

the revaluation of material stocks to be posted automatically to Profitability Analysis. This instance 

also requires that you define "Automatic assignment to a profitability segment". 

Requirements 

The operating concern must be fully defined. 

The desired form of Profitability Analysis must be active for the relevant controlling areas. 

You have maintained number ranges for record type "B". 

You have created a group of characteristics (under "Master Data") to define the screen for assigning 

postings to profitability segments, and assigned this characteristic group to business transaction 

"RFBU". 

 Maintain PA Transfer Structure for Direct Postings 

In this activity, you define the  PA transfer structure FI, which you use to post costs and revenues directly 

to profitability segments. In the PA transfer structure "FI", you specify how the cost elements are to be 

defined to the CO-PA value fields. 

You can choose to transfer the posted amount to CO-PA as well. For this, include in the assignment the 

corresponding quantity field along with the value field(s). 

Since this maintenance dialog is also used in the definition of PA transfer structures for other allocations, 

there are several selection options that do not apply to the PA transfer structure "FI". These options are 

discussed below under "Activities". 

Activities 

Define the PA transfer structure "FI". 

Divide your cost elements according to how you want to group them in Profitability Analysis, and create 

assignment lines accordingly. 



 

 

Note: The indicator for quantity billed/delivered is not relevant for PA transfer structure FI and 

hence should not be activated. 

For each assignment line, enter the cost element or the cost element group to be assigned. As the source, 

activate the "Costs/Revenues" option. 

For each assignment line, enter the value field (or, if the costs are split into fixed and variable portions, 

both value fields) into which costs/revenues are to be imported. 

 Automatic Account Assignment 

Automatic postings, such as those created in Materials Management, can be passed on to Profitability 

Analysis (CO-PA) by means of an automatic assignment to a profitability segment. 

In Profitability Analysis, the documents are updated to the profitability segments generated according to 

the characteristic values found in the corresponding Financial Accounting ( FI ) document. If the 

characteristic value information in the FI document is not very detailed, the posted values are transferred 

to Profitability Analysis at an aggregated level. 

Note that automatic assignments to a profitability segment should only be used under special 

circumstances for certain accounts and business transactions only. 

Typical business transactions for which it makes sense to have a profitability segment found 

automatically include 

The transfer of price differences that are posted in purchasing due to differing order prices or differing 

prices in invoice receipt (as period costs) 

The transfer of expenses or revenues that arise due to a revaluation of material stocks ( as period costs) 

The transfer of inventory differences (as period costs) 

Activities 

Enter the accounts for automatic postings in the automatic assignment table. 

Select the "Profitability segment" indicator to transfer postings to this account to CO-PA. 

Requirements 

The automatic determination of a profitability segment is only required in individual cases, if you want to 

represent special business transactions in Profitability Analysis. 

The account for automatic postings must be assigned in the PA transfer structure "FI". 

The desired form of Profitability Analysis must be for the relevant controlling areas. 

Further notes 

Generally, a profitability segment is found and updated in Profitability Analysis automatically when the 

corresponding sender document is created (such as when you enter FI documents with direct assignment 

to Profitability Analysis, or when you create sales orders or billing documents). Therefore, it is not 
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desirable to have the system find a profitability segment for all the accounts relevant to profits by 

assigning accounts in this Customizing step. 

 Settlement of Production Variances 

When you valuate products with the standard price of production, so-called "production variances" can 

result on the production orders (actual cost of goods manufactured - ( produced quantity * standard 

price)). 

These production variances are determined in Product Cost Planning (CO-PC) and broken down there 

according to variance categories. When you settle the production order, you can transfer these variance 

categories to separate value fields in Profitability Analysis. 

Prerequisites 

The production variances first need to be calculated in CO-PC. 

Your PA transfer structure must contain assignments of variance categories to value fields. 

In the settlement profile, you defined that variances are to be settled. 

The settlement rule to profitability segments is created automatically based on the information available 

in the production order (product, product group, plant and so on). 

You must have maintained number ranges for record type "C". 

The desired form of Profitability Analysis must be active in the relevant controlling area. 

 Define PA Transfer Structure for Variance Settlement 

In this IMG activity, you define a PA transfer structure for transferring production variances during the 

settlement of production orders. 

When variances are calculated in Cost Object Controlling (CO-PC), production variances are 

determined and stored. When you settle production orders, you can transfer these variances differentiated 

by cost element and variance category - to value fields in CO-PA. 

Although it is technically possible, via a joint maintenance dialog, to use the same PA transfer structures 

from different allocation types to settle production variances, you should instead define separate PA 

transfer structures. 

Activities 

Create an identification code and a corresponding name for a PA transfer structure. 

Decide how you want to divide the variances and define corresponding assignment lines in the PA 

transfer structure. This division is then applied to transfer the production variances to the value 

fields in CO-PA. 

Select the indicator for quantity billed/delivered in the assignment line that is used for transferring 

to CO-PA the quantity of the production order that has been delivered to the plant. A CO-PA value 

field must be assigned under "Value fields" to such an assignment line for the delivered quantity 

(quantity/value indicator "2"). When the production order is settled to CO-PA, the delivered 

quantity is transferred to the assigned field. 



 

 

For each assignment line, enter the cost element(s) or the cost element group from which the production 

variances are to be settled, and select a variance category as the source (such as price variances for 

materials input). If, instead of a variance category, you select the "Costs/Revenues" option as the 

source, all variances of the entered cost element are settled to the production order. 

For each assignment line, enter the value field (or, if costs are split into fixed and variable portions, both 

value fields) into which the appropriate variance category is to be imported. 

In the next activity, assign your PA transfer structure to the desired settlement profile. 

 Assign PA Transfer Structure to Settlement Profile 

The settlement profile contains all the relevant information needed for settling CO orders, sales orders, 

projects, and production orders. 

From the point of view of Profitability Analysis (CO-PA), you need to assign your PA transfer structure 

to a settlement profile. 

Note: 

The settlement profile must allow profitability segments as settlement receivers. If you want to settle 

production variances, this must be stored in the settlement profile. 

Requirements 

Since the settlement profile is usually entered automatically in the master data of the object being settled 

(internal order, sales order, or project), you need to specify the desired settlement profile as a default. 

For internal orders, you can do this when you maintain order types. 

For sales orders, you do this when you maintain requirement classes. 

For projects, you do this when you maintain project profiles. 

 Transfer of Overhead 

The following business transactions let you transfer overhead to Profitability Analysis. 

 Initial Steps 

In this section you make the settings necessary for transferring overhead to Profitability Analysis. 

 Define Calculated Values for Use as Reference Values 

In this activity, you can define calculated values for use as tracing factors for cost center assessment, 

process assessment, or indirect activity allocation. 
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Example 

You want to assess the costs of your cost centers on the basis of the net revenue of the receiver 

profitability segments. So you define this value here using value fields. 

Activities 

Define a calculated value as a formula consisting of value fields. 

When you define your cycles for assessment or indirect activity allocation, you can then choose these 

values as tracing factors. 

 Assign Characteristic Groups to Actual Cycles 

In this step, you specify (for cycle maintenance for assessment and for the allocation of indirect 

activities) which characteristics can be used to define the receiver during segment maintenance. To do 

this, you assign a characteristic group to the business transaction of the particular allocation type 

concerned. 

Example 

During segment maintenance for a planned assessment cycle, only the characteristics "Company code", 

"Customer" and "Sales organization" should be available for defining the receiver. You therefore assign 

a characteristic group containing these characteristics to the business transaction KSPB (Plan assessment 

to CO-PA). 

Requirements 

You need to have defined a characteristic group containing the characteristics that are to be made 

available for defining the receiver. You do this by choosing Flows of Actual Values -> Initial Steps -

> Characteristic Groups -> Maintain Characteristic Groups. 

 Activate Transfer of Cost Component Split During Activity 

Allocation 

In this activity, you activate the transfer of the price cost components from activity and process allocation 

to Profitability Analysis. 

Activities 

If you use the cost component split in Cost Center Accounting or Activity-Based Costing for price 

calculation, you can update the prices divided into cost components during allocations to Profitability 

Analysis. To do this, you need to perform the following steps: 

Maintain the cost component split assignments to CO-PA value fields. 

Assign a value field or, when splitting into fixed and variable portions, both value fields to each of 

the cost components of the cost component structure used in Cost Center Accounting or Activity-

Based Costing. 

You find the corresponding cost component structure in the detailed information on the section of 

the CO version dependent on the fiscal year. 



 

 

Activate the transfer of the cost components for the corresponding operating concern. 

Further notes 

Note that, when the transfer is activated, price revaluations are also updated for activities posted 

previously using the assignment of cost components to CO-PA value fields. 

For more information on the cost component structure and on price calculation with cost components, see 

the SAP Library in the area Financials -> Controlling -> Cost Center Accounting -> Period-End Closing 

-> Actual Price Calculations -> Price Calculation with Cost Component Split. 

 Assign PA Transfer Structure to Business Transaction 

In this activity, you specify which PA transfer structures are used for specific business transactions to 

transfer overhead. 

For this, you assign a PA transfer structure to the business transaction of the respective allocation type. 

Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. Initial entries in the PA Transfer Structure column are reset to 

the following SAP standard selection when you save. 

PA transfer structure "CO" for 

Internal activity allocation 

Template allocation from cost center costs and process costs 

Revaluation due to price ( re)calculation 

PA transfer structure "FI" for repostings 

Example 

You want to be able to display price changes individually when revaluating internally allocated activities 

with a price calculation. 

By assigning different PA transfer structures for the business transactions "Activity Allocation" and 

"Revaluation Due to (Re)Calculation of Prices", you can send the results from the revaluation of activity 

quantities into other value fields as opposed to those for the values calculated in activity allocation. 

 Assess Cost Center Costs / Process Costs 

You can assess both plan and actual cost center costs and process costs to profitability segments as part 

of your period-end closing activities. 

Example 

You can assign the costs of your sales cost centers to the customer groups and regions for which those 

cost centers are responsible. You can assess specific percentages of the costs or absolute amounts to the 

different customer groups and regions, or you can distribute them in proportion to certain values 

contained in the value fields of those segments (tracing factors). 

Activities 
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Define an assessment cycle. The cycle determines: 

The cost centers or business processes that assess the costs 

The profitability segments that receive the costs 

The amounts that are to be assessed 

The tracing factors according to which the costs are distributed to the different profitability 

segments 

In the cycle, you need to specify a PA transfer structure if you want to transfer different cost element 

groups to several value fields in costing-based CO-PA. 

You need to specify an allocation structure if you want to credit the cost center using several assessment 

cost elements. 

Note 

You can only use PA transfer structures and allocation structures with sender rule "1" ( posted amounts). 

 Define Structure of Cost Center Assessment/Process Cost Assessment 

In this step you define rules for allocating cost center costs and process costs to Profitability Analysis 

(CO-PA) in the form of cycles. 

Activities 

Define your assessment cycles. In doing so, observe the following: 

The header of the cycle contains the parameters that are valid for the entire cycle. This includes the 

sender selection type, where you specify for actual data whether you want to assess all costs 

together or fixed and variable costs separately. 

The segments contain the combinations of sender cost centers/sender processes and receiver profitability 

segments that are processed using a single distribution rule. 

Specify either an assessment cost element or an allocation structure, which determines more than 

one assessment cost element for each cost element group. The sender cost centers/sender 

processes are credited using these secondary cost elements (cost element category 42). In 

account-based CO-PA, the receiver profitability segments are also credited using this cost 

element. 

Specify either single value fields for the fixed and variable costs, respectively, or a PA transfer 

structure that determines more than one value field for each cost element group. 

Specify the rule which you want to use to credit the sender. 

Note that, for technical reasons, you can only use an allocation structure or a PA transfer 

structure with sender rule "1" (posted amounts). 

Define the tracing factor, the rule which determines how the values are distributed to the receivers. 

For example, you can distribute certain percentages to the different 

receivers or distribute using certain values (such as the quantity sold or the revenue) as an 

allocation base. If you choose to use an allocation base, choose the receiver rule "Variable 

portions". 



 

 

Specify the senders and receivers in the allocation characteristics. 

Prerequisites 

For process cost assessment, Activity-Based Costing (CO-OM-ABC) must be active as an operational 

Controlling component in your system. 

The desired form of Profitability Analysis must be active. 

You can check the form of Profitability Analysis by choosing Actual Flows of Values -> Activate 

Profitability Analysis. 

Credit postings require you to have assigned an internal number range for the CO transactions KSPA 

(actual) or KSPB ( plan ). 

To verify that this has been done, switch to Customizing for General Controlling and choose 

Organization -> Define Number Ranges for CO Documents. 

In Profitability Analysis, you must define a number range for record type "D". For actual data, you verify 

this by choosing Flows of Actual Values -> Initial Steps -> Define Number Ranges for Actual 

Postings. 

In planning, you verify this by choosing Planning -> Initial Steps -> Define Number Ranges 

for Planning Data. 

To improve runtimes in assessment, it is recommended that you use summarization levels if possible. 

These provide presummarized tracing factors for the receiver profitability segments. 

 Define PA Transfer Structure for Assessment 

In this activity, you define a PA transfer structure for performing assessment. 

If you want import the values posted to a cost center/process into different value fields by means of 

differentiation by cost element, you can use one of the following options: 

You can set up a cycle with several segments. For this, you need to create a separate segment for each 

assignment of a cost element interval/cost element group to a value field. 

You can set up a cycle with only one segment. For this, the assignment of cost elements to the respective 

value fields is defined via a PA transfer structure. 

You can use the PA transfer structure to combine in a single segment different assignments of cost 

elements/cost element groups to value fields. Instead of a value field, you can enter the PA transfer 

structure when defining an assessment cycle in the segment header. 

Notes: 

You can only use a PA transfer system together with the "Posted values" sender rule. 

Even when it is technically possible, via a joint maintenance dialog, to use PA transfer structures from 

different allocation types to perform the assessment, you should still define separate PA transfer 

structures. 

Equally dependent on the joint maintenance dialog, there are some selection options within the 

maintenance functions for the PA transfer structure that do not apply to structures used exclusively 

in assessment. These options are discussed below under "Activities". 
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Activities 

Create a PA transfer structure for assessment. 

Decide how you want to divide the cost elements and define corresponding assignment lines. This 

division is then used to transfer the cost elements to the CO-PA value fields. The indicator for 

quantity billed/delivered is not relevant for assessment and hence should not be activated. 

For each assignment line, enter into the cost center/process the cost element(s) or the cost element that 

are to be assigned. 

As the source, activate the "Costs/Revenues" option. Note that only costs are allocated during 

assessment, not revenues. 

For each assignment line, enter the value field (or, if the cost elements are split into fixed and variable 

portions, both value fields) into which the entered costs are to be imported. 

 Define Allocation Structure 

If the assessment for each segment is not made with a pre-defined assessment cost element, you can 

assign the source cost elements to the desired assessment cost element in the allocation structure. During 

cycle definition, enter the allocation structure instead of an assessment cost element in the segment. 

An allocation structure for the assessment consists of at least one assignment, stating the assessment cost 

element to which the source element is assigned. The original cost elements will already have 

assignments in the source. 

Requirements 

To define the assessment cost elements required for the allocation structures, you must first complete the 

IMG activity "Create Assessment Cost Elements". 

Activities 

Creating an allocation structure. 

To create an allocation structure, proceed as follows: 

Choose "New Entries". 

Enter a name and text for the allocation structure. 

Save the allocation structure. 

Enter the assignments for each allocation structure. To make the assignments, proceed as follows: 

Select the allocation structure, and then choose "Assignments". 

Choose "New Entries". 

Enter a name and text for the assignment. 

Save the assignment. 

Specify the source for each assignment. 

To specify the source for an assignment, proceed as follows: 

Select the assignment, then choose "Source". 



 

 

Enter a cost element interval or a cost element group. 

Save the source. 

Enter the assessment cost element for each assignment. 

To specify an assessment cost element for an assignement, proceed as follows: 

Select the assignment, then choose "Assessment cost element". 

Enter the assessment cost element you require. 

Save your entries. 

 Display Cycle Overview of Actual Assessment 

In this step, you can display the cycles for actual assessment that have been defined in an operating 

concern. 

Cycles are displayed in a tree structure on the left-hand side of the screen. By expanding the nodes, you 

can display the segments for a cycle. 

On the right-hand side of the screen, you can change the selection used to call up the tree structure for the 

cycles and you can display additional columns in the tree. 

To call up detailed information about a cycle and a segment, select the required object in the tree by 

double-clicking it and switch to the tab index Cycle information. From the detailed information screen, 

you can switch to cycle maintenance to make changes there. Alternatively, you can execute the cycle 

directly. 

 Direct/Indirect Activity Allocation 

In this step, you make the necessary settings for allocating activities from cost centers and processes to 

profitability segments. 

Whereas in assessment you can distribute the data from cost elements or cost element groups by 

percentages or based on tracing factors, the distribution of values in activity allocation depends on the 

activity involved. 

Direct activity allocation 

Normally, you can assign activities that are performed for certain profitability segments (such as 

customers or products) directly to those segments. When you do so, the system transfers the quantity of 

the activity performed and valuates this with the planned price for that activity in the cost center 

involved. This makes it possible to allocate consulting hours, for example, to the customer for whom 

they were worked. 

Prerequisite 

The activity must be defined as activity type category "1" (manual entry and manual allocation) 

in Cost Center Accounting, and an activity quantity must have been planned manually. 

Activities 

Define the PA transfer structure "CO". 

Indirect activity allocation 
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If the activity cannot be measured directly, you can create a quantity structure on the basis of certain 

assumptions, and then valuate and allocate this structure just like direct activity allocation. An example 

for this would be a cost center "Order processing", for which no activities are explicitly entered. In order 

to allocate these costs in accordance with how they originated, you can create a quantity structure based 

on a quantity field "Number of orders entered", and then valuate this with a planned price. 

Prerequisite 

The activity must be defined as activity type category "2" (Indirect creation and indirect 

allocation) or "3" (Manual entry and indirect allocation) in Cost Center Accounting. If you use 

category "3", you also need to define an activity quantity for the sender. 

Activities 

Define the PA transfer structure "CO". 

Define indirect activity allocation for cost centers or processes. 

Further Notes 

The sender cost center are credited using the allocation cost element that was assigned to the activity 

type. 

In account-based CO-PA, the values are posted to the same allocation cost element. 

In costing-based CO-PA, the allocation cost element needs to be assigned to a value field in PA transfer 

structure "CO". The value is transferred to that value field. 

 Maintain PA Transfer Structure for Template and Activity 

Allocation 

In this activity, you maintain PA transfer structures that are used for the following allocations of actual 

and plan data: 

Internal activity allocation 

Template allocation for cost center costs and process costs 

Revaluation due to price ( re)determination 

Reposting 

You use the PA transfer structure to determine which allocation cost elements are transferred to which 

CO-PA value fields. 

You can also transfer the allocated activity quantity to CO-PA. To do this, include in the assignment the 

corresponding quantity field along with the value field(s). 

Note: 

Since this maintenance dialog is also used in the definition of PA transfer structures for other allocations, 

there are several selection options that do not apply to the PA transfer structures used here. These options 

are discussed below under Activities. 

Activities 



 

 

Maintain the appropriate PA transfer structure. 

Decide how you want to divide your allocation cost elements and create corresponding assignment lines. 

This division is then used to transfer the cost elements to the CO-PA value fields. 

Note: The indicator for quantity billed/delivered is not relevant here and should therefore not be 

activated. 

For each assignment line, enter the allocation cost element(s) or the allocation cost element group to be 

assigned. As the source, activate the "Costs/Revenues" option. Note that only costs are allocated 

during activity allocation and template allocation, and that revenues are not. 

For each assignment line, enter the value field (or, if the costs are split into fixed and variable portions, 

both value fields) into which the entered costs are to be imported. 

Assign the PA transfer structure to the corresponding business transaction. Maintain these settings 

separately for actual business transactions and plan business transactions . 

Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. ("CO" or "FI"). 

 Set Up Indirect Allocation of Activities from Cost 

Centers/Processes 

The advantage of indirect activity allocation over cost assessment is that you can allocate the entire 

activity based on the activity quantity performed or one determined indirectly after valuating it with a 

fixed and/or a variable price. For information on the basic concept of indirect activity allocation, see 

Indirect Activity Allocation. 

Activities 

Set up indirect activity allocation as described by performing the steps described in the section Define 

Indirect Activity Allocation in Customizing for Cost Center Accounting. You use the same steps 

again to set up the indirect allocation of activities from processes. 

Enter a cost center and a suitable activity type or business process as the sender objects in the cycle. 

As the receiver, specify those profitability segments that are relevant for the allocation of costs. 

Prerequisites 

For the indirect allocation of activities from cost centers: 

You must have an activity type that uses allocation category 02 or 03. Maintain Activity Types for 

Indirect Activity Allocation. 

Planning data must exist for the activity type so that 

plan price iteration has been carried out, or - a plan price was defined manually for the cost center, or 

an actual price must have been determined in period-end closing. 

For the indirect allocation of activities from processes: 

You must have Activity-Based Costing implemented as an operational Controlling component in your 

system 

You need to have defined a process containing the allocation category 02 or 03. 



 

WHATSAPP +255738656506 

 

The process has been planned during business process planning so that - a price is available for 

valuating utilization, or - an actual price is determined. 

 Display Cycle Overview of Actual Activity Allocation 

In this step, you can display the cycles that have been created in an operating concern for actual indirect 

activity allocation. 

Cycles are displayed in a tree structure on the left-hand side of the screen. By expanding the nodes, you 

can display the segments for a cycle. 

On the right-hand side of the screen, you can change the selection used to call up the tree structure for the 

cycles and you can display additional columns in the tree. 

To call up detailed information about a cycle and a segment, select the required object in the tree by 

double-clicking it and switch to the tab index Cycle information. From the detailed information screen, 

you can switch to cycle maintenance to make changes there. Alternatively, you can execute the cycle 

directly. 

 Maintain Cost Component Split Assignments for Activity Allocation 

In this activity, you define the assignment of cost elements to value fields. 

Requirements 

This assignment is only relevant if the transfer of the cost component split to Profitability Analysis is 

active. 

Activities 

Assign a value field or, if splitting into fixed and variable portions, both value fields to each of the cost 

components of the cost component structure used in Cost Center Accounting or Activity-Based Costing. 

You find the corresponding cost component structure in the detailed information on the part of the CO 

version dependent on the fiscal year. 

Further notes 

For more information on the cost component structure as well as on price calculation with cost 

components, see the documentation in the SAP Library in the area Financials -> Controlling -> Cost 

Center Accounting -> Period-End Closing -> Actual Price Calculations -> Price Calculation with Cost 

Component Split. 



 

 

 Set Up Template Allocation 

In contrast to assessment, template allocation lets you allocate overhead costs (for business processes or 

cost centers/activity types) in a cause-and-effect manner based on the quantities used. 

To do this, you must define a template containing the formulas and functions required for calculating the 

quantities used and thus the cost drivers. The quantities are then valuated by means of price calculation. 

Dynamic template allocation functions as follows: 

When carrying out the allocation, the user specifies the particular characteristic area for which the 

allocation should be carried out. If there are characteristic values in this area that are linked with a 

template via a selection strategy, this template is then used automatically. The template's settings are 

employed to determine the appropriate activity quantities and the appropriate business process or cost 

center/activity type that forward those quantities to the profitability segment. The activity quantities 

(valuated with prices) are then allocated to the profitability segment whose dimensions are defined in 

Customizing. The costs are not only allocated to the specified update characteristics. They are also 

allocated to all characteristics that you defined as target fields for source characteristics via a derivation 

rule. 

To create all prerequisites for this procedure, you need to carry out the following steps in Customizing: 

First, limit the number of record types. Doing so reduces the amounts of data to be processed, thus 

enhancing system performance. Moreover, this prevents duplicate allocations from occurring (for 

example, for an incoming sales order and again for its corresponding billing document). 

You specify the dimensions of the profitability segment by entering update characteristics. You then 

make some or all of them into selection characteristics. These determine which criteria are used to 

select the destination objects in the template allocation. 

This last step completes the definition of the profitability segment. The following steps allow you to set 

about using the process template: 

You generate and maintain the template environment by changing environment functions already present 

or creating new ones. 

You can use the environment functions delivered in the system or those that you created yourself to 

create the templates required for your allocations. 

To ensure that the appropriate template is used for allocation, enter at this stage which characteristics and 

which characteristic values should be used to define the template. 

You then specify in the PA transfer structure which value fields the process costs are posted to. This 

occurs via the assignment of the allocation cost elements (for business processes or cost 

centers/activity types) to value fields. 

 Define Record Types for Selecting Cost Drivers 

In this activity, you choose which record types in CO-PA you want to use as tracing factors for selecting 

the cost drivers. This reduces the number of profitability segments used in template determination, 

thereby producing several advantages. Such a reduction can considerably enhance performance, for 

example. 

You can choose from the record types delivered by SAP or define your own: Define New 

Record Types 

Example 



 

WHATSAPP +255738656506 

 

If incoming sales orders and billing documents are both posted in CO-PA, you can decide whether the 

sender objects (such as processes) should be allocated at the point of entry of the incoming sales orders 

or of the billing documents. If you choose both record types, then you have to decide on an activation 

condition in the template that controls when the sender objects are settled. This ensures that a settlement 

does not occur twice. 

Activities 

To choose a record type, select the appropriate checkbox and save your selection. 

 Specify Characteristics for Selection and Update 

In this activity, you define update characteristics and specify which ones you want the system to use to 

select profitability segments in template allocation. 

Allocated costs in CO-PA are posted to the update characteristics (and to the characteristics 

derived from them). Update characteristics are used to locate cost drivers. 

When you carry out the dynamic process allocation, the selection characteristics appear for selection. 

This enables you to limit the number of characteristic values. 

Note 

Delta postings to characteristics are no longer possible once the latter have been changed. 

Activities 

Select 'New Entries'. 

Select the desired update characteristics in the "Characteristic" column using the possible entries 

function. The characteristics for the operating concern are then available. Note: The characteristics 

"Product" and "Customer" are not offered for selection because the general allocation of sender 

objects to lowest-level characteristics usually causes performance problems. 

To specify an update characteristic as a selection characteristic, click on the corresponding indicator in 

the "Selection" column. 

Note 

You can define other update characteristics which can then also be considered during profitability 

segment determination, but dependently of the characteristic values relating to the update characteristics 

defined under "New Entries". You do this in the transaction Maintain Process Template Determination 

and Other Update Characteristics. This makes sense if, for example, the characteristic "Customer" is to 

be included in operating concern determination for a specific customer group. (Example: if an update 

should occur at customer level whenever the characteristic "Customer group" receives the value "Major 

customer"). 

 Generate Template Environment for CO-PA 

Before you can define a template, you first need to modify the template environment so that it is 

compatible with your operating concern. 



 

 

The update characteristics that you specified and the value fields of your operating concern are first made 

available in the environment. 

Activities 

Choose from the available characteristics and value fields all those that you wish to use for maintaining 

the template. 

 Maintain Template Environment and Function Trees 

At this point, you can choose from all the possible environments for template allocation. However,you 

should ONLY edit the environment PAC ! Ensure that you note the following when executing the 

allocation. 

General 

In this step you maintain: 

Function trees 

Structure nodes - Function references - Functions. 

The basis for the maintenance of the object is always the chosen environment. 

Environment 

The Template's environment determines the information of the SAP-environment and the external system 

that can be accessed. Basically, the functions relevant to each context are already provided in the 

corresponding environment. Environments always contain a row of sub-environments which group 

functions by theme; these include material, BOM, routing, and others. 

The standard system delivers the following environments: 

Template allocation (for cost objects, profitability segments, 

business processes, cost centers/activity types) 

Formula planning (business processes, cost centers, profit centers) 

Standard cost estimates 

Process quantity determination ( SOP/LTP ) 

Easy Cost Planning/Internal Service Request 

Recommendation 

Use the sub-environments provided by SAP as much as possible. When you assign an function to a sub-

environment, it is automatically available in all the main environments containing this sub-environment. 

Further notes 

For more information on environments and a list of these and their sub-environments go to the help for 

applications of Activity-Based Costing under "Template -> Template Environment". 

Function Tree 

A function tree is a user-defined hierarchy which structures or groups functions. With the Help for 

function trees, you can structure groups of functions available in each environment according to their 

their theme or emphasis. Functions are then processed from here on. 
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A function tree is assigned to an environment and consists of nodes and function nodes. 

Environments: all environments are displayed when you call up the n transaction. Environments 

themselves cannot be changed or deleted. The creation of new environments is also not possible. 

Function trees: the first level under environments. You can subordinate nodes or function nodes to a 

function tree. 

Nodes: nodes are always subordinate to function trees or other nodes. You can subordinate other nodes to 

a node or function node. In function trees SAP1, nodes contain sub-environments. 

Function nodes are always subordinate to function trees or nodes. They always refer to a function. 

SAP standard delivery for all environments includes function tree SAP1 (for example, for environment 

001, function tree SAP1-001). This contains all standard nodes ( sub-environments ) and function nodes 

(with reference to the respective function). 

Activities 

The transaction provides you with left and right screens. The left one displays the existing environments. 

You can expand the hierarchy and view the function trees, nodes and function nodes in their hierarchical 

structure. Place the curser on an object you want to process. 

The right screen details of the chosen object (environment, function tree, nodes or function nodes) in list 

form. If you double click on a funciton node you will see the maintenance screen for the functions. 

Further notes 

For more information see Application help for Activity-Based Costing: 

AC-Financials -> CO-Controlling -> Activity-Based Costing -> Template -> 

Function tree -> Maintain function tree or Template -> Template environment -> Maintain 

functions 

AC-Financials -> CO-Controlling -> Cost center accounting -> Cost center planning -> Aids -> 

Formula planning -> Template -> Template environment. 

 Maintain Template 

Here you maintain templates. 

Applications 

Each purpose (application) of a template requires a special environment. Before creating a template, 

choose an environment. The environment determines which row and column types are available, for 

example. 

The available applications include the following: 

Template allocation to cost objects, or use in standard cost estimates for cost objects and materials 

(environments 001 - 012) 

Template allocation to business processes, cost centers, or cost centers/activity types 

(environments SBP, SCI, SCD) 

Template allocation to profitability segments (environment PAC) 



 

 

Formula planning (environments CPI, CPD, BPP, PCA) 

Calculation of output quantities (environment SOP) 

Easy Cost Planning/Internal Service Requests (environment 200 - 299) 

Structure 

A template consists of rows (items) and columns. The row and column types available to you depend on 

the environment. 

Columns available include: 

Type of row, such as business process, cost element subtemplate, or calculation row 

Name of the item 

Object, such as the name of the process, cost element, subtemplate, or calculation row 

Quantity (actual/plan), such as the process quantity or statistical key figure quantity 

Activation ( actual/plan ) 

Allocation event (template for cost objects) 

Activities 

To maintain a template, you must edit the initial and overview screens, from which you can access 

various editors. 

Initial screen 

Enter the name of the template that you want to create or edit. 

Enter the environment of the template. 

Choose Enter. 

Overview screen 

If the template is new, enter a name for it. 

Select the row type. 

Enter a name for the row. 

Edit the other columns. Use the mouse or the tab key to reach the individual columns. Double-clicking on 

particular column types (such as object, quantity, activation, or allocation event) brings you to the 

editor or function selection. 

Once you have entered or edited all rows, choose Template -> Save. 

Further notes 

Detailed information is available in the Application Help for the transaction, or in the SAP Library under 

Financials -> Controlling -> Activity-Based Costing -> Template -> Maintaining Templates. 
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 Maintain Template Determination and Other Update 

Characteristics 

Maintaining template definition 

If the user wants to run a template allocation, he/she specifies via the selection characteristics the 

particular characteristic area for which the allocation should be carried out. If that particular area 

contains characteristics that are linked to a template via a determination strategy, then the relevant 

template is automatically used for the calculation. You define the determination strategy as follows: 

Choose "Strategy -> Display/Change" 

Choose "Edit -> Create step" 

Assign a description to the determination rule. 

Use the possible entries pushbutton to choose source fields from the selection characteristics previously 

specified. A placeholder is automatically entered as target field for a template. Note: During rule 

entry, a column is provided for all the fields entered at this stage. You can then enter concrete 

values into this column. 

Save your entries and choose "Maintain rule values". Use the possible entries pushbutton to insert 

Use the possible entries pushbutton to insert in the columns produced by source field entries the 

characteristic values to be used in the selection of the template. 

Use the possible entries pushbutton to insert a template in the template column. 

Note: If you have already defined further allocation characteristics in this transaction ( see below), 

change the existing determination rule by inserting a concrete template for the rule values. 

Maintaining further allocation characteristics 

Further allocation characteristics are those which only form a dimension of an operating concern under 

certain circumstances (that is, when one or more allocation characteristics accept certain values). 

These are maintained after you have selected the fixed allocation characteristics. 

You need to take the following steps: 

Choose "Strategy -> Display/Change" 

Choose "Edit -> Create step" 

Assign a description to the determination rule. 

Carry out the following steps in the register "Definition": 

Use the possible entries pushbutton to choose source fields from the selection characteristics 

previously specified. 

Use the possible entries pushbutton to choose up to five target fields ('NAME1' to 'NAME5') as 

additional allocation characteristics. 

Save your entries and choose "Maintain rule values". 

You arrive at the screen "Change rule values" in which an entry column is displayed for each field 

that you have created. 

Use the possible entries pushbutton to insert in the columns produced by source field entries the 

characteristic values to be used in the selection of the additional template. 



 

 

Use the possible entries pushbutton to insert the additional allocation characteristic in the columns 

produced by target field entries. All characteristics for the operating concern that are not yet fixed 

allocation characteristics are available. 

Save your entries. 

Example 

You have chosen the characteristic value "Major customer" for the fixed allocation characteristic 

"Customer group" and you have chosen the additional allocation characteristic "Customer" for this 

condition. If during the template allocation data records with the characteristic value "Major customer" 

are contained in the selected characteristic area, then the characteristic "Customer" (and all 

characteristics derived from it) is involved in determining the operating concern. 

 Maintain PA Transfer Structure for Template and Activity 

Allocation 

In this activity, you maintain PA transfer structures that are used for the following allocations of actual 

and plan data: 

Internal activity allocation 

Template allocation for cost center costs and process costs 

Revaluation due to price ( re)determination 

Reposting 

You use the PA transfer structure to determine which allocation cost elements are transferred to which 

CO-PA value fields. 

You can also transfer the allocated activity quantity to CO-PA. To do this, include in the assignment the 

corresponding quantity field along with the value field(s). 

Note: 

Since this maintenance dialog is also used in the definition of PA transfer structures for other allocations, 

there are several selection options that do not apply to the PA transfer structures used here. These options 

are discussed below under Activities. 

Activities 

Maintain the appropriate PA transfer structure. 

Decide how you want to divide your allocation cost elements and create corresponding assignment lines. 

This division is then used to transfer the cost elements to the CO-PA value fields. 

Note: The indicator for quantity billed/delivered is not relevant here and should therefore not be 

activated. 

For each assignment line, enter the allocation cost element(s) or the allocation cost element group to be 

assigned. As the source, activate the "Costs/Revenues" option. Note that only costs are allocated 

during activity allocation and template allocation, and that revenues are not. 

For each assignment line, enter the value field (or, if the costs are split into fixed and variable portions, 

both value fields) into which the entered costs are to be imported. 

Assign the PA transfer structure to the corresponding business transaction. Maintain these settings 

separately for actual business transactions and plan business transactions . 
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Note: 

If you do not assign a business transaction to a PA transfer structure, the system uses the standard 

selection for the PA transfer structures. ("CO" or "FI"). 

 Maintain Cost Component Split Assignments for Activity Allocation 

In this activity, you define the assignment of cost elements to value fields. 

Requirements 

This assignment is only relevant if the transfer of the cost component split to Profitability Analysis is 

active. 

Activities 

Assign a value field or, if splitting into fixed and variable portions, both value fields to each of the cost 

components of the cost component structure used in Cost Center Accounting or Activity-Based Costing. 

You find the corresponding cost component structure in the detailed information on the part of the CO 

version dependent on the fiscal year. 

Further notes 

For more information on the cost component structure as well as on price calculation with cost 

components, see the documentation in the SAP Library in the area Financials -> Controlling -> Cost 

Center Accounting -> Period-End Closing -> Actual Price Calculations -> Price Calculation with Cost 

Component Split. 

 Settlement of Overhead/Projects 

In this section, you determine how the values and quantities posted to overhead orders and overhead 

projects are to be settled into Profitability Analysis. 

Note 

Settlement is carried out the same way as for projects and orders with revenues. For more information, 

see the section Order and Project Settlement. 

 Define PA Transfer Structure for Settlement 

In this activity, you define the PA transfer structures to be used to settle actual and planning data for 

orders and projects. 

Although it is technically possible, via a joint maintenance dialog, to use the same PA transfer structures 

from different allocation types in settlement, you should instead define separate PA transfer structures. 

Actions 



 

 

Select the function "New entries" and enter an abbreviation and a name for your PA transfer structure. 

Divide your cost elements according to how you want to group them in Profitability Analysis, and create 

assignment lines accordingly. These assignment lines are then used to transfer the cost elements to 

CO-PA value fields. 

The indicator for quantity billed/delivered is relevant for settling sales orders and projects. Select 

this indicator for the particular assignment line with which the billed quantity is to be transferred to 

CO-PA. Under "Value fields", you need to assign a CO-PA quantity field (quantity/value indicator 

"2") to such an assignment line for the billed quantity. During settlement to CO-PA, the billed 

amount is transferred to the assigned field. 

For each assignment line, enter into the order/project the cost element(s) or the cost element group to be 

assigned. You should usually activate the "Costs/Revenues" option as the source. The "Variances 

on production orders" option is only relevant for the settlement of production orders. In the latter 

case, you should define a separate operating concern (see the section "Define PA Tranfer Structure 

for Variance Settlement"). The "Accounting indicator from SM orders" option is only relevant for 

the settlement of service orders. 

For each assignment line, enter the value field (or, if costs are split into fixed and variable portions, both 

value fields) into which the entered costs are to be imported. 

 Assign PA Transfer Structure to Settlement Profile 

The settlement profile controls the whole settlement. From a Profitability Analysis point of view, your 

PA transfer structure must be assigned to a settlement profile. 

Important: 

The settlement profile must allow profitability segments as settlement receivers. 

If you want to settle production variances, this must be stored in the settlement profile. 

 Transfer Customer Rebate Agreements 

In this step, you can activate the transfer of customer agreeements from Sales and Distribution (SD) to 

Profitability Analysis ( CO-PA ). 

Requirements 

The number ranges for record type "G" must be maintained. 

The assignment of conditions to value fields must be maintained in the Customizing step "Flow of Actual 

Values -> Transfer of Billing Documents". 

Costing-based CO-PA must be active. 

Recommendation 
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In general, it makes sense to transfer customer agreements (especially promotions) to CO-PA if you want 

to be able to control your sales and promotional campaigns in CO-PA. This transfer makes it possible to 

analyze your budgets and the available funds at an early point in time ( as soon as you have created funds 

for a promotion). 

Activities 

Specify that you want to transfer the condition types relevant for monitoring sales and promotional 

budgets to CO-PA. 

Further notes 

Note that, in this step, you are maintaining the same table as in the step "Assign value fields" for the 

transfer of billing documents and incoming sales orders. If, for example, you delete an entry, it is also 

deleted in all these steps. 

 Multiple Valuation Approaches/Transfer Prices 

In Profitability Analysis, all sales to external customers (outside the group) are represented from the 

point of view of the legal organizational unit (company code). This view only shows you the external 

sales, valuated using the legally oriented cost of goods manufactured. 

If your organization uses profit centers, which operate independently on the market just like separate 

companies, you need to be able to see internal sales, such as goods withdrawals or deliveries, between 

profit centers if you want to be able to analyze the profitability of your profit centers. Moreover, you 

need to be able to see the external sales valuated from the viewpoint of the individual profit centers - in 

other words, valuated with the cost of goods manufactured on the basis of transfer prices. 

In the following sections, you set up the transfer of values from the viewpoint of your profit centers to 

costing-based CO-PA. 

 Assign Accounts for Internal Goods Movements 

In this activity, you assign accounts for internal goods movements between profit centers to value fields 

in Profitability Analysis. You also can specify the quantity field to which you want to transfer the goods 

movements quantities. 

This makes it possible to analyze your results in CO-PA based on profit center valuation, taking internal 

goods movements between profit centers into account. 

Requirements 

In the attributes of your operating concern, profit center valuation must be activated for at least one 

currency. Choose "Structures -> Define Operating Concern -> Maintain Operating Concern" and 

then choose the tab page "Attributes". 

The currency and valuation profile assigned to the relevant controlling area must be active. Choose 

"General Controlling -> Multiple Valuation Approaches/Transfer Prices -> Activate ->  Parallel 

Valuation Approaches: Check Activation / Execute". 



 

 

 Activate Profit Center Valuation 

In this activity, you can activate profit center valuation in CO-PA for individual controlling areas. If you 

do so, the system valuates both external sales and internal sales between profit centers (such as stock 

transfers between different plants) from the viewpoint of the individual profit centers. 

In profit center valuation, both internal and external sales are valuated with a cost of goods manufactured 

based on transfer prices. 

In planning, you can define plan versions to use profit center valuation. 

In the information system, you can define and analyze reports that show data for both profit center 

valuation and legal valuation. 

Recommendation 

You should only activate profit center valuation in CO-PA if you want to be able to valuate exchanges of 

goods and services between profit centers using transfer prices and analyze the results of this valuation in 

CO-PA. 

Further notes 

If you activate profit center valuation, the system creates separate line items for legal valuation and profit 

center valuation. 

Consequently, this about doubles the volume of actual data transferred to CO-PA! The number of 

profitability segments, however, remains the same. 

 Periodic Adjustments 

In Profitability Analysis (CO-PA), you can carry out periodic adjustments on your data by 

valuating the data already posted using the most up-to-date information. For example, you may have new 

information about the cost of goods manufactured and want to pass this information on to CO-PA. 

This function is called "periodic valuation". 

assign postings that could only be made at higher levels when they were first posted ( such as the division 

level) to more detailed profitability segments (such as sales organizations). This function is called 

"Actual top-down distribution". 

Actions 

To perform periodic valuation, you first need to make settings for valuation for the point of valuation 

"2" (periodic valuation of actual data). 

If you want to perform actual top-down valuation, you only need to make Customizing settings if you 

always want using one value field as the reference base for distributing the values does not fulfill 

your requirements. If this is the case, you can use calculated values as the reference base. 



 

WHATSAPP +255738656506 

 

 Calculated Values as Reference for Top-Down Distribution 

In this activity, you define a key figure (a formula based on value fields) for use as the reference values 

for distributing planning data or actual data using top-down distribution. 

Example 

You defined a key figure "Net revenue = Revenue - Discounts" and enter this as the reference value in 

top-down distribution. The system distributes the data in proportion to the net revenue according to the 

reference data of the profitability segments at the lowest level. 

Activities 

Define the desired key figures 

If you want to use the key figure as the tracing factor in automatic top-down planning, select the key 

figure in the parameter set under Reference value field. 

If you want to use the key figure for top-down manual planning, you need to assign it to the value fields 

you want to use it for. You do this in Customizing. 

If you want to use the key figure as a tracing factor for actual top-down planning, select the option "Fixed 

value field" under "Tracing factor" when you execute it and enter the key figure in the field "Value 

field". 

 Activate Profitability Analysis 

In this step you activate the interfaces to Profitability Analysis for the controlling areas assigned to your 

operating concern. 

The "Active" indicator has the following values: 

Value Meaning 

_ Profitability Analysis is not active 

Only costing-based Profitability Analysis is active 

Only account-based Profitability Analysis is active 

Costing-based and account-based Profitability Analysis are active 

Note that if you select "2" or "3", only one form of CO-PA will be updated with data. 

By specifying a fiscal year you can determine the year beginning with which Profitability Analysis is 

active. 

Once Profitability Analysis is active, you can transfer the following actual postings to profitability 

segments: 

Automatic transfer of billing document data from SD 

Direct postings from Financial Accounting ( FI ) 

Settlement of orders and projects 

Period-based allocations, such as the transfer of overhead 



 

 

Invoice receipt postings from Materials Management 

When you activate CO-PA, you can make the following plan postings: 

Period-based allocations, such as the transfer of planned overhead 

1. Settlement of planning data from orders and projects 

You can activate the automatic transfer of sales orders from SD to CO-PA in the activity 

Actual Flows of Values -> Transfer Incoming Sales Orders -> Activate Transfer of Incoming 
Sales Orders. You must activate this separately for each controlling area assigned to your operating 

concern in order that the data in Profitability Analysis can be updated. 

Note that when you carry out the activities "Activate Profitability Analysis" and "Activate Transfer of 

Incoming Sales Orders", you are processing the same table. Consequently, if you delete an entry on one 

of these screens, it is effectively deleted for both. 

Prerequisites 

In the SAP Reference IMG under Enterprise Structure -> Assignment -> Controlling, you need to 

have assigned a controlling area to the operating concern. 

Activities 

Activate Profitability Analysis. 

 Information System 

Here you make the basic settings for creating and executing profitability reports. This includes the 

following steps: 

Create the individual components of reports 

Create reports 

Store report data 

Define a report tree 

Define authorization objects for the information system 

Reorganize your information system 

Notes on transporting 

You can transport the settings you made to your productive system using the CO-PA transport tool. 

Note that the generated ABAP Repository objects are valid for all clients. Conflicting names in the target 

system can also lead to problems in other applications. Therefore you should make all Customizing 

settings in one (source) system. You can then transport these settings to your other (target) systems. This 

technique helps you avoid inconsistencies. 

If you cannot use this technique for some reason, be sure to observe the following: 

Characteristics and value fields with the same name must have the same text, the same attributes (type, 

length), the same check table and the same origin table in each system. 
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For characteristics which were defined manually, enter the number for the check table manually as well. 

Each characteristic must have the same number in all systems. The assignment of the number to the 

characteristic must be unique. 

 Report Components 

In this section, you define the components that you want to use in your information system reports. These 

components can be used in more than one report definition. 

The report components that you can create here are: 

Key figure schemes 

Variables 

Forms 

Characteristic groups 

Hierarchies 

Note 

For detailed information on the various report components, see 

The CO-PA documentation or 

The cross-application documentation on drilldown reporting 

 Define Key Figure Schemes 

In this activity, you define the key figure schemes you want to use in the information system. In a key 

figure scheme, you can define any number of interrelated key figures, referred to as elements of the key 

figure scheme. 

Activities 

To create a new element of a key figure scheme, choose New entries. Enter a number between 1 and 

8999 and a suitable text. If you wish, you can also enter special display parameters. 

You can use two functions to define the content of a key figure: 

To define an element that simply represents the addition and subtraction of different values, choose 

Basic formula. The system displays a list of all the elements to be added or subtracted to 

define that element. Choose Choose entries and select all the value fields that you want to use 

in the element. This formula will then become available when you define the next element of 

the scheme, and will therefore appear in the list of elements under Choose entries. 

If you want to define a more complex formula, choose Formula editor. Here you can link 

constants and any elements of the scheme using standard mathematical operators (+, -, *, /) as 

well as your own ABAP functions. For a detailed description of the functions available in the 

formula editor, see the section "Information System" in the online documentation for 

Profitability Analysis. 

Using the function Check key figure scheme, you can check all the elements of the scheme for 

syntactical errors. 



 

 

Using the function Overview list, you can obtain an overview of all the formulas in a key figure scheme. 

The status of the individual formulas - no error, warning, or error - is indicated by the colors green, 

yellow and red respectively. You can also print a key figure scheme from the overview list. 

 Define Variables for Reports 

In this activity, you can define variables for your information system. 

Variables allow you more flexibility in defining your forms and reports. Variables are the parameters in a 

report which you do not specify until you create or execute the report. The user specifies these 

parameters by filling the appropriate fields. 

If you do not wish to define variables globally, you can define them directly as local variables in the form 

or in the report. 

Activities 

To define new variables, enter the variable type and a name. The variable type determines whether you 

can use the variable as a 

Variable for a characteristic value 

Variable for a node of a hierarchy 

Variable for a text 

Variable for a formula 

Variable for a hierarchy 

The system displays the fields you need to fill when you press enter. 

The where-used list function tells you which are the forms and reports where a global variable is used. 

Further notes 

For more detailed information on how to work with variables, see the online documentation "Drilldown 

Reporting", which you can access from the SAP Library. 

 Define Characteristic Groups for the Information System 

In this activity you can create groups of characteristics which you want to use in your information 

system. 

A characteristic group can be any combination of characteristics from one operating concern. You can 

use a characteristic group when you define a report to reduce the number of characteristics available for 

selection. 

Actions 

Create the characteristic groups you want to use in the information system. 

Note 
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These characteristic groups are not the same as those created under "Master data". Those characteristic 

groups serve a different purpose. 

Further notes 

For more detailed information on how to work with characteristic groups, see the CO-PA online manual. 

 Define Characteristics Hierarchy 

You can define hierarchical structures for characteristics in Profitability Analysis (CO-PA) and analyze 

these structures later in the information system. This means you can, for example, structure your 

products or customers in a hierarchy. 

Each characteristic value contained in the hierarchy represents a hierarchy node. Further to the 

characteristic values contained in the master data, you can add "non-chargeable nodes" to the structure. 

Note that different characteristics that use the same master data table are grouped in the same 

characteristics hierarchy. It is not possible to define external hierarchies for characteristics that do not 

have a check table or text table. 

Note that only the characteristic values for one characteristic are grouped hierarchically for each 

hierarchy. In addition, each characteristic value can occur only once in the hierarchy. Thus each value is 

unique within the entire hierarchy. 

You can define alternative hierarchies for the same characteristic in order to simulate different ways of 

grouping the characteristic values. These alternative hierarchies are stored as hierarchy variants. You can 

define up to 999 different variants for each characteristic. 

Activities 

Creating a characteristic hierarchy 

Enter the name of the characteristic for which you want to define the hierarchy. Also, enter a number 

between 1 and 999 for the hierarchy variant. 

If you enter a characteristic that has the same data element and domain as another characteristic, the 

hierarchy applies for both characteristics, since both have the same characteristic values. A list of 

the characteristics involved is displayed in the lower part of the screen. 

Choose "Hierarchy -> Create". 

The next screen contains information about the hierarchy. 

Enter a description for the hierarchy and, if desired, select the "Visible system-wide" indicator. 

If you select this field, this variant will be active for all applications where you can maintain master 

data hierarchies. If you do not select it, the variant will only be available in EC-EIS. 

Choose "Goto -> Back". 

Then add the nodes to the hierarchy. 



 

 

Position the cursor on a node and press F4 to display the valid characteristic values to which data 

can be posted. Choose the desired value or any existing node that cannot receive postings. 

If you enter data for a nonchargeable node, this data is transferred to a table. To access this table, 

choose Goto -> Maintain nonchargeable nodes. 

Once you have added the desired characteristic values, save the hierarchy. 

Each characteristic value can only occur once in the hierarchy variant. If a characteristic value already 

occurs in the hierarchy, it no longer appears in the list of possible entries. To add new nodes, you can use 

the following functions: 

"Edit -> Create entry -> Same level" 

This function inserts a blank node at the same level as the selected node. 

"Edit -> Create entry -> One level lower" This function inserts a new node 

at the next level down. 

"Edit -> Create sev. entries -> Same level" This function inserts several 

blank nodes at the same level. 

"Edit -> Create sev. entries -> One level lower" This function inserts 

several blank nodes at the next level down. 

"Edit -> Create range -> Same level" 

"Edit -> Create range -> One level lower" 

These functions let you enter a range, such as "characteristic value X through characteristic value 

Z". 

Changing, displaying, copying, and deleting characteristics hierarchies 

The functions for changing, displaying, copying, and deleting master data hierarchies work the same way 

as the function for creating them. 

You can use an existing hierarchy as the basis for creating a new hierarchy variant by copying the 

existing variant and then changing it. 

When you change a hierarchy, you can add new nodes and remove existing nodes, as well as cut and 

paste existing parts of the hierarchy. When deleting a node, ensure that all dependent entries are deleted 

as well. 

You can search for specific values in the hierarchy by choosing Edit -> Find -> Characteristic value. It 

is also possible to see the relationships between the different nodes by positioning the cursor on a node 

and then searching for the parent, child, and so on. You can expand and collapse branches of the 

hierarchy by clicking on the plus and minus signs. This makes it easier to find your way around in the 

hierarchy. 

You can delete any hierarchy variants that you no longer need from the initial screen of this transaction. 

 Assign Cost Element Hierarchy for Account-Based CO-PA 

The purpose of assigning a hierarchy is to be able to display the cost elements in hierarchical form in a 

Profitability Analysis report. This function is only possible in account-based CO-PA reports. 

 Assign Display Attributes 

In this IMG activity, you can assign additional display attributes to characteristics. These attributes allow 

you to display additional information from the master data tables in your reports. 
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Example 

In a report that contains the characteristic "Customer" you want to be able to see not only the customer 

name and key, but also the city. To do this, you need to assign the attribute "City" to the characteristic 

"Customer". 

Standard settings 

A few sample attributes are contained in the standard system. 

Activities 

Enter the field name of the desired characteristic. 

Specify where in the attribute list you want the display attribute to appear. 

Enter the attribute name and the table of origin of the attribute. The attribute name must correspond to 

that in the table of origin. 

Save the attribute. After this point the attribute is available for your reports. 

Further notes 

The assignment of display attributes to characteristics is valid in all clients. 

 Define Headers and Footers for Basic Reports 

In this activity you can define headers and footers for your basic reports. You can use these headers and 

footers in any basic report you create. 

You can change the headers and footers you define here when you define your report as well as on the 

report list ("Print setup -> Drilldown + detail -> Maintain header/footer"). 

You can also activate or deactivate the header and footer separately for each report. This function is 

found under "Print setup -> Drilldown + detail -> Header/footer on/off" in the report definition or under 

"Settings -> Header/footer on/off" from the report list. 

Actions 

Define your report headers and footers. 

 Define Forms 

In this activity, you define the forms you want to use in your information system for designing reports. 

You can create forms for profitability reports or for reports based on line items. The report types - and 

correspondingly the forms - are defined in the same way; the data that you call up, on the other hand, is 

not the same. This is why the number of characteristics available for use in the definition varies. 

A form represents the content and structure of the report. It can generally be seen as a semi-finished 

report definition that you can build upon. You specify lines, columns, and the form header by means of 



 

 

characteristics or value fields that are to appear in several reports. In this way, a form can be used 

repeatedly for different reports. 

Activities 

Specify which forms you need and create them. 

You can use the function Extras -> Overview to display information for the General Selections, 

columns, lines, and so on, of a form. 

Requirements 

You need to have already fully defined an operating concern in which to create the form. 

If you want to include global variables in the report, you need to define these first. 

Further notes 

For more information on defining forms, see the documentation for Profitability Analysis or Drilldown 

Reporting. 

 Define Forms for Profitability Reports 

In this activity, you define the forms that you want to use when designing your profitability reports. 

Further notes 

For more information, see the section Define Forms. 

 Define Forms for Reports Based on Line Items 

In this activity, you can define special forms for reports based on line items. 

Further notes 

For more information, see the section Define Forms. 

 Create Profitability Report 

In this activity, you can create your own profitability reports as well as display and change existing ones. 

The following describes how to go about creating a new report. 

There are two types of report you can define here - basic reports and form reports. A basic report displays 

the characteristics and value fields you specify using a standard layout. This type of report is best suited 

to searching for trends in data classified by various characteristics. Form reports, on the other hand, allow 

you to display the characteristics and key figures according to your requirements. This type of report is 

based on a form that you define yourself. 

Activities 
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Decide which type of report you would like to create. 

From the available characteristics, select those that you want to analyze in a report. Use the arrow button 

to add them to the "selected characteristics" area. If needed, you can maintain additional settings, 

such as hierarchies, variables or characteristic values. You can reduce the number of characteristics 

offered on the selection screen using characteristic groups. 

Select the key figures you want to analyze. You can choose from the value fields of your operating 

concern and any key figures defined in a specified key figure scheme. 

If needed, you can specify limitation values for the variables defined for the report. Select "Enter at 

execution" if you want your users to be able to enter or replace these values when they execute the 

report. 

Selection the output type to be used to display the report. 

By using the "graphical report-output", you can obtain a report consisting of several information 

areas: the header and navigation area, the graphics area, and the drilldown and detail list. You 

can use an HTML template to include individual graphics as the report header. With this 

output type, functions such as navigation and switching drilldown are performed via the "drag 

and drop" function. Select the desired output areas and an HTML template. 

If you select the output type "classic drilldown", your reports continue to be presented as a 

drilldown list. 

By selecting the "object list", you can use the ABAP List Viewer to display a 

report.This is of particular use if you want to display several characteristics in the lead 

column. 

If you select the output type "XXL (spreadsheet)", you can display your reports in Microsoft Excel. 

Under "Options", you can find settings for the print layout and performance settings for report execution, 

such as whether the system should display the current data or the data from the last summarization 

level update (see also the F1 Help on performance). 

By setting the "inSight" indicator, you can use inSight to call up the current report. 

Note: Not all of the above steps may be possible or necessary in all instances. 

Requirements 

If you want to use forms, characteristic groups, variables, or key figure groups, you need to define these 

first. 

Further notes 

For more information, see the sections Creating Reports in the online documentation for CO-PA and in 

the cross-application documentation for drilldown reporting. 

 Create Reports Based on Line Items 

In this activity, you can create reports based on line items, or change or display existing reports. The 

following description tells you how to create a new report. 

There are two types of report you can define here - basic reports and form reports. A basic report displays 

the characteristics and value fields you specify using a standard layout. This type of report is best suited 

to searching for trends in data classified by various characteristics. Form reports, on the other hand, allow 



 

 

you to display the characteristics and key figures according to your requirements. This type of report is 

based on a form that you define yourself. 

Activities 

Decide whether you would like to define a basic report or a form report. 

Select from the "available characteristics" those that you want to analyze and use the arrow button to 

move them to the "selected characteristics" area. You can also maintain further settings, such as 

hierarchies, variables, or characteristic values. You can reduce the number of characteristics offered 

on the selection screen using characteristic groups. Note: When you define reports based on line 

items, you can use the following characteristics: 

All the characteristics in the segment level, plus those excluded from the segment level 

characteristics 

The creation date of the line item 

The name of the person who created the line item 

Select the key figures you want to analyze. You can choose from the value fields of your operating 

concern and any key figures defined in one key figure scheme. 

If required, specify restricting values for the variables defined for the report. Select "Enter at execution" 

if you want your users to be able to enter or replace these variables when they execute the report. 

Select the output type that you want to use to display the report: 

If you select "graphic report output", the report may consist of several information areas (header 

and navigation area, graphic area, drilldown, and details list). You can use an HTML template 

to include individual graphics in the report header. For this output type, you can use the Drag 

and Drop facility for functions such as navigation and drilldown switch. 

Select the desired output type and an HTML template. 

If you select the output type "classic drilldown", your reports are are displayed as drilldown lists. 

The "object list" enables you to display reports using the ABAP List Viewer. This is a particularly 

useful output type if you want to display several characteristics in the lead column. 

If you select the output type "XXL (spreadsheet)", you can display reports in Microsoft Excel. 

6. Among the settings under "Options", you find the print layout settings and the performance settings 

for executing a report. When specifying the latter, you need to decide whether current data should 

be read or whether the system should read the data from the last time the summarization level was 

built up (see also the F1 help on performance). You use the "inSight" indicator to enable the current 

report to be called up via inSight. 

Note: Not all of the above steps may be possible or necessary in all instances, depending on the report 

and the form concerned. These steps then dealt with during form definition. 

Requirements 

If you want to use forms, you need to define special forms for reports based on line items. 

If you want to use characteristic groups, variables, or key figure schemes, you need to define these first 

(see report components). 

Further notes 
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You define reports based on line items the same way you define profitability reports. For more 

information, see the sections Creating Reports in the online documentation for CO-PA and in the cross-

application documentation for drilldown reporting. 

 Background Processing 

This section tells you how to execute reports and save the data as frozen report data or summarization 

data at specified times. Here you can also read about how to print reports using variants and variant 

groups. You can both print reports and update report data in the background at specified points in time. 

This section consists of the following steps: 

Maintain variants 

Define variant groups 

Maintain variant groups 

Schedule variant groups for background processing 

Note: Variants and variant groups replace the variable groups and program RKEBATCH, which were 

used in previous releases. For details about converting to the new method, see the release note. 

 Maintain Variants 

You execute reports in the background using selection variants. 

For a report, the variable entries and the settings for rebuilding summarization data, creating frozen 

report data and printing can be saved in ABAP variants. 

The option to rebuild summarization data is only displayed if summarization data has been activated in 

the definition of the report. 

For printing, the setting in the "Read mode" field determines how current the printed data is. 

If you choose "Reselect", data is printed according to the settings made in the "Performance" dialog box 

in the report definition. If you did not activate the option "Current data" in the report definition, the 

system prints the most recently summarized data. 

If you select "Frozen data", the system prints the frozen report data, if any exists. Otherwise, a message is 

issued. 

Activities 

Define the variants you would like to use in your reports. 

Once you have made your entries, choose "Goto -> Variants -> Save as variant..." (see also the online 

documentation "BC Computing Center Management System"). You can then schedule this variant in the 

background. If you need to schedule more than one report for background processing using variants, you 

can group these variants together in a so-called "variant group" (see the following Customizing 

activities). 



 

 

 Define Variant Groups 

In the background, reports are processed using selection variants. 

Several variants can be grouped together in a variant group. 

Using variant groups, you can 

schedule several variants for one report 

(different combinations of characteristic 

values for one report) 

schedule variants for several reports in one 

step. 

Activities 

Define the variant group that you want to use. 

 Maintain Variant Groups 

Different variants of several reports can be grouped together in one variant group. 

Activities 

Enter the reports and variant which are to be scheduled for this variant group. 

 Schedule Variant Groups 

The entire variant group can now be scheduled for background processing. 

Activities 

Enter the variant group you want to schedule in the background. You can limit the reports for which the 

variant group should be executed by specifying report names. 

The job is scheduled in the background for the variant group and the specified reports. You can execute 

this job in regular intervals at specific times. For more information about this, see the online 

documentation "BC Computing Center Management System". 
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 Assign Reports/Report Selection to Role 

In this activity, you can assign individual reports to a role. 

Activities 

To assign reports to a role, proceed as follows: 

Choose the "Role" pushbutton. 

Create a new role. Alternatively, you can enter one that already exists and then choose "Change". 

In the "Menu" tab page, select the "Report" button. Then select the type of report, the appropriate 

application class and the desired report. You can use the report type to assign reports of different 

types (such as "Report Writer" reports or drilldown reports). 

Further notes 

The create and change functions are no longer supported for report trees. In future, reports are to be 

assigned to roles as an alternative method to the use of user-defined report trees. 

If necessary, you can choose to convert previously-used report trees into an area menu. To do this, start 

the transaction "RTTREE_MIGRATION". (for more information, see the program documentation 

relating to this subject). You can then assign the area menu generated from the report tree to a role and 

thereby make it accessible to users. 

 Currency Translation 

In this section you define the currency translation types which you want to use to translate the currencies 

of value columns in drilldown reporting. 

 Define Currency Translation Keys 

When you execute a drilldown report, you can display value columns in another currency using the 

function Settings -> Currency. In this step, you maintain the currency translation keys to be used for 

translating value columns. These translation keys are valid for all operating concerns and therefore can 

be used for all reports in Profitability Analysis. 

Activities 

Define your currency translation keys by carrying out the following: 

Enter a descriptive text 

Specify the currency translation key (historic rate, average rate, and so on). 

Specify whether the target currency should be fixed or variable. Your choice will influence the next 

screen in the following way: 



 

 

If the target currency is to be fixed, the next screen will present you with the possibility of entering 

a fixed target currency. However, it is recommended to leave this field empty in most cases. In 

drilldown reporting, you usually wish to use the same currency translation key to calculate 

currency-independent values. This means that only currency translation keys without a 

specified target currency are appropriate. 

If you opt for variable at this stage, the next screen will allow you to set up a link to a characteristic 

by entering a table name and a field name. If, for example, you would like the target currency 

to be selected depending on the country, specify the table with the country data (T005) and the 

field for the country key (LAND1). To do so, the country key must be defined as a 

characteristic in the operating concern. 

Specify whether the currency translation key should use a fixed or a variable translation date. 

The query appearing on a further screen will depend on your selection at this stage. 

A fixed translation date is either a prespecified date or the day on which you execute the program. 

The date fixed here, together with the exchange rate type, determines the rate used later for the 

currency translation. 

For variable translation dates, the date selected in the information system (period or fiscal year) 

determines the rate for each data record. Here you need to specify the time reference 

(beginning of period or end of year, for example). This enables you to translate each record 

with the rate that was valid at the beginning of the corresponding period. 

Note that, with variable translation, all columns linked arithmetically to the column to be 

translated are automatically translated as well. 

Note: You cannot create a date field as a characteristic in Profitability Analysis. Consequently, 

the option "Time base to the day" is not available here. 

Specify whether the rate is an inverse exchange rate. 

A translation key with an inverse rate is useful when the amounts have already been converted and 

need to be returned to the original values. 

Save your currency translation keys. 

Example of a currency translation key with inverse exchange rate 

You have maintained the following rates: 

DEM     USD      

USD     DEM     03 

When translating from USD to DEM with an inverse rate, the system uses the rate 1/ = 025 instead of 03. 

Further notes 

The column "Specific translation key" is not used in Profitability Analysis. 

The translation keys do not affect currency translation during actual data transfers. 

 Reorganization and Conversions 

These functions let you 

Reorganize objects in your information system, such as 

Report data 



 

WHATSAPP +255738656506 

 

Reports 

Forms 

Line item layouts 

Variant groups 

Convert your reports for compatibility with the current release. 

 Reorganize Report Data 

In this activity you can select frozen report data to obtain an overview list and then delete sets of data 

individually from that list. 

Before the deletion is actually carried out, a selection screen appears in which you must select the objects 

to be deleted. 

Currently you can specify the fiscal year, period and period/year to select the report data. This 

combination lets you delete individual data records for reports which are run on a periodic basis. This 

helps prevent an overflow in the memory table. 

Example 

Before you go productive with Profitability Analysis, you can delete the data for the test reports in your 

operating concern. 

You can also delete the report data by report name, author and date created. 

Action 

Reorganize your report data. 

 Reorganize Reports 

Here you can select a list of reports according to a number of parameters and then delete individual 

reports from this list. 

Before actually deleting the reports, the system displays a dialog box in which you must confirm your 

selection. 

Example 

You can delete all the test reports created by a certain user before you go productive with CO-PA. 

Actions 

Reorganize your reports. 



 

 

 Reorganize Forms 

Here you can select a list of forms based on certain parameters and then delete individual forms from 

that list. Before actually deleting, the system displays a dialog box in which you must confirm your 

selection. 

Example 

You can delete all the forms with one axis and key figures which were created on a specific date. 

Note 

You can only reorganize those forms which are not being used in any report. The system automatically 

checks this before deleting any forms, and at the same time calls up and checks the individual reports. 

Actions 

Reorganize your forms. 

 Reorganize Forms for Reports Based on Line Items 

In this activity, you can specify a number of forms for reports based on line items and then delete these. 

Before deleting the forms, the system displays a second selection screen where you have to repeat your 

entries. 

 Reorganize Line Item Layouts 

Here you can select a list of line item layouts according to certain parameters and then delete layouts 

individually from this list. Before actually deleting the layouts, the system displays a dialog box in which 

you must confirm your selection. 

Example 

You can delete all the line item layouts in your operating concern before going productive with CO-PA. 

Actions 

Reorganize your line item layouts. 

 Reorganize Variant Groups 

In this activity, you can select variant groups from which any variants that no longer exist should be 

deleted automatically. 

Before actually deleting the variants, the system displays a second selection screen in which you have to 

select the objects to be deleted. 
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 Convert Reports 

This function converts the reports which you created in an earlier release. 

This is usually necessary when you move up to the new release, or possibly also when you import a new 

update level. The system will display a message in the information system if you need to convert your 

reports. 

The system deletes all saved report data when converting the reports. This includes both the frozen data 

and the summarization data. 

Note 

If you do not carry out this function now, the system will automatically convert each report the 

first time you try to change or execute them. 

Actions 

Convert your reports. 

 Generation: Virtual InfoProvider 

Use 

In this activity, you can generate Virtual InfoProviders on the basis of an operating concern. 

Using a Virtual InfoProvider enables you to perform queries in your ERP system for CO-PA data by 

deploying the embedded BW functions already available (as opposed to needing to have previously 

extracted them into a BI system). Consequently, you can use for your CO-PA data analysis not only the 

classic CO-PA drilldown but also all SAP Business Objects BI clients, BEx tools, and other BI clients 

that are certified on the MDX interface for BW. 

 Tools 

This section contains a variety of tools. 

 Summarization Levels 

In this activity, you define summarization levels that allow you to considerably improve system 

performance when calling up data stored in Profitability Analysis. 

You can have the system suggest coherent summarization levels and then use these directly, or you can 

define your own levels manually in the activity Defining Summarization Levels. 



 

 

 Have Proposal Created Automatically 

This function helps you to create useful summarization levels. It logs and analyzes the callup of CO-PA 

transaction data, such as report calls. The system then uses this information to suggest summarization 

levels that optimize all callups. 

To activate/deactivate the logging function for an operating concern in one of the types of Profitability 

Analysis (costing-based or account-based), you can use the Log setting pushbutton. 

There are two kinds of proposal: 

An "enhancement" proposal that considers existing levels 

A "replacement" proposal that does not consider existing levels 

Output 

The system displays an overview of the suggested summarization levels and the characteristics they 

contain. The levels are built upon one another and are arranged so that the first level is the one that 

produces the best optimization for callups. If you do not wish to use all the suggested levels, you should 

delete the last in the list but never the first. The proposal ceases to make sense if the first level is deleted. 

You can create the levels directly from the overview. 

Requirements 

To guarantee that appropriate summarization levels are put forward for the way in which they are to be 

used productively, the user behavior to serve as the typical sample should be genuine. In other words, 

you need to perform this function in a productiv operating concern where genuine reports have already 

been carried out. The log data in the test system is generally not representative of user behavior in the 

productive system. 

Activities 

Specify which type of proposal is to be created and what period should be considered in order to analyze 

user behavior (that is, the way transaction data is called up). You should specify a period in which 

all relevant reports have been executed. 

Carry out the function in the background. Then display the result afterwards using the pushbutton 

Display last proposal. 

From the proposal display, you can create the suggested summarization levels directly by using Create 

levels. 

Before these summarization can be accessed (such as when reports are called up), you need to fill the 

levels with data. You do this in the CO-PA menu by choosing Tools -> Summarization levels -> 

Update and then by selecting the option Build new levels. 

When you have created the summarization levels suggested by a replacement proposal, you should then 

delete the old summarization levels. You do this in Customizing by choosing Define Summarization 

Levels. 

Further notes 
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If the enhancement proposal does not suggest any new levels, and it still takes too long to execute a 

report, you should change your reports. 

 Define Summarization Levels 

Maintain summarization levels 

In this activity you define summarization levels. 

For a general overview on summarization levels, see the corresponding chapter in the CO-PA online 

manual. The following text describes how you maintain summarization levels. To learn how to define 

them for a specific use, see the examples. 

Navigation functions 

When you call up the transaction for maintaining summarization levels, the system displays a view 

containing all the existing levels. You can navigate in the following manners: 

In the navigation area at the top of the screen, you can call up: 

the characteristics (here you define which characteristics should be summarized and which not) 

and the indexes (to fine-tune the way the system accesses the summarization levels) 

The function "Detail" (magnifying glass icon or double-click) displays statistical information. 

Under the menu "Extras" you can access an overview list of fields in all of the ( selected ) summarization 

levels. 

Recommendation 

Use fixed values sparingly for the characteristics. If, for example, you define a summarization 

level which contains the data for one company code only, you can only use it when you are working in 

that company code. 

At first you do not need to define any indexes. Indexes let you fine-tune how the system accesses the 

summarization levels. If you do not define any indexes here, the system will create a default when you 

save. This default should be sufficient in most cases. You should not need to change this until your 

summarization levels contain a large amount of data in the key table. 

Initial screen 

The system displays a list of all the existing summarization levels, their descriptive texts, and their 

current status. The status of a level tells you whether the level can be used in your application. Only 

those summarization levels can be used which have the status "active". 

Technically you can create up to 5000 summarization levels. However, you should try to get by with as 

few levels as possible, since increasing the number of levels increases the amount of memory space 

required and the amount of time needed to build them. You can create additional levels later as required. 

You can also delete the ones you no longer need. 

The function "Save" is only available on the initial screen. When you save, the system creates tables in 

the ABAP/4 Dictionary and in the database for each summarization level. If you have deleted levels, the 

system deletes the corresponding tables. If you change the fields or the indexes in the summarization 

level, the system deletes the tables and then recreates them. 



 

 

Once you have saved the summarization levels, you need to run the program for building the levels, that 

is, supplying them with data. Until you have done so, you cannot use the summarization levels in your 

applications. 

Characteristics 

In the characteristic list for the summarization level, choose which characteristics you want to summarize 

and which not. If you change the characteristics, the system deletes all the data in the level. For more 

information, see characteristic value in the summarization level catalog. 

Indexes 

Indexes let you optimize the way the system accesses the summarization levels. 

At first you do not need to define any indexes. When you save the levels, the system creates a default, 

which should be sufficient in most cases. It only makes sense to create indexes when the data in the key 

table reaches a volume of several thousand records (see detail screen). 

Maintain the characteristics before you define indexes. 

Detail screen 

By double-clicking on a level or clicking on the "Detail" pushbutton, you obtain the detail screen for the 

summarization level. The detail screen contains various statistical information, including how often the 

level has been accessed or how many records it contains. This data tells you how often the level is used 

and how high the degree of summarization is. 

Menu "Extras" 

The menu "Extras" contains the following additional functions: 

Overview list 

This function gives you an overview of the existing levels. This list makes it possible to compare 

the levels side by side, which helps you decide whether or not you can delete certain levels or 

whether you need to create new ones. 

Test mode 

Here you can deactivate all the summarization levels for test purposes, in order to compare the data 

in the levels with the data in the segment level. Run a function once with the test mode and once 

without. In both cases, the same data must appear. The summarization levels retain the status 

"active" even when you are in the test mode, and can still be updated. However, they are not used in 

applications. Be sure to turn the levels on again after you have finished testing. 

Create proposal 

Here you can have the system automatically propose summarization levels for one or more reports. 

First enter a number for the summarization level. If you want to create more than one proposal, the 

system assigns numbers sequentially starting with the number you entered. Existing numbers are 

not overwritten. 

Next, select the desired reports and save the summarization levels. 

Finally, choose "Tools -> Summarization levels" from the application menu and build the new 

levels. 

Note: With the function "Create proposal", it is theoretically possible to create a summarization 

level that already exists. You therefore should check the overview list first to see if the level already 

exists. If so, do not save the level. 

Tips on optimizing the summarization levels 
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The detail screen for a summarization level gives you some informational statistics that can help you 

decide whether your levels are being put to good use or whether they can be deleted. 

The overview list lets you compare the definition of characteristics in your levels. 

Level is contained in another level. 

By comparing how often the levels are used, you can decide whether you need both levels. If the 

number of records in the levels does not differ greatly, you can delete the one which is summarized 

to a higher degree to save memory space. 

Level is not used. 

If a level is not used or hardly used, you can delete it. 

Level not in status "active". 

If the status is "To be created", save the level. If it has the status "active, without data", build the 

level. If the level has the status "decimal overflow", the level can no longer be used. It may be that 

the overflow no longer occurs when you rebuild it, otherwise delete the level. 

Long read times. 

The detail screen shows the aggregated time needed to read the level and how often it was read. If 

the average is much longer than with other levels, this may indicate that there are no indexes. 

Another reason could be that a report uses a level which is more detailed than is actually necessary. 

In this case you should consider whether you can create a special level to improve performance for 

that report. 

Notes on transporting 

You can transport the settings you make to your productive system using the CO-PA transport tool. 

The system only transports the description of the summarization levels. Once you have transported the 

levels, you need to call up the maintenance transaction for summarization levels once and press "Save" to 

create the corresponding tables. 

As an alternative to this, you can execute program RKETREGN. On the initial screen, enter the 

following (replacing "xxxx" with the name of your operating concern): 

Application class      KE 

Subclass               01 

Table name             CE1xxxx (for costing-based CO-PA) 

                       CE0xxxx (for account-based CO-PA) 

Additional information 

Building the summarization levels 

Examples for defining summarization levels 



 

 

 SAP HANA Integration 

 Set Up SAP HANA Integration 

Use 

In this IMG activity, you make the settings for the integration of Profitability Analysis (CO-PA) with 

SAP HANA. You can activate the integration (CO-PA Accelerator) for individual operating concerns. 

Requirements 

You have entered a connection to the SAP HANA database. Use the transaction Display Description of 

Database Connections (transaction DBCO) to enter a new database connection. 

Activities 

Choose Acceleration Activated if you want the CO-PA integration to be activated for the 

specified operating concern. 

Basic Settings 

On the Basic Settings tab page, specify the following parameters for the CO-PA integration: -

 Under DB Connection Name, specify a connection to the SAP HANA database. 

Choose Include Realignments if you want to include the realignment process in the data transfer 

to the SAP HANA database. 

For system behavior when no SAP HANA system is used, choose one of the following options for 

dialog processing or background processing: 

Ignore; The system reads data from SAP ERP, and no system message is issued. 

Issue Warning (only with dialog processing); some users can control in a query whether the 

system terminates the program or whether the data is read from SAP ERP. 

Issue Error Message; Processing is terminated and an error message is issued - Specify the 

type of replication as follows: 

Choose Using CO-PA Program if you want to use the program in the system to transfer data to 

the SAP HANA database. Specify a safety buffer in seconds. The default setting is 1,800 

seconds. 

Choose Alternative if you want to use an alternative method for transferring data and specify a 

safety buffer in seconds for each dataset to be read. 

Choose Read Line Items from SAP ERP if you additionally want to read data from SAP ERP 

that has not yet been transferred to the SAP HANA database. If you do not choose this option, 

the system processes only the data since the last replication. 

Read Access 

On the Read Access tab page, you can adapt according to your needs the following default settings for 

reading data from the SAP HANA database: 

Under Control HANA Read Access, restrict the authorization of users or applications to read data 

from the SAP HANA database. 
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In the Expert Settings area, you can change the default setting under Access Type if required as 

follows: 

Remove the selection Column Views if you want to read data directly from the CO-PA tables that 

have been transferred to the database. In this way, you can also access the data when using an 

alternative replication type that does not provide any SAP HANA views for selecting and 

reading data. 

Choose Native SQL or Open SQL if you want to read data directly from the CO-PA tables that 

have been transferred to the database. 

You can reduce the default package size for read access of 0,000 if there are any problems 

saving data when reading line items. 

Status 

On the Status tab page, you can check the status of the processes important to Accelerated CO-PA. CO-

PA is not accelerated for an operating concern until all processes have acquired a green traffic light. 

If there are structural changes, you can generate the SAP HANA views again. For this, choose 

Generate Views. 

The Status tab page also provides information on archiving, on the status of the realignment, and on the 

times of the most recent data transfers to SAP HANA database. 

Example 

You want to integrate with SAP HANA the analysis of operating concern S001 and have entered the 

database connection HDB. To activate the acceleration, select the following options or specify the 

following: 

Acceleration Activated 

HDB for the DB Connection 

Include Realignments 

Ignore errors in dialog processing or background processing 

Using CO-PA Program for the type of replication, with a safety buffer of 1,800 seconds 

Read Also Line Items from SAP ERP 

 Analysis 

In the step "Check Customizing Settings", you can use the Customizing monitor to display the 

following for an operating concern: 

Value field analysis 

Valuation analysis 

Derivation overview 

The where-used list for characteristics and value fields 

An overview of the organizational structures 



 

 

In the step "Simulate Billing Document Transfer", you can simulate the transfer of billing documents 

to CO-PA. 

In the step "Check Flow of Values in Billing Document Transfer, you can compare billing document 

data that has been updated to CO-PA with the corresponding values posted in FI. This allows you to see 

how values have been moved to CO-PA during billing document transfer, to display the differences 

between the two applications, and to analyze these differences. 

 Check Customizing Settings 

In this activity, you can display the customizing settings for an operating concern. A number of functions 

let you analyze the various areas of Customizing: 

You can obtain an overview of the organizational structures for an operating concern. 

The functions Value field analysis, Overview of valuation, and Overview of derivation provide you 

with several options for detailed analysis. 

You can draw up a where-used list for the characteristics and value fields in an operating concern. 

Overview of Organizational Structures 

In the overview of the organizational structures for the operating concern, all assigned organizational 

units are listed and detailed information is displayed from the relevant master data. 

Analysis Options 

Value Field Analysis 

The value field analysis function lets you analyze all the flows of actual data to Profitability Analysis. 

You can find inconsistencies by looking at individual value fields. The report shows you what value 

flows the value field is involved in and what condition types or cost elements it gets its values from. In 

all, you can analyze the following actual value flows: 

Transfer of billing documents and incoming sales orders 

By analyzing the interface with SD, you can answer the following questions: 

Which SD condition types are mapped to which value fields? 

In which pricing procedures are those condition types used? 

Should a condition type be transferred with its +/- sign? 

Is the condition type "statistical"? 

Is the condition type used for reserves? 

Which FI accounts are found by the account keys in the pricing procedure? 

Are these FI accounts defined as cost elements of the category "11" (sales revenues) or "12" (sales 

deductions) in CO? 

Possible causes of errors that are referred to: 

For each G/L account found for the condition types, the system checks whether the corresponding 

CO cost element was defined for the category "11" or "12". If the cost element does not exist 

or was defined for a category other than "11" or "12", the "Type" field is displayed in red 

because that condition type cannot be transferred to CO-PA as it is currently defined. 

This analysis is only carried out for those condition types which are not defined as "statistical" in 

the pricing procedure. Statistical condition types are normally transferred to CO-PA once they 

are assigned to a value field. The only exception to this are condition types which are used for 
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reserves. These lead to postings in FI, even if they are marked as statistical in the pricing 

procedure. Consequently, the system checks the cost element for these condition types, 

provided that a cost element was defined for the corresponding reserves account in FI. 

Reserves are normally regarded as irrelevant for CO and consequently are not defined as cost 

elements in CO. In that case, the value field analysis ignores the account key of the reserves 

account. 

If the current Customizing setting calls for a condition type to be transferred with its +/- sign, the 

system displays a warning, because this setting should only be made in rare instances (such as 

for bonus conditions). 

Customizing: 

It is not possible to simulate the complete logic for determining revenue accounts. The accounts 

shown in the overview are found using the account keys defined in the pricing procedures. These 

account keys are used as selection criteria to read the account determination tables. The system 

selects all the records in those tables that contain the account key. For the system to be able to find 

the relevant accounts, you first need to define the account determination tables that should be 

analyzed before running the analysis. To do so, choose "Settings -> Value field analysis -> Account 

determination tables". You can only use tables that have the field "KVSL" (account key) in their 

key. 

Direct postings from FI and MM 

This option analyzes the customizing settings made in PA transfer structure FI and answers the 

following questions: 

Which cost elements or cost element groups are mapped to each value field? 

Are the fixed and variable costs split? 

Have CO cost elements been defined in PA transfer structure for the accounts found using 

automatic account determination? 

Possible cause of errors that is referred to: 

If both fixed and variable costs are transferred to the same value field in one assignment line, this 

is marked as a possible error. For the accounts found using automatic account determination, the 

system checks whether the corresponding CO cost element is contained in PA transfer structure FI. 

Order and project settlement 

This option analyzes all the PA transfer structures except structures FI and CO, which are treated 

separately. 

The data for order and project settlement is shown just like that for FI and MM direct postings, 

except that there is no information regarding automatic account determination. 

Possible cause of errors: 

If the "Transfer billed/delivered quantity" flag has been selected, there must be a quantity field 

defined for this assignment line, otherwise no quantity is transferred to CO-PA during settlement. 

Direct and indirect activity allocation 

This option gives you information about PA transfer structure CO and displays the information like 

that for order and project settlement. 

Cost center assessment and process assessment 

The option Cost center assessment and process assessment answers the following questions: 

Which cycles and segments populate which value field? 



 

 

Which value fields do fixed and variable costs flow into? 

Is a value field assigned explicitly in the segment, or is a PA transfer structure used instead? 

Note: 

This overview only shows those assignments that are used for assessment. Assignments with a 

source "Variance category" or "accounting indicator" are not displayed. 

External data transfer 

The option External data transfer answers the following questions: 

What data interfaces ("sender structures") contain a given value field? 

To which external field is the CO-PA value field assigned? 

As well as providing an overview of what value flows each value field is involved in, the function 

"Value field view" also offers you the option of creating a where-used list for the assigned value fields. 

Overview of Valuation 

The overview of valuation shows you all the customizing settings for CO-PA valuation. You can use this 

function for the following record types: 

Billing documents ( F ) 

Incoming sales orders ( A ) 

Direct postings from FI and MM ( B ) 

Order and project settlement ( C ) 

User-defined record types 

The analysis is possible for different actual and plan points of valuation. 

Overview of Derivation 

This option displays the following information: 

Characteristic Derivation 

Derivation of Planning Functions: Events 

Derivation of Planning Functions: Revaluation Keys 

Derivation of Planning Functions: Distribution Keys 

Derivation of Planning Functions: Forecast Profiles 

Account Determination for Transferring Plan data to Profit Center Accounting - Template 

determination for Template Allocation. 

Where-used list 

This option provides you with an overview of the occurrences of a characteristic or a value field in CO-

PA Customizing. It is possible to call up the overview for the current client or for all clients in the 

system. By double-clicking in the overview, you can access the corresponding maintenance transaction 

directly, where you can then delete a characteristic or value field, for example. 
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 Valuation Simulation 

In the activity Simulation of Valuation, you can test your Customizing settings for CO-PA valuation. 

With the Analyze valuation function, you can run a detailed analysis of the valuation strategy valid for 

the point of valuation you entered. 

This option should make it easier for you to analyze situations where errors have occurred. 

Performing the simulation causes no data of any kind to be posted in Profitability Analysis. 

 Simulate Billing Document Transfer 

In the activity "Simulating the Transfer of Documents from Billing", you have the option of 

simulating the transfer of billing document data into Profitability Analysis. 

Simulation occurs on the basis of the Customizing settings valid at the time it is carried out. You can 

view the characteristics and value fields of the line item to be written to COPA. 

The function "Valuation analysis" allows you to perform an analysis of the valuation strategy valid for 

valuating billing document data. 

You can also restart the simulation of document transfers for billing documents that have already been 

transferred. This option should simplify in particular the analysis of error situations that have arisen. 

Performing this simulation causes no data to be posted to COPA or to other modules. 

Example 

Requirements 

Standard settings 

Recommendation 

Activities 

Further notes 

 Simulation of Document Transfer from Incoming Sales Orders 

In this activity, you can simulate the transfer of incoming sales to Profitability Analysis. 



 

 

Simulation occurs on the basis of the valid Customizing settings at the time you run the simulation. You 

can display the characteristics and value fields of the line item to be posted to Profitability Analysis. 

The "Valuation Analysis" function allows you to run an analysis of the valuation strategy valid for 

valuating sales order data. 

It is possible to rerun the simulation of document transfer for sales orders that have already been 

transferred. This option should simplify analyzing any error situations that have occurred. 

Carrying out a simulation causes no data of whatever kind to be posted in Profitability Analysis or in any 

of the other modules. 

 Check Value Flow in Billing Document Transfer 

In this activity, you can compare your actual data in Profitability Analysis with the data posted in 

Financial Accounting (FI). This makes it possible to analyze the flow of values from SD billing 

documents to CO-PA, find and analyze any differences between the different applications. 

Billing data is stored by condition types in SD, accounts in FI, and value fields in costing-based CO-PA. 

The reconciliation report yields a list of the balances for value fields, condition types, and profit and loss 

accounts. 

Selection 

You can use a number of selection parameters. Only the company code and the currency type are 

mandatory. However, the more criteria you specify, the quicker the system response time will be. To 

estimate the runtime, it is recommended that you run a number of small runs. 

Error handling 

By specifying an "Error tolerance", you can determine the threshold value for difference between the 

CO-PA value and the SD value. Differences that exceed that threshold are displayed with a red 

background. By selecting a difference, you can display the billing documents that led to the difference. 

From there you can analyze the individual billing documents in detail. 

By specifying a "Number of billing documents with errors", you can limit the number of billing 

documents that should be selected for each error. Making an entry here can significantly reduce the 

response time. 

Activities 

You can carry out this function online or in the background. If you choose background processing, the 

system automatically saves the selected data. You can then analyze that data online later by choosing 

"Display saved data". If you choose online processing, you can manually save the data once it is 

displayed, and can also call up this data again later. 

Only one set of saved data can be stored per user. 



 

WHATSAPP +255738656506 

 

 Check Value Flow from Order/Project Settlement 

In this section, you can compare the actual data (resulting from the settlement of sales order items and 

WBS elements) in Profitability Analysis (CO-PA) and in Financial Accounting ( FI ) with the source 

values in the orders or projects. In this way, you can trace the flow of values settled to CO-PA and FI, 

and analyze the differences between the applications. 

Selection 

You can choose from several selection parameters. Note that fiscal year, operating concern and 

currency type are obligatory selection parameters, whereby "company code currency" and "controlling 

area currency" are the two currency types available. 

You should only choose the controlling area currency if: 

The setting for updating values in the company code currency has not been activated for your operating 

concern or 

Not all of the company codes involved support the same currency as that used in the operating concern 

You can select data by sales order, project or both. All the values stored in the objects you choose are 

summated since no distinction is made between sales orders and projects. 

Even if you only need to make a few required entries, we recommend that you limit the selection as 

much as possible to speed up response times. To gauge how long response times are likely to be, you 

should execute several sample selection runs that you have restricted considerably. 

Activities 

You can run this function online as well as in the background. 

If you choose to run it in the background, the system automatically saves the selected data, and this data 

can then be called up online with the function "Display frozen data". 

If you choose the run it online, you can save the data manually and then call it up again. 

 Check Value Flow from FI 

Use 

In this activity, you can compare at the account level the actual data in Profitability Analysis (CO-PA) 

against the corresponding values posted in Financial Accounting (FI). This enables you to display and 

analyze any discrepancies between FI and CO-PA. 

You use this function to produce a list of the values posted in Accounting (FI values), of the values in the 

original documents, and of the values posted in CO-PA (CO-PA values). In the case of the values of the 



 

 

original documents, the system distinguishes between the document value and the relevant amount 

resulting from it in CO-PA. 

Furthermore, the system displays, on the one hand, the difference between the FI value and the document 

value (FI Doc Delta) and, on the other hand, the difference between the CO-PA-relevant amount of the 

document value and the CO-PA value (PA Doc Delta). If a difference is found, you can drilldown to the 

documents involved. 

In the list output, a distinction is made between the following business transactions: 

FI Documents 

In the case of FI documents that originate in FI or MM, the value posted in FI is compared against the 

value determined using the PA transfer structure FI. The CO-PA-relevant value resulting from the FI 

value is determined using the same sign handling as that applied for transferring FI and MM direct 

assignments in CO-PA. 

Settlement Documents 

In the case of FI documents that have been posted to a CO object (such as an internal order, a sales order 

item, or a WBS element) and possibly settled to CO-PA, the settlement-relevant values on the CO object 

are compared against the values already settled in CO-PA. The "Document Value" column displays the 

amount posted with the FI document to the CO object. The "Of Which PA-Relevant" column displays 

the value that would have been settled in CO-PA using the current Customizing settings. If the CO object 

has a results analysis key, the posted values are not applied to calculate the CO-PA-relevant values; 

instead, the amounts already settled are applied. 

Billing Documents 

In the case of FI documents that originated when billing documents were transferred, the conditions 

determined in SD are compared against the value fields stored in Customizing for CO-PA.  The 

"Document Value" column displays the condition value of the billing documents whereas the "Of Which 

PA-Relevant" column displays the value that would be posted in CO-PA if the billing documents were 

transferred again. The current Customizing settings are applied to calculate the CO-PA-relevant value. 

Other Documents 

In the case of FI documents for which it is not possible to determine (or to determine uniquely) the CO 

account assignment, only the FI value is displayed. 

Displaying Differences 

Differences between the FI value and the document value or between the CO-PA-relevant amount of the 

document value and the CO-PA value are highlighted once the differences exceed the threshold specified 

on the selection screen. If the account assignment object can be assigned uniquely to the corresponding 

FI document, the differences are highlighted in red. If the account assignment cannot be determined 

uniquely due to summarizations, the differences are displayed in grey. (Example: For a billing document 

posting, postings from multiple accounts are made to a CO-PA value field.) 

Selection 

You can use various selection parameters. The following selection parameters are required entry fields: 

company code, fiscal year, period, and G/L account. 

Further restrictions can be made using transaction types, sales orders, billing documents, CO objects, or 

FI documents. 

Summarization 

You can use the following options to define the granularity of the results of the analysis: 
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"CO-PA Business Transaction Only":   The values determined per FI document are summarized by 

business transaction; the values are not displayed at the document level. 

"Only Documents with Delta to CO-PA":  The system summarizes the values of the documents for which 

no delta to CO-PA has been determined. Documents with a delta to CO-PA are displayed 

individually. 

"Only Documents with Delta": The system summarizes the values of the documents for which no delta 

has been determined. Documents with a delta are displayed individually. 

"No Summarization": All documents are displayed individually. 

Activities 

This function can be executed online or in the background. When it is executed in the background, the 

system automatically saves the selected data, and you can call up the data online with the function 

"Display Saved Data". When you execute this function online, you can save the data manually and call it 

up again subsequently. 

 Production Startup 

In this section you will find functions that you may need to execute before you start using Profitability 

Analysis productively. 

 Delete Transaction Data 

In this step, you delete the test data posted to your operating concern before it is set up productively. 

For more detailed information, you should read the program documentation on deleting test data. 



 

 

 Transport 

In this activity, you can create a transport request which lets you transport objects to a target system. 

Once you have made your CO-PA settings, you can collect the objects which are linked to these settings 

(table entries, data elements, domains, tables, and so on) in a transport request. 

With this function, the system collects all the dependent objects in the source system and places them in a 

transport request. After importing the objects to the target system, it automatically activates the necessary 

objects in the ABAP Dictionary (the data structures of the operating concern). 

Requirements 

The source and target systems must be of the same release and update level. 

Activities 

Choose a transport object class. 

Enter a transport request. 

Select the objects you want to transport. 

Select the dependent object classes. 

Transport the transport request using the tools provided for this. 

Recommendation 

With this function you create a transport request based on the current settings. Consequently, no new 

CO-PA objects should be added and no settings changed while the transaction is running. Furthermore, 

you can create a transport request (what you want to transfer) and carry out the actual transfer at different 

points in time. If you change any settings between the time when you create the transport request and 

when you carry out the transport, the system recognizes some of the changes but does not add any new 

objects to the transport request. This can lead to inconsistencies in the target system following the 

transport. 

SAP therefore recommends that you make no further settings in CO-PA between the time when you 

create the request and when you export the settings. 

When you create the transport request, the system is not able to check which of the objects to be 

transported already exist in the target system. If objects already exist there, the system may import these 

objects and overwrite the ones which were created in that system. To avoid this, you should set up one 

source system first, and then transfer the settings to your other system(s). Do not create any new CO-PA 

objects (operating concern, characteristic, value field, and so on) in the target system. 

General notes on transports into CO-PA covering the following topics: 

Automatic transport versus manual transport 

Transporting client-specific and cross-client settings 

Transporting translated settings (settings in different languages) 

Postprocessing following import 

Additional information 

Notes on the individual transport objects 
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Automatic transport versus manual transport 

As in other applications, many CO-PA customizing settings are automatically collected in a transport 

request. However, this does not apply to all settings. 

For information on the transport type, see the following IMG activity: Additional Information -> 

Technical data -> Transport type. Settings for manual transport can usually be transported using the 

transport options with the individual transactions or by using this transport transaction. Which one you 

choose will depend on the purpose of the transport as well as the number of objects to be transported. 

Differences 

In contrast to the standard transport functionality, the current transport function allows you to 

transport larger amounts of objects. This usually means that more may be transported than is 

necessary. If the source and target systems are identical, this poses no problem. If you only want to 

transport individual table entries or settings, you should use the transport function available from 

the relevant customizing transaction or create a transport request manually. 

Moreover, collecting objects (reports, forms, and so on) later with this function means that objects 

that have been deleted in the meantime will not be found. 

Recommendation 

Overall transport 

The first time you transport an operating concern, you can do so most easily using the function 

"Transport objects". 

If a transport request is generated in the process, you can also release this following the overall 

transport. 

"Delta" transport ( changes ) 

If you later add customizing settings that are automatically recorded in a transport request, 

you can transport them using that transport request. All other settings must be transported manually. 

Client-specific and cross-client settings 

In CO-PA, Customizing consists of cross-client settings (such as tables and data elements) and client-

specific settings (such as Customizing value flows). Two request categories are usually used in the SAP 

System: 

Customizing requests 

Workbench requests 

The Customizing settings in CO-PA are split by default into these two request categories, depending on 

whether they are cross-client or client-specific settings. You can deactivate this splitting function in 

the transport settings (found under Goto -> Settings). Read the documentation on the  Split 

Objects into Workbench and Customizing Requests indicator. 

Transporting translated settings (settings in different languages) 

If objects exist in different languages, these languages can also be taken into account during the 

transport. For this, you need to set the corresponding indicator in the settings. All languages are 

transported by default. 

If only some of the languages should be transported, you can add just those particular languages to an 

existing transport request by choosing "Edit -> Add languages". You cannot do this with Data Dictionary 

objects because the language transport for those objects uses the system settings. 

Postprocessing Following Import 



 

 

No postprocessing 

No postprocessing is necessary when you transport settings that have nothing directly to do with the 

structures of the operating concern. These include reports, forms, key figure schemes, layouts, and 

so on. However, these objects require you to have a compatible operating concern in the target 

system. 

Automatic postprocessing 

In Release 4A, the system automatically carries out some postprocessing actions ("after-import 

methods") directly when you import certain Customizing settings. This means you no longer need 

to carry out these steps manually in the target system. You can find information about what 

methods were carried out - and any error messages issued - in the import log. 

When certain settings are transported, it is necessary to regenerate the client-specific environment 

of the operating concern. Generation occurs the first time the transaction is called up (after not after 

the import phase). 

Manual postprocessing 

Summarization levels are not automatically activated after the import. You need to activate them 

manually and then populate them with data. 

Number ranges are generally not transported. Consequently, you need to define them in the target 

system following the first transport. However, it is possible to transport the number range 

groups that are assigned to the CO-PA record types (using "Structures: Number Range 

Groups"). It is recommended that you only transport these groups if the source and target 

systems have the same record types and number ranges. Otherwise you should define them 

manually in the target system. 

Further notes 

For technical reasons, the system cannot transport any reports whose names contain special 

characters. To get around this problem, you need to create a new report without special 

characters, and copy the old report. 

To ensure that your entire system is consistent, the system transports all the tables and table entries 

which CO-PA references. The system transports only those ABAP Development Workbench 

objects which are generated by CO-PA, and the table entries which are managed by CO-PA and 

those changed by the user. Those settings which you can make in CO-PA, but which also affect 

other applications outside of CO-PA, are not transported. This ensures consistency in the target 

system. 

If characteristics or value fields have been deleted from an operating concern that is to be 

transported to a system that already contains the old version of the operating concern, proceed 

as follows: 

Transport all Customizing requests containing objects for that operating concern. 

In a separate transport request, transport all reports, forms, key figure schemes, and planning 

layouts from which the deleted fields have been removed. If you have deleted steps or rules 

from the derivation strategy or from other strategies (such as planning), transport the entire 

strategy by choosing Extras -> Transport. In general, the following applies: If the maintenance 

transaction does not have an automatic link to transport, check whether a manual transport 

option is available. If such an option is not available, use the Customizing transaction 

Transport Objects to perform the transport. 

In the target system, choose Tools -> Analysis -> Check Customizing Settings to access the 

where-used list, and use this function to determine whether the deleted characteristics und 

value fields are still in use anywhere. It may be necessary to use the corresponding 

maintenance transaction (which you access by double-clicking the object from within the 

where-used list) to remove the deleted fields from the objects. 
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You may only import the changed data structures for the operating concern when the deleted fields 

are no longer referenced in the target system. 

Below is a list of the objects which are not transported: 

Master data tables for characteristics that were not created manually in the operating concern (this 

applies to characteristics copied from reference tables) 

Fiscal year variants 

Condition records 

Transaction data 

Notes on the individual transport objects 

For more detailed information on the following transport objects 

Report 

Key figure scheme - Operating concern, 

see the section Details on the individual transport objects (including information such as a list of the 

subobjects that can be included in the transport). 

 Import 

This function lets you import CO-PA objects from any source client to another productive or test client. 

This function is used primarily to import the SAP standard reports delivered in client 000 to your other 

clients. 

Restriction 

- Comments for reports you have created: 

If comments have been created for reports, you cannot use the import function to copy such 

comments. To overcome this, include the report in a transport request and import it into the target 

client. To do this, use the function Transports within a System. 

 Subsequent Posting of Documents 

 Prepare Subsequent Posting of Sales Orders 

In this activity, you can prepare to post existing sales orders subsequently to Profitability Analysis ( CO-

PA ). 

This function is especially useful if you implement CO-PA after you have already posted data 

productively in Sales and Distribution (SD). This lets you post data from the current or past periods. 

Before you can post sales orders subsequently, the system needs to determine profitability segments to 

which the order items should be assigned, if this assignment does not already exist. In this step, you 

make that assignment so that you can then post the sales orders. 



 

 

On the selection screen, enter the criteria for the sales orders you want to post subsequently. The system 

selects those sales orders that meet the selection criteria and have not yet been assigned to a profitability 

segment. 

If errors occur, the system stores the corresponding messages in the log. After correcting the errors, you 

can start this function again to assign the sales orders that contained the errors. 

You can execute this program in the test mode so that no changes are made to the database. This makes it 

possible to check for any possible errors and correct these in advance. 

 Post Sales Orders Subsequently 

In this activity you can post sales orders that have already been defined in the system to Profitability 

Analysis ( CO-PA ). 

This function is especially useful if you activate CO-PA after you have already posted data productively 

in Sales and Distribution (SD) and want to transfer this data for the current period or past periods. 

Before you can use this function to post sales orders to CO-PA, you must determine a profitability 

segment to which the data for these orders should be posted. If you have sales orders that have not 

already been assigned a profitability segment, you need to prepare this step using the function "Prepare 

subsequent transfer of sales orders". Documents without profitability segments are not processed by this 

function. 

On the selection screen, you can specify the sales orders you would like to transfer. The system only 

selects those sales orders that have been assigned to a profitability segment. 

If errors occur during the transfer, the system saves the relevant error messages in the log. Once you have 

corrected the errors, you can execute this function again to post the rest of the sales orders. 

You can execute this function in the test mode in order to correct any sales orders that contain errors. In 

this case, no changes are made to the database. 

The default system does not protect any sales documents being transferred from any changes being 

made during the transfer. You can deactivate this function on the selection screen to prevent changes 

from being made to the selected documents. However, the result of this may be that you do not obtain 

the most current data in Profitability Analysis. This also has the effect that no sales orders can be 

processed in SD while this program is running. 

This function also checks whether any of the selected sales orders have already been posted to CO-PA. If 

you deactivate this option, and if the system finds orders that have already been transferred, these orders 

are canceled and then reposted again to CO-PA. 

 Post Billing Documents Subsequently 

This function lets you transfer to costing-based CO-PA billing documents that already exist in 
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FI. This is particularly useful if you go productive with CO-PA later than you do with SD and you wish 

to post the sales data for the current or previous period(s) to CO-PA. 

You can specify the billing documents to be transferred by entering: 

the billing document number 

the billing date 

the sales organization 

the distribution channel and/or division. 

The program checks whether the billing data has already been posted to CO-PA in order to prevent 

documents from being posted twice (first online and then with this function to CO-PA). 

After posting the data to CO-PA, the program displays a transfer log and an error log. If any billing 

documents contained errors, you need to correct them and run the program again. 

Prerequisites 

The operating concern to which you want to transfer the billing data must be defined and generated. 

The fields in the billing document must be assigned to the value fields or quantity fields in the operating 

concern. 

Actions 

Post your billing data from the sales system (SD) to Profitability Analysis. 

Additional notes 

This function also allows you to repost billing documents correctly if they have been transferred into CO-

PA via incorrect derivation. If you activate the "Reversal of line items" indicator, the system cancels the 

incorrect line item and, in the same step, writes a new line item for which the current derivation rules are 

taken into account. You also need to activate the "Redetermine prof. segment" indicator for the latter to 

occur. 

 Subsequent Posting of Documents from Financial Accounting 

Use 

You can use this function to transfer FI documents to costing-based Profitability Analysis. 

The program checks whether the FI documents have already been posted in Profitability Analysis to 

avoid the same documents being transferred twice - once online and a second time with the subsequent 

posting program in Profitability Analysis. 

Requirements 

It is only possible to transfer documents that already contain an account assignment to a profitability 

segment. 



 

 

 Subsequent Posting of Documents from Materials Management 

Use 

You can use this function to transfer FI documents to costing-based Profitability Analysis. 

The program checks whether the FI documents have already been posted in Profitability Analysis to 

avoid the same documents being transferred twice - once online and a second time with the subsequent 

posting program in Profitability Analysis. 

Requirements 

It is only possible to transfer documents that already contain an account assignment to a profitability 

segment. 

 Data Transfers Between CO-PA and Other Systems 

In this activity you find functions for transferring data between Profitability Analysis and external 

systems. 

 Initial Steps 

In this section you make the necessary settings so that you can transfer data between Profitability 

Analysis and other systems. 

 Define Record Types 

In this activity you specify the record types with which you want to transfer data to or enter data in 

Profitability Analysis. 

You can assign a record type to each data source. The numbers 0 - 9 are reserved for your user-

defined record types to be assigned to your own data sources. Standard Settings 

The following record types are pre-defined and cannot be changed: 

A: Incoming sales orders 

B: Direct postings from Financial Accounting 

C: Settled orders and projects 

D: Transfer of cost center costs 

F: Transfer of billing documents from the SD interface 

G: Transfer of sales quotes 
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H: Transfer of key figures 

I: Transfer of sales orders from projects 

Actions 

Define additional record types as desired. 

 Define Number Ranges for New Record Types 

In this IMG activity, you define the necessary number ranges for your user-defined record types. 

Set up number assignment for plan data 

Set up number assignment for actual data 

 CO-PA External Data Transfer 

In this section, you will find information about importing data from a non-SAP system. 

In costing-based Profitability Analysis, you can import both plan and actual data. In account-based 

Profitability Analysis, you can only import plan data. 

It is possible to process transfers simultaneously. You can transfer more than one external file at the same 

time without the system locking data. 

Before the first data transfer, you need to 

define the structure of the external data 

define the sender structure 

define transfer rules 

Recommendation 

To reduce runtimes, divide the external files into a number of separate files and import them on multiple 

application servers. 

Additional Information 

This interface can also be used to import legacy data. 

 Define Structure of External Data 

In this activity, you define the structure of the external data you want to import. 

This makes it possible for you to transfer the data in the format supplied by the external system. 



 

 

The standard structure COPA999 is an example of such a structure. 

 Define Data Interface 

Activities 

In this activity, you define the data interfaces for importing external data to Profitability Analysis. 

A data interface is referred to as a "sender structure". The "sender structure" contains the mappings of 

one or more ABAP Dictionary structure(s) to an operating concern. The ABAP Dictonary structure 

defines the format of the external data that is to be imported to the operating concern. 

When you define the "sender structure", you need to specify whether you want to import the data to 

account-based or costing-based CO-PA. In addition, you specify whether you want to import actual 

data or plan data. 

Note that, in account-based CO-PA, you can only import plan data. 

 Maintain Transfer Rules 

Activities 

In this activity, you define how you want data stored in the format of an external structure to be mapped 

to the data structures of your operating concern. You define this mapping at the field level. 

On the initial screen, enter the name of the sender structure. Then go to the overview screen by choosing 

"Maintain" or "Display". 

The overview screen shows a table containing the fields of the operating concern that were defined in the 

sender structure. You can generate an automatic assignment of fields in the external structure to the 

fields of the operating concern by choosing "Create proposal for rule". 

If you want to define manually how a field of your operating concern should be populated, select that 

field and choose the "Detail" icon. Here you have a number of different options, depending on the type of 

field. 

I. Detail Screen for Defining Rules for Characteristics 

You can define the following rules for characteristics in your operating concern: 

1. Copy sender field 

This rule assigns a field in the external structure to a characteristic in the operating concern. 

Using the "Restrict value ranges" function, you can specify explicitly which values of the sender 

field should be copied to the target field. You can also use special "conversion routines" for the 

transfer. This makes it possible, for example, to fill a field with leading zeros. In addition, you can 

specify conditions for other fields, so that the field content is only transferred if certain other fields 

of the external structure contain certain values. 

Example: 

Suppose the country in the sender record is "France" and you want to transfer the divisions "01" 

through "09" from the sender to the same divisions in the operating concern. To achieve this, you 
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enter the sender characteristic "SPART" under "Sender Field to be Transferred". Then choose 

"Restrict value ranges" and enter the divisions "01" through "09". Under "Sender fields for 

conditions", enter the characteristic "LAND". Then choose "Conditions" and enter "France" as the 

condition for the transfer. 

If a characteristic is not populated during an external data transfer, you have the following options: 

"Set to initial" 

The field receives its initial value (blank or "0"). 

"Classify as error" 

The case is registered as an error. 

"Set constant" 

A constant is entered in the field. 

d) "Copy sender field" 

The system copies the value of another sender field. 

Set constant 

You can assign a fixed value to the sender field. 

Example: 

You want all external plan data to be transferred to version 001. To achieve this, you set the 

constant "001" for the characteristic "VERSI". 

Set variable 

You assign a variable to the receiver field. This makes it possible for you to specify a value for this 

field when you carry out a data transfer. For example, you can use this option to specify the 

company code manually for each data being imported. You can also define a fixed value for the 

variable. 

Example: 

You want to specify the company code when you carry out the data transfer. To achieve this, you 

define a variable "&COCODE" by choosing "Goto -> Variables -> Characteristic variables" and 

selecting replacement type 2 (manual entry). Then save the variable. Then enter this variable for the 

receiver characteristic "BUKRS". 

Convert sender fields 

This option lets you specify which fields of the external structure you would like to convert. By 

specifying an offset and a length, you can copy only part of the sender field. Also, you can specify a 

conversion routine that the system should carry out before converting the sender field value. 

When you choose the "Conditions" function, the system takes you to a screen where you can 

specify the values the sender field must have for the conversion to take place. In the left-hand 

column, you enter the "target" values of the receiver field. In the subsequent columns, you can 

enter single values or intervals for the sender fields. All of the sender fields must contain the 

specified values for the receiver field to receive that value. If you want a sender field to be able to 

have more than one value, select the line and choose "Multiple selection" next to the field. An 

icon to the right of the field shows that multiple criteria have been specified. You can also define 

more than one line for one receiver field value. When you carry out the data transfer, the system 

chooses the first rule that works. However, the order in which the rules are processed is not 



 

 

defined. It is also possible to enter a receiver field value explicitly or set the field to its initial 

value. Example: 

You want to use the sender fields "Sold-to party" and "Division" to determine the value 

for the receiver field "Sales district". To achieve this you enter the sender characteristics "AUFGB" 

and "SPART" under "Sender fields to be converted" and choose "Conditions". Then you enter the 

desired conditions - for example, sales district "0001" is found for sold-to party "0000000" and 

division "02". 

5. Use general rule 

You can enter a rule that should be used for more than one transfer. 

You can decide that the rule should be used as a "general rule". To do so, enter a name and a 

description in the field "Use the rule defined here as a general rule". 

Example: 

You want to transfer the data for the sender characteristics "Region" and "Product group" to the 

receiver characteristic "Customer group" in multiple transfers. To be able to use a defined rule more 

than once, you need to define a general rule. You define this rule as described above for "Convert 

sender field". Then you enter a name and a description for the rule in the field "Use rule defined 

here as general rule", and save your entries. You can then use this rule in other sender structures by 

choosing the "Use general rule" function. When you select a rule, the system displays the sender 

fields to be converted by the general rule. 

Once a rule is referenced, you can no longer delete it. If you want to delete the rule, you need to 

append it to the rule that references it. 

II. The Detail Screen for Defining Rule Values for Value Fields 

On the detail screen, you define how the values in the external file should be transferred to the value 

fields of your operating concern. 

In the "Key figure formula" box, enter the name of the external field that you want to transfer to the 

selected value field. 

You can also calculate using sender fields. To do so, you need to define a formula using the fields in the 

external structure. You can display a list of the valid sender fields using the "Possible entries" function. It 

is also possible to work with variables in the formula. The formulas are defined using the syntax rules 

that apply in ABAP. For more information, see the field help (F1) for the input field. 

You can use conditions to specify that a key figure is only populated if a certain sender field contains a 

certain value. 

As with the transfer rules for characteristics, you can save your rule as a general rule by entering a name 

in the "Use as general rule" field. To use this rule for the transfer, enter a name in the "General rule" 

field. The system displays the sender fields that are to be converted. 

Further notes 

Define variables 

You can define variables for characteristic values and formulas, and use these when you define your 

transfer rules. Variables for formulas are global. Variables for characteristic values are only valid for the 

object that you are processing. To create a variable, choose "Goto -> Variables" from the detail screen. 

Then choose "Edit -> Insert line" on the next screen. The system inserts as ampersand (&) in the field. 

Enter the name of the variable directly after this ampersand. Then choose the desired replacement type. If 

you choose replacement type "2", you can replace the variable manually when you carry out the external 
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data transfer. If you choose "5", you must enter a fixed value. If you choose "3", you must activate 

function module EXIT_SAPFKCIM_003 as a user exit. Finally, enter a description for the variable and 

save your entries. 

 Platform-Independent File Name Allocation 

When executing the external data transfer, you can enter a cross-platform, logical file name for for the 

input and output file. 

Read the following information describing the concept of the logical file names. 

 Cross-Client Maintenance of File Names and Paths 

This activity (transaction FILE) is for cross-client maintenance of logical filenames and file paths and 

includes the following: 

Logical file path definition 

Assignment of physical paths to logical path 

Logical file name definition, cross-client 

Definition of variables 

Syntax group definition 

Assignment of operating system to syntax group 

Choose one of these in the navigation area of the screen to see the corresponding view of the values to be 

maintained. You can examine existing entries and enter new values. Depending on the data you need to 

maintain, you can either work in the overview or you may need to go to the details view by pressing F2 

or the "Details" push button in the application toolbar. 

Note 

Release 3C introduces cross-client logical filename maintenance. In addition to cross-client maintenance 

you can still choose to maintain filenames for a specific client. You must maintain a logical filename 

across clients before you can maintain it for one client. Then you can maintain it for particular clients as 

required. 

Use program RSFILE01 to transfer filenames from the client-specific maintenance ( available before 

Release 3C) to cross-client maintenance. Client-specific data is not affected. 

Activities 

Verify that existing definitions meet your needs. 

Change the definitions (and, if necessary, the structure of your file system). 

If necessary, define additional filenames and paths. 



 

 

 Maintain Additional Client-Specific File Names  
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 Data Transfer from SAP BW 

In this activity, you set up the transfer of data from an SAP BW query into CO-PA before executing data 

transfer. 

Note: The data transfer can only occur for costing-based Profitability Analysis. 

During setup, you specify the field assignments between the BW query and the operating concern CO-

PA. 

During transfer, the current status of the query is transferred without any delta procedure occurring. You 

can cancel a transfer run to make any necessary corrections. 

Note 

For easier access, you can insert this IMG structure into the standard IMG for Profitability Analysis. For 

information on how to do this, see note 205201.  



 

 

 Define Field Assignments 

In this activity, you specify which fields of an SAP BW query are to be set in which fields of a CO-PA 

operating concern during the data transfer. You also have the option of specifying the field assignment 

for the entire BW system, that is, for all queries. In this way, you reduce the amount of maintenance 

required if an assignment is to remain identical for each query. If an assignment has been specified for a 

field at the system level and at the query level, the detailed assignment at the query level is applied. 

To implement additional functions, such as mapping BW master data onto CO-PA master data or 

postprocessing the query data, you can use the SAP enhancement COPA00RE in the ERP system and the 

customer enhancement for external data transfer COPA0007. 

Requirements 

The query must be RFC-enabled. In other words, the Release for OLE DB for OLAP indicator must be 

set. 

The query can contain no more than one structure. 

The user for the RFC connection to the BW system must be of user type 'dialog' or 'service', because 

otherwise the input help for the queries will not work. 

Activities 

From the available RFC systems, select the BW system from which the data is to be transferred. 

Select the query from which the data is to be transferred. 

In the details screen, you can assign BW objects to CO-PA fields. BW objects are as follows: 

All info objects for the query, 

Formulas that are defined in the query, 

All attributes of the info objects, as well as 

The info objects that define a restriction to a key figure; the condition for this is that the restriction 

does not consist of a single value. 

Filter values that are defined in the query are not contained. It is not possible to assign these values. 

On the CO-PA side, you find all the characteristics, value fields, quantity fields as well as some 

technical fields (such as the posting date) for the operating concern. 

The currencies and quantity units belonging to the fields are assigned automatically. During the 

transfer, the period is interpreted according to the fiscal year variant. 

If a value cannot or should not be transferred, you can enter a fixed value for a CO-PA 

field. This can be necessary, for example, for the mandatory field company code if this field does 

not exist in the query and cannot be determined during characteristic derivation. 

For the field assignment described above for the entire BW system, you can use all the info objects from 

the BW system and all fields from the operating concern. An assignment at this point is overridden 

by an assignment of the corresponding info object at the query level. 
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 Execute data transfer 

In this activity, you execute the transfer of data from an SAP BW query. 

During the transfer, the query is expanded down to the greatest level of detail and corresponding CO-PA 

line items are created. For this, characteristic derivation and valuation (when actual data is transferred) 

are run automatically (valuation of planning data is optional). Moreover, a check is run to see whether 

the respective characteristic values that are to be transferred are valid for the characteristic. If any errors 

occur during data transfer, no line item is posted. 

For each data transfer, all the data for the query is transferred. In other words, if the data in a query is 

transferred several times, this data is then redundant in CO-PA. In such cases, you have the option of 

cancelling a transfer run. To improve runtime during cancellation, an index with a document number 

should exist in table CE1xxxx (where xxx = operating concern). 

Requirements 

It is only possible to transfer data for costing-based Profitability Analysis. 

Field assignment must be maintained for the query. 

Since the posting occurs with record type H when actual data is transferred, a number range must be 

assigned to this record type. 

Activities 

Enter the BW system and the query for which you have maintained a field assignment. 

If the query that you want to transfer contains variables, you can use the Query variable pushbutton to 

define a variant with which to fill these variables and to enter this variant in the  Variant for query 

variable field. This is necessary if you want to execute the transfer in the background. If you 

execute the transfer online and have not created a variant, the variables are called up online. 

When you transfer planning data, you need to make the entries for posting to CO-PA, such as the record 

type and the version. For the transfer of actual data, the record type 

H is automatically applied. 

You can use the Logs pushbutton to display detailed information about completed data transfers. It is 

possible to cancel a transfer, for example, directly from the log. 

 Data Transfer via FI/CO Document 

In this section, you will find information about how to set up an IDoc interface for transferring data from 

an external billing system to the Financials applications and including an update in Profitability Analysis. 



 

 

 Display IDoc Type 

In this activity, you can display the structure of the IDoc ACLREC01, which is used to update data from 

an external billing system to Profitability Analysis. 

This also contains the CO-PA-specific segments that you need to use if you want to update the data in 

CO-PA. 

To make the data transfer possible, the segments and segment fields of the external data need to be 

assigned automatically to the fields in Profitability Analysis. 

Activities 

Enter the object name "ACLREC01" and choose "Tree display". You will find the CO-PA-specific 

segments under the segment E1ACA1. There you can also find documentation on the IDoc structure. 

 Assign Fields 

In this activity you can display the assignment of the fields of the IDoc segment ACLREC01 (Load 

Receivable) to the characteristics and value in Profitability Analysis. These assignments were generated 

automatically when you generated the operating concern. 

 Distributed Profitability Analysis 

In this activity, you carry out tasks which are only required if you are using CO-PA as a distributed 

system, that is, in conjunction with the ALE function. 

The system supports distribution scenarios in which several systems are connected to one another. This 

makes it possible in CO-PA to integrate local contribution margin accounting with central profitability 

accounting. 

To set up distributed Profitability Analysis, you need to carry out the following steps: 

Costing-based Profitability Analysis 

Generate a message type for each operating concern carrying the name CPxxxx (xxxx = operating 

concern). 

Carry out general ALE-Customizing. Refer in particular to the section Set profitability analysis. 

Activate the distribution in the local, sender systems by specifying whether realtime distribution or 

periodic rollup should be carried out. 

If you have activated periodic rollup, you have to enter the segment level characteristics for distributed 

Profitability Analysis. 

If you have activated realtime distribution, you can carry out the initial supply of distributed 

Profitability Analysis. 

Account-based Profitability Analysis 

Generate or update the message type 'CODCMT' ( CO-Document ). 
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Carry out general ALE Customizing. 

Further notes 

For background information about distributed Profitability Analysis, see the section "Tools -> 

Distributed Profitability Analysis" in the CO-PA documentation. 

 Generate/Update Message Type 

In order to run Profitability Analysis in a distributed system environment, you need to generate system 

message types which control the communication with the local systems. You need one system message 

type for each type of Profitability Analysis (costing-based and account-based). 

Activities 

For costing-based CO-PA, you need to generate message type CPxxxx (where xxxx is the name of your 

operating concern). You need one message type for each operating concern. 

For account-based CO-PA, you need to generate system message type CODCMT, or actualize it if it has 

already been generated for another application in CO. 

Further notes 

If you change an operating concern or add new characteristics or value fields to it, you need to regenerate 

the corresponding system message type. 

 Activate Distributed Profitability Analysis 

When you activate distributed Profitability Analysis, you need to specify in the local ( sender ) systems 

how the data should be transferred to the central (receiver) system. 

The following methods exist: 

Realtime distribution ( transaction-based ) 

An IDoc with the line item is sent to the receiver system for each CO-PA posting in the local 

system. This method offers you the advantage that the receiver system always contains the most 

current, detailed information. 

Periodic rollup 

In a periodic rollup, the data is not passed on to the receiver system until you execute the rollup 

function in the application. You can do this on a daily, weekly or monthly basis. The line items are 

selected in the sender system, summarized if necessary and sent to the receiver system. You should 

use this method if you do not need to have the most detailed information in the central system. 



 

 

Note: You can only activate this for distribution in costing-based Profitability Analysis. It has no effect 

on account-based Profitability Analysis, where only realtime distribution is possible. 

Recommendation 

It is recommended that you do not switch between these two methods in your productive system since 

that could lead to inconsistences between the local (sender) systems and the central (receiver) system. 

Activities 

If you have activated realtime distribution, you can then use the function 'Run Initial Supply for 

Distributed Profitability Analysis' to post subsequently any data already posted but not yet distributed. 

If you hav activated periodic rollup, you must then use the function 'Define Segment-Level 

Characteristics for Distributed CO-PA'. 

Further notes 

Even if you choose realtime distribution, it is possible not to send the data immediately to the central 

system. If you set up a large buffer when you customize the ALE function, the system will wait until it 

has collected a certain number of line items and then send them en bloc. 

 Run Initial Supply for Distributed Profitability Analysis 

This function lets you transfer data from local systems to the central system according to certain 

selection criteria. You should use this function when you want to post data to the central system which 

already has been posted in the local system but not yet distributed. 

Example 

If you posted billing data in the first few posting periods before you used Profitability Analysis as a 

distributed system, you can use this function to distribute that data now. 

You need to enter the operating concern, the partner system, the plan/actual indicator, record type F (for 

billing data) and the period(s)/year. 

Requirements 

The initial supply of data only affects costing-based Profitability Analysis during distribution. It does not 

affect account-based Profitability Analysis in any way. 

This step is only necessary if distributed Profitability Analysis has been activated as simultaneous 

(transaction-based) distribution. 

Activities 

Specify the selection criteria for the data to be posted. 

If you select the indicator "Check partner system", you can check whether any line items which you want 

to send to the partner system already exist there. If any are already there, those line items are not sent. 
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When you run the initial supply, you can display or print a log by checking off the indicator "Detail list". 

By checking off "Test run", you can execute the function without making any changes to the database. 

 Subsequent Posting of CRM Billing Documents 
 Data Transfer to SAP Business Information Warehouse  



 

 

 Assign Key Figures 

In this activity, you assign elements of a key figure scheme to some of the key figures predefined in CO-

PA. By placing these elements into DataSources, you can transfer your contribution margin scheme 

(which you defined using the key figure scheme) to your SAP BW. This eliminates the need to define 

new key figures there. Another advantage is the fact that the key figure scheme in the SAP BW then has 

fixed concepts at its disposal that can be accessed in predefined Queries or from external systems without 

requiring knowledge of customer-specific information from CO-PA. However, it is necessary for the key 

figure and the element from the key figure scheme assigned to it to have the same meaning from a 

business point of view. 

For more information about the business meaning of predefined key figures, see the documentation 

relating to the existing key figures listed below. You call up the documentation by clicking the 

appropriate key figure. 

Sales Unit ( COPASLQTU ) 

Sales Quantity ( COPASLQTY ) 

Revenue ( COPAREVEN ) 

Customer Discount ( COPACDSCN ) 

Product Discount ( COPAPDSCN ) 

Quantity Discount ( COPAQDSCN ) 

Promotion ( COPASPROM ) 

Cash Discount ( COPACASHD ) 

Rebate ( COPAREBAT ) 

Miscellaneous Sales Deductions ( COPAODSCN ) 

Total Sales Deductions ( COPADISCT ) 

Net Sales ( COPANETSL ) 

Sales Commission ( COPASCOMM ) 

Special Sales Direct Costs ( COPASDIRS ) 

Anticipated Shipment Costs ( COPAFRGTC ) 

Total Sales Direct Costs ( COPADIRSL ) 

Net Revenue ( COPANETRV ) 

Material Direct Costs ( COPADMATC ) 

Variable Production Costs ( COPAPRDCV ) 

Total Variable COGM ( COPACOGSV ) - Contribution Margin I ( COPAMRGN 1) 

Material Overhead ( COPAMATOH ) 

Fixed Production Costs ( COPAPRDCF ) 

Total Fixed COGM ( COPACOGSF ) 

Contribution Margin II ( COPAMRGN 2) 

Total Variances ( COPAVRNCS ) 
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Contribution Margin III ( COPAMRGN 3) 

Marketing Overhead ( COPAOHMRK ) 

Sales Overhead ( COPAOHSLS ) 

Administrative Overhead ( COPAOHADM ) 

R&D Overhead ( COPAOHRND ) 

Logistics Overhead ( COPAOHLOG ) 

Miscellaneous Overhead ( COPAOHOTH ) 

Total Overhead ( COPAOVHDC ) 

Operating Profit/Loss ( COPAPROFT ) 

If you do not wish to separate your costs of goods manufactured into fixed and variable, you can use the 

key figure Total COGM ( COPACOGS ). 

As is the case for the key figure scheme itself, the assignment of the elements of the scheme is specific to 

the operating concern. In other words, you assign the key figures individually for each operating concern. 

Instead of assigning an element from a key figure scheme, you can choose to assign a value field or one 

of the function modules at your disposal. 

Example 

Requirements 

Standard settings 

Recommendation 

Activities 

In the overview screen, choose New Entries and assign one of the following to a key figure: 

An element from the key figure scheme 

A value field, or 

the function module of a user exit 

Ensure that the key figure and the object assigned to it have the same business meaning. 

Further notes 

To obtain an overview of all the assignments maintained, select the pushbutton Overview.  



 

 

 Create Transaction Data DataSource 

In this activity, you can create or delete a DataSource for analyzing data from Profitability Analysis (CO-

PA) as well as display its structure. 

Create: 

You define a DataSource on the basis of an existing operating concern. You can include in your 

DataSource all or just some of the characteristic and value fields of this operating concern. 

A DataSource is defined by the following elements: 

Operating concern 

Amount of characteristics 

Amount of value fields 

Amount of calculated key figures 

Up to and including Plug-In Release PI2003, a DataSource is only defined in the current client of the 

source system. This means that a DataSource can only be extracted from this client. The DataSource has 

a timestamp for the delta method, and this timestamp is only valid for the current client. This timestamp 

is managed by Profitability Analysis. 

With Plug-In Release PI2004, timestamp management was converted to a new method, called generic 

delta. This method works in combination with a BW system with Release 2 and higher. With this 

method, timestamp management is no longer performed by Profitability Analysis, but instead by the 

Service API (interface between Profitability Analysis and SAP BW). 

Compared to timestamp management in Profitability Analysis, the generic delta allows for several 

enhancements: 

You can apply the delta method simultaneously using the same DataSource from more than one client of 

the source system because a separate timestamp is saved for each logical system. 

You can apply the delta method for the same client of the source system simultaneously using the same 

DataSource from several BW systems. 

You can perform several initializations of the delta method with different selections using the same 

DataSource from a given BW system for the same client of the source system. 

The DataSource commands the "Delta Init Simulation" mode. With timestamp management in 

Profitability Analysis, this mode had to be implemented using the Simulate Delta Method 

Initialization transaction (see SAP Note 408366). 

For more information on the generic delta, see section Delta Transfer, whereby the steps of the 

"Specify Generic Delta for a DataSource" section are performed automatically for Profitability Analysis 

when a DataSource is created. For this, the field determining the delta is taken as the timestamp for 

Profitability Analysis (TIMESTMP), and the timestamp is stored for summarization levels and line item 

tables. However, in contrast to generic DataSources, the TIMESTMP field is not generated in the 

extraction structure because this is not necessary for DataSources in Profitability Analysis. As with 

timestamp management in Profitability Analysis, an upper limit of 30 minutes is set as the safety 

interval. 

You find the timestamp of a DataSource for the delta method in the current logical system either on the 

"Last Data Transfer" tab page or using the IMG activity Check Delta Queue. The timestamp is shown 

here when you choose the selection button in the Status column for the combination of DataSource and 

BW system. 
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DataSources created after implementing PI2004 automatically apply the new method. DataSources that 

were created in Plug-In releases prior to PI2004 still continue to use timestamp management in 

Profitability Analysis but can be converted to the generic delta in transaction Create CO-PA DataSource. 

For this, an additional selection option Convert to Generic Delta appears in the selection screen when a 

DataSource with timestamp management in Profitability Analysis is entered. Conversion from the 

generic delta to timestamp management in Profitability Analysis is not supported. 

Conversion is only possible for DataSources that are defined in the current client of the source system 

and for which the delta method has already been successfully initialized or for which a delta update has 

successfully been performed. This is the case once the DataSource has the replication status "Update 

successful". Furthermore, no realignments should have been performed since the last delta update. 

For the conversion, the timestamp for the current source system client is transferred from Profitability 

Analysis into the timestamp of the generic delta. In this way, the transition is seamless, enabling you to 

continue to perform delta updates after the conversion. If delta updates are to be performed from 

different clients of the source system for this DataSource, you first need to initialize the delta method for 

these clients. 

The conversion must be performed separately in each source system because the timestamp 

information is always dependent on the current R/3 System and is reset during the transport. If, however, 

a converted DataSource is inadvertently transported into a system in which it has not yet been converted, 

delta extraction will no longer work in the target system because the timestamp information is deleted 

during the import into the target system and is not converted to the timestamp information of the generic 

delta. If in this instance no new delta initialization is going to be performed in the target system for the 

DataSource, you can execute program ZZUPD_ROOSGENDLM_FROM_TKEBWTS from SAP Note 

776151 for the DataSource. This program reconstructs the current time stamp information from the 

information for the data packages transported thus far and enters this time stamp information into the 

time stamp information for the generic delta. Once this program has been applied, delta extraction should 

work again. Normally, however, you should ensure during the transport that the DataSource uses the 

same logic in the source system and the target system. 

After the conversion, the DataSource must be replicated again from the BW system. 

A successful conversion is recorded in the notes on the DataSource. 

Since the generic delta does not offer any other log functions apart from the timestamp information 

(status: Plug-In Release PI2004), Profitability Analysis still logs the delta initialization requests or delta 

requests. However, the information logged, in particular the timestamps, only has a statistical character 

because the actual timestamp management occurs in the generic delta. Since the delta method can be 

performed simultaneously for the same source system client using the generic delta from several BW 

systems, the information logged is stored for each logical system (source system) and BW system. When 

a delta initialization is simulated, only the timestamp of the generic delta is set; Profitability Analysis is 

not called. Consequently, no information can be logged in this case. Messages concerning a DataSource 

are only saved for each logical system (on the source system side). You can use the IMG activity Display 

Detailed Information on DataSource to view the information logged. 

Another enhancement from Plug-In Release PI2004 means that you can no longer exclusively perform 

full updates (that is, update mode "F") for DataSources of the Extractor Checker of the Service API that 

have recently been created or converted to the generic delta. The following update modes are possible: 

"F" - Full update: Transfer of all requested data 

"D" - Delta: Transfer of the delta since the last request 

"R" - Repeat transfer of a data package 

"C" - Initialization of the delta transfer 

"S" - Simulation of the initialization of the delta transfer 



 

 

In the case of all update modes other than "F", you have to specify an BW system as the target system so 

that the corresponding timestamp and/or selection information for reading the data is found. The "Read 

only" parameter is set automatically and indicates that no timestamp information is changed and that 

Profitability Analysis does not log the request. 

Update mode "I" (transfer of an opening balance for non-cumulative values) is an exception: Although 

you can still select this mode, the system issues an error message because Profitability Analysis does not 

support this mode. 

Delete: 

You can delete a DataSource that you no longer require. 

Activities 

Create: 

Give the DataSource a unique technical name. As a default setting, this name starts with the prefix 

"1_CO_PA". This prefix is mandatory and cannot be changed. 

To create the DataSource, choose DataSource -> Create. 

Select the characteristics that are to be included in the DataSource. The DataSource must contain some of 

these characteristics. These are already selected for you and cannot be deactivated. 

It is also useful to include characteristics that are contained in the segment table and are hence used 

to create the profitability segments. These characteristics are already selected but you can 

deactivate them if necessary. 

When selecting the characteristics, ensure that they are formally independent of each other in 

Profitability Analysis. In this way, it is also possible to make postings at the aggregated level. In 

spite of this formal independence, a logical dependency can still exist between some characteristics. 

For example, the customer group is logically dependent on the customer. You need to keep this 

logical dependency in mind when transferring characteristics into SAP BW so that you obtain valid 

data there. We recommend that, for each characteristic you select, you also select all the 

characteristics that are logically dependent on the selected characteristic. As a general rule, it is not 

useful to model CO-PA characteristics as navigation attributes in SAP BW. The inclusion of 

dependent characteristics has no negative consequences for performance or for the dataset. 

For costing-based Profitability Analysis, select the value fields and calculated key figures that are to be 

included in the DataSource. It is useful to include all the value fields of the operating concern. 

These value fields are already selected but you can deactivate them if necessary. The system checks 

that the units of measure relating to the value fields are also transferred. 

Technical notes: 

Along with the selected characteristics and value fields, the fiscal year variant and the record 

currency are also included in the replication so that the data in SAP BW can be interpreted 

correctly. 

The technical field PALEDGER (currency type) in Profitability Analysis is encrypted as 

CURTYPE (currency type) and VALUTYP (valuation) during the transfer to SAP 

BW. 
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The plan/actual indicator (PLIKZ) is copied to SAP BW as value type ( WRTTP ). 

You can use the Summarization level? icon to determine for costing-based CO-PA whether callup 

occurs by means of a summarization level when the delta procedure is initialized (the first time you 

replicate all CO-PA data into SAP BW). It is particularly useful to use a summarization level as a 

data source if the data in SAP BW is maintained at an aggregated level. In such cases, replication 

can be performed much more quickly due to the data having already been presummarized. If the 

system cannot find an appropriate summarization level for the characteristics and value fields that 

you selected, it reads the data from the segment level or from the line items. For more detailed 

information about data sources, see SAP Note 392635. For information about the data sources, see 

also SAP Note 392635. 

If no appropriate summarization level exists for the DataSource, you can use the function Create 

Summarization Level to create a proposal of a summarization level that is appropriate as a data 

source. 

Saving the DataSource generates a DataSource with the name 0G_Cyyyy_TXT (where yyyy = name of 

the characteristic) for the characteristics defined in CO-PA for the subsequent replication of the 

texts. 

Once the InfoObjects have been generated in the background, a screen appears in which you can specify 

whether selections can be made from a field in the InfoPackage. For account-based CO-PA; the 

fields "Period/Year" (PERIO) and "Controlling Area" ( KOKRS ) are mandatory fields for the 

selection. Furthermore, you can hide a field in the DataSource, but this is not relevant for CO-PA. 

In this screen, choose Save. In some cases, you access a screen in which you can perform an 

assignment of CO-PA fields to BW fields. This only applies when there is a connection to the 

SAP BW Release 1.. For more information, see the section Procedure for Setting Up the 

Replication Model for BW Release 1. 

For connections to SAP BW 2 or higher, only choose Save at this point. This takes you back to 

DataSource maintenance. 

Note: Up to and including Plug-In Release PI2003, a DataSource in CO-PA only carries one 

timestamp. This means that a maximum of just one BW system can be connected to a DataSource 

for a Delta replication. To connect additional BW systems, you need to create an additional 

DataSource or use the replication methods available in the BW system. 

Delete: 

1. By choosing DataSource -> Delete, you can delete any DataSources that you no longer require as 

well as the generated extract structure "ZOX*"  belonging to a deleted DataSource. 

Further notes 

You cannot change a DataSource once created. You can, however, delete it and then create a DataSource 

with the same name but with different technical properties. You should not upload metadata between 

these two steps. 

 Create Hierarchy DataSource 

In this activity, you create a DataSource for loading hierarchies from Profitability Analysis (CO-PA) into 

SAP BW. 

Enter the following data: 

Name of the hierarchy DataSource 



 

 

Short text 

The InfoObject for which you are generating the DataSource 

The related CO-PA characteristic for which you are creating the hierarchies. 

 Authorization Management 

In this activity, you determine which functions may be carried out by users in the SAP system and 

particularly in Profitability Analysis. 

To do this, you issue authorizations which relate to what are known as authorization objects. 

There are two types of authorization object: 

Those predefined by SAP 

Those defined by yourself, specific to CO-PA for planning, for the information system in general, and for 

reports based on line items in particular 

When a transaction is executed, the user's authorization is checked against the corresponding 

authorization objects. You assign authorization objects to users with the profile generator, which lets you 

use a role to create authorization profiles and then assign these profiles to users. 

Activities 

First create your CO-PA-specific authorization objects. 

Then create roles with the profile generator, maintain the necessary authorizations and assign these to 

users via the authorization profiles. 

Further information on this procedure can be found in the relevant sections. 

Prerequisites 

To maintain users, you require authorizations for the following authorization objects: 

S_USER_GRP 

S_USER_AUT 

S_USER_PRO 

S_USER_AGR - S_USER_TCD 

S_USER_VAL 

Note 
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For further information on authorizations in Profitability Analysis, please refer to the section "Tools -> 

Authorizations" in the documentation for Profitability Analysis. 

 CO-PA-Specific Authorization Objects 

In this activity, you can define your own CO-PA authorization objects to supplement those contained in 

the standard SAP System. 

You can make it easier to define authorizations by activating characteristic derivation during 

authorization checks. For example, if you want to protect the product group in your reports, it is enough 

to define authorizations for individual products. When a user runs a report for the product group, the 

system derives the product group from the product in the authorization. If the user has authorization for 

the product, he or she can run the report on the product group. This means that the "Product" field and 

the authorizations attached to it at the product level do not have to be copied to the authorization object. 

For more on activating derivation, see the sections on defining the individual CO-PA authorization 

objects. 

Note 

Authorization objects created here are automatically considered by the profile generator ( see Create 

Role/Profile and Assign Users). 

 Define Authorization Objects for Planning 

In this IMG activity, you define authorization objects which the system protects in planning. Each 

authorization object can consist of up to  fields, which you can define and group together as you wish 

(you can also use the characteristics of the operating concern or a free variable for the value field). All 

other characteristics which you do not specify in the object are regarded as allowed. 

By choosing up to  fields more than once, you can create different authorization objects that are linked 

with one another. However, it is recommended that you only create one object. Otherwise the "AND" 

links between authorization objects could cause difficulties when you create the authorizations for 

individual users. 

Before a user performs an action in planning, the system checks his or her authorization. If the 

authorization is lacking for just one of the objects, the system refuses the request. You can define the 

authorizations for individual users under Tools -> Administration -> Maintain users from the main 

menu. 

If desired, you can activate characteristic derivation for the authorization check. In this case, the system 

checks the user's authorization for all the characteristics that can be derived. For the system to do this, the 

user must have authorization for the activity "B3" (Derive) in authorization object "K_KEPL_TC" (Sales 

and profit planning). In addition, the set/get parameter "RDA" must have the value "X" in the user 

parameters. 

Possible authorizations for an object include: 

the individual values of a characteristic 

* 

This means that the user is authorized for all values of the characteristic. 

: 



 

 

This means that the user is not authorized at this level. He or she may only look at the total for the 

characteristic. 

# 

This means the user is not authorized for any value of the characteristic (only non-assigned values). 

The following tables demonstrates how the system checks your entries against an authorization object: 

    Field content   *           Y           #       does not exist 

Authorization: 

  *                 x           x           x           x 

  (A,Z)             -           x           -           - 

  X                 -           -           -           - 

  #                 -           -           x           - 

  :                 -           -           -           x 

Examples of how authorization objects are used in planning 

For planning, assume that the object Y_KEPL_X00 was defined with the fields "Customer", "Product 

range" and "Region". 

User A needs to carry out single-segment planning for customer C01. Data exists for product ranges A1, 

A2 and A3. The value entered by the user for customer C01 is stored for product range SPACE, region 

SPACE. 

Necessary authorization: Customer C01, Product range ":", Region ":". 

User A needs to carry out multi-segment planning for customer C01 and all product ranges. Necessary 

authorization: Customer C01, Product range "*", Region ":". 

Actions 

Define your authorization objects. 

 Define Authorization Objects for the Information System 

In this IMG activity, you define authorization objects which protect the CO-PA information system. Each 

authorization object can consist of up to  fields, which you define as you wish. These fields can be the 

characteristics which have been defined for the operating concern as well as value fields and elements of 

specific key figure schemes. All the characteristics and value fields which are not specified in the 

authorization object are allowed. 

You can create a number of authorization objects which are linked to one another by selecting up to  

objects several times. However, it is recommended that you create one authorization object with many 

fields instead of several with just a few fields. The "AND" relationship between the objects can lead to 

difficulties when you create authorizations for the individual users. See also "Example for the use of 

authorization objects". 

The system checks the user's authorization before he or she executes a report. If the user lacks 

authorization for even one object, the system denies access. 

You can define a user's authorizations from the main menu by choosing Tools -> Administration -> 

User maintenance. 

If desired, you can activate characteristic derivation for the authorization check. In this case, the system 

checks the user's authorization for all the characteristics that can be derived. For the system to do this, the 

user must have authorization for the activity "B3" (Derive) in authorization object "K_KEPL_TC" (Sales 
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and profit planning). In addition, the set/get parameter "RDA" must have the value "X" in the user 

parameters. 

The following authorizations are allowed for objects: 

normal values 

"*" 

This means that the user has authorization for all the values of the characteristic or all key figures. 

If intervals are defined in the form, the user needs the authorization "*" for these fields. It would be 

better, however, to use the "More" function and enter the individual values of the interval. 

The user also needs the authorization "*" for all the drill-down characteristics in the list. If at the 

same time the user should only have authorization for some of the characteristic values, you need 

to use another characteristic. This characteristic must be used in all the reports and at least one 

authorization object. 

":" 

This means that the user is only allowed to see total values for this characteristic. 

"#" 

This means that the user is not authorized for any values of the characteristic. That is, he or she can 

only see data records to which no value of that characteristic is assigned. 

The following tables demonstrates how the system checks your entries against an authorization object: 

    Field content   *           Y           #       does not exist 

Authorization: 

  *                 x           x           x           x 

  (A,Z)             -           x           -           - 

  X                 -           -           -           - 

  #                 -           -           x           - 

  :                 -           -           -           x 

Note 

Through creating an authorization object with the characteristics "Customer" and "Product", you 

can prevent reports which could slow down your system significantly: 

Customer  * 

Product   000000 to 01900000 (or the valid characteristic values) 

Customer  04500000 to 04800000 (or the valid characteristic values) 

Product   * 

These two authorizations let the user create a list of products for the selected customer and a list 

of customers for the selected product. However, he or she cannot create a single list of all the 

customers and products, something which would load down your system significantly. 

The authorization object consists of the fields "Product" and "Element of the key figure scheme". 

User X is to have authorization to look at the values of the key figure scheme ZZ up to contribution 

margin I for product 000000. Element 2000 of the key figure scheme contains this value. In order to 

do so, the user needs the following authorizations: 

Product                     000000 

Elem. of key figure scheme  ZZ0001,ZZ2000 

User Y is authorized to see all the data of key figure scheme ZZ for all products. He has the 

authorizations: 



 

 

Product                        * 

Elem. of key figure scheme     ZZ* 

An example of how you can use one object instead of two. 

A user is supposed to execute two reports: one report on the company 00 broken down by company 

codes (which belong to this company), and one report on the company code 0001 broken down by 

business areas. However, the user is not allowed to execute a report for any random company code. 

1st case: You created an object with the fields "Company" and "Company code" and another object with 

the fields "Company code" and "Business area". 

User X has the following authorizations: 

Company                00,: Company 

code           * and 

Company code           0001 

Business area          * 

The user cannot run the first report on company 00 broken down by company codes, even though 

he has authorization for the first object, because this report also requires him to have authorization 

for company code "*" and business area ":" in the second object. If the user had this, however, he or 

she could run reports on any company code. 

2nd case: You created only one authorization object with the fields "Company", "Company code", and 

"Business area". 

The user has the following authorizations: 

Company                00,: Company 

code           * Business area          : 

and 

Company                : 

Company code           0001 

Business area          * 

Here the user can execute a report on company 00 broken down by company codes and a report on 

company code 0001 broken down by business areas. 

By combining the three fields in the same object, you can achieve greater control than if you create more 

than one object. 

Activities 

Define your authorization objects for the information system. 

 Define Authorization Objects for Reports Based on Line Items 

In this activity, you can define special authorization objects for reports based on line items. The system 

checks these authorizations in addition to the other authorization objects for the information system. 

Activities 

Define these authorization objects the same way you define authorization objects for the information 

system. 
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 Create Role/Authorization Profile and Assign Users 

In this step, you can create roles and use the profile generator to generate authorization profiles. 

Activities 

To assign an authorization profile to a user, do the following: 

Create a role 

Enter a description 

Select transactions 

Create and edit authorizations 

Assigns users and compare the user master (in doing so, the profile is entered in the user's master record) 

Transport roles, if desired 

Detailed documentation 

For more information about the procedures, see transaction documentation 

See also the general documentation on the Profile Generator in the SAP Library. Choose: 

Basis Components -> Computing Center Management System -> Users and Roles or in the 

Implementation Guide (IMG), choose: Basis Components -> System Administration -> Users and 

Authorizations -> Maintain Authorizations and Profiles using Profile Generator. 

Note 

You can also use authorization profiles you created manually or were delivered by SAP, in roles. You 

can create a role without a menu and include the corresponding profile in the authorization data of the 

role. 

In the fourth step, choose "Edit -> Add authorization -> From profile" to add the authorization profile 

data to the role. 

 Utilities 

This section contains a variety of tools. 

 Prepare Archiving 

Use 

In this IMG activity, you prepare the archiving of data from costing-based Profitability Analysis. The 

settings are relevant for the following archiving objects (whereby xxxx stands for the name of the 

operating concern): 

COPAA_xxxx for archiving CO-PA line items (actual and plan) as well as for archiving reference 

documents from ALE distribution (tables CE1xxxx, CE2xxxx, and CEALE01) 

COPAB_xxxx for archiving CO-PA segment level (table CE3xxxx) 



 

 

The IMG activity offers you flexibility in making selection settings for the CO-PA line items to be 

archived as well as in making settings for subsequent access options. In principle, two settings need to be 

made: 

Selection of the CO-PA characteristics that need to be used to select the CO-PA line items to be archived. 

Selection of the CO-PA characteristics that need to be used as selection criteria for frequent accesses to 

the archive (either using the archive information system or directly in CO-PA Reporting). Using 

this option optimizes the archive structures because selection with these characteristics speeds up 

access to the archive data. From the technical standpoint, this means that the characteristics selected 

here are included in the definition of the data object in the archive, in addition to the CO-PA fields 

predefined by SAP (listed below), which enables the data objects to be read directly at the level of 

these characteristics ( with index). Characteristics that you do not select here may still be used to 

restrict the selection of archive data, but this increases the access time considerably. 

On the basis of the settings made here, the field catalog SAP_COPAA_xxxx of the line item archive is 

built in the Archive Information System. Information structure SAP_COPAA_xxxx can be used to 

analyze the archived line items in the Archive Information System. For more information about 

information structures, see Using the Archive Information System< Object >. 

The following characteristics always form part of the selection as well as part of the archive data object: 

Fiscal year 

Period 

Plan/actual indicator 

Version 

Record type 

Controlling area 

Company code 

Requirements 

Standard settings 

Activities 

Example 

For a specific product, you want to archive CO-PA data that is no longer used. Furthermore, you 

occasionally want to read line items for analysis purposes from the archived CO-PA data for a specific 

plant. For this, you need to make the following settings: 

Select the fields Product (ARTNR) and Plant (WERKS) in the characteristic selection on the right and 

transfer them to the characteristic list for the data object definition by choosing the To Object  
pushbutton. 

Select the Selection indicator for the characteristic Product (ARTNR) and select the Object indicator 

for the characteristic Plant (WERKS). 
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Save your settings. 

Start the generation of the archiving object. The system performs the following steps: 

Regeneration of the archive write program with the characteristic Product ( ARTNR ) as the 

selection criterion and with the characteristic Plant (WERKS) in the definition of the archive 

object structure. 

Rebuild of the archive field catalog SAP_COPAA_xxxx and of the archive information structure 

SAP_COPAA_xxxx. If an information structure that is already active is overwritten (after 

query), you then have to rebuild this information structure from the archive data after 

regeneration. 

 Translate Texts 
 Printing with Microsoft Word for Windows 

In the info system, you can print individual reports using Microsoft Word for Windows 6. 

This section explains possible ways to set this up and important information about the installation. 

This method of printing is only available on a presentation server under Windows or Windows NT as 

Microsoft Word for Windows 6 runs on these presentation servers. 

The logical file name 'DRILLDOWN_PRINT' gives a suggested directory, in which the files for printing 

with Word are stored. 

Microsoft Word for Windows 6 must have been installed on the presentation server in language version 

English, French or German. It is possible to extend the function 'GetLanguageDependency' for other 

language versions in the WinWord style sheet SAP_REP.DOT in the macro 'Library'. 

To install style SAP_REP.DOT, perform the following steps: 

1. Copy file SAP_REP.DOT into the directory specified in file WINWORD6.INI under parameters: 

- 'USER-DOT-PATH'      or -

 'WORKGROUP-DOT-PATH' 

(style directory) 

Call up MS-Winword 

Choose 'Tools -> Macro' 'Organize ...' 

On one side of the dialog box, open style 'SAP_REP' and on the other open style 'NORMAL'. 

Copy macro 'BatchStart' from style 'SAP_REP' 

Close the dialog box 

Choose 'Tools -> Macro' 

Choose macro 'DefinePaperformat' 

Execute the macro 

Exit WinWord and save the changes in style 'Normal'. 

Change style SAP_REP.DOT to meet your requirements. Note that you should keep a copy of the 

original file SAP_REP.DOT. 



 

 

After you have carried out these steps, Microsoft Word for Windows 6 is set up to enable you to print 

reports. 

Note: If a drilldown report is to be printed in Word, without an action in Word being necessary (Mode 

not interactive on the pop-up 'Enter print control parameter'), the entered directory using the logical file 

name must agree with the 'Batchstart' entered in the macro in Word. The directory 'D:\SAP_REP' is 

given in the delivered reference SAP_REP.DOT.  
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 Cross-Client File Names and Paths 

In this section, you specify a file name for use in different areas in Profitability Analysis. 

The logical file name "DRILLDOWN_PRINT" is a default directory where you have have the files for 

printing with Word stored. 

 Create Logical File Names 

 SAP Enhancements 

In this step you can set up system enhancements which are not supported in the standard R/3 System. 

These so-called "standard enhancements" can be used in the following areas of Profitability Analysis: 

Derivation of characteristic values        ( COPA 0001) 

Valuation                                  ( COPA 0002) 

Direct postings to profitability segments  ( COPA 0003) 

Currency translation                       ( COPA 0004) 

Actual data update                         ( COPA 0005) 

Planning                                   ( COPA 0006) 

External data transfer                     ( COPA 0007) 

Global variables in the information system ( KKDR 0001) 

Virtual characteristics                    ( KKDR 0002) For more information, see the documentation for these 

enhancements. 

 



 

 

 


